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Preface: Introduction to PRweb

Preface: Introduction to PRweb

The AcquiLine suite of products, developed by American Management Systems (AMS), is
targeted at achieving paper-free business processes. AcquiLineisaweb-based product suite that
isa“bolt-on” to the Standard Procurement System (SPS) program’ s Procurement Desktop-
Defense (PD?) system. The AcquiLine PRweb module isa direct paperless channel between the
requesting agent and a Contracting Office’'s PD? database. With the PRweb module, the
requesting agent can create Purchase Requests, with attachments, for supplies and services directly
from a desktop web browser. After creating a Purchase Request, the PRweb user can routeit to
other PRweb users in the organization for additional information, changes, funding commitment,
and package approval, all according to locally defined business Eractices. Once the Purchase
Request is approved, the information is saved directly to the PD“ database at the Contracting
Office. Procurement officials can then utilize the full power of PD? to fulfill the requirement as
submitted, or can route the requirement back to the PRweb user if further clarification is needed.

The PRweb module also allows customersto view PR status information through their desktop
web browser. This capability saves the requesting agent and Contracting Office valuable time,
providing customer self-service rather than necessitating a phone call or e-mail status inquiry to
the Contracting Office.

The PRweb Functional User’s Guide is designed to be a comprehensive manual providing detailed
procedures for the various system features of the product. The effective use of this manual isto
ensure successful use of PRweb. The manual is divided into twelve sections: Getting Started,
PRweb Desktop, Account Maintenance, Purchase Request, PR Modifications, Line Item,
Attachments, DD254, Workflow, Reports, Transfer Document and Help.

AcquiLine PRweb v2.3 1 July 29, 2002
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Chapter 1: Getting Started

Chapter 1: Getting Started

The PRweb desktop allows the requesting agent to
successfully perform procurement-related tasks. A
reguesting agent in PRweb has the capability of : : : C
c?gating, ?/ig\?vi ng, editing, routing anag apprgvi ng PRs Using thefuncu.ons described in this
from the PRweb desktop. Maintenance of the PRweb Gt RIEr SO EET

user account allows the user to access PRweb, - Register for access to PRweb
become familiar with desktop functionality and set
user preferences.

In This Chapter...

Log onto PRweb

Accessing PRweb

A valid user account is required to accessPRweb. To obtain an account, the registrant must
compl ete the registration form, which then needs to be approved by the designated System
Administrator. Alternatively, auser account can be created directly by the System Administrator.
Upon completion of either of these two options, the user can log on to the PRweb module. The
login process requires the registrant to successfully enter a username and password. Upon
successful log on, the user has access to the PRweb desktop and can participatein the
requirements phase of the procurement process.

AcquiLine PRweb v2.3 2 July 29, 2002
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Chapter 1: Getting Started

Information Tab
The L ogin window opens to the Information tab. The Information tab provides alocation in

which the System Administrator can post information or messages for PRweb usersto see. Itis
recommended that the user read the Information tab upon login.

Information | Lu:uginl Registration

Information instructions may be edited in Site Tlanagerent.

Figure 1: Login —Information Tab

AcquiLine PRweb v2.3
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Chapter 1: Getting Started

Login Tab

PRweb users can access the PRweb modul e viathe L ogin window.

Information  Login | Registrati-:nnl

Uzermame: |

Passward: I

Login |

Figure2: Login—Login Tab

To log on to the PRweb module:
1. Click the Login tab from the L ogin window.
2. Enter the username in the Username field.

3. Enter the corresponding password in the Passwor d field.

Note:  The password entered must be a minimum of 8 characters including one or more special
characters (e.g., “%" or “#").

4, Click the[L ogin] button.

AcquiLine PRweb v2.3 4 July 29, 2002
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Chapter 1: Getting Started

Registration Tab

The Registration tab isthe location in which a person begins the registration process to become a
PRweb user.

To register as a PRweb user:

1. Select the Registration tab from the L ogin window.

Information | Login Rﬂgistratiunl

Reqistration instructions may be edited in Site M anagement.

R egistration |

Figure 3: Login —Registration Tab

AcquiLine PRweb v2.3 5 July 29, 2002
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Chapter 1: Getting Started

2. Click the[Registration] button.
The Registration Form window opens with the User tab displayed.

User Tab

i Registration Form Hi=] E3

Form

User | Cu:untau::tl Grnupsl

Ilzername:; I

Paszword: I

Werifu: I

Requested Rightz:

™ Admirigtrator

[ Wiew PRweb PR in Status Report
[ Wiew Al PRz in Status Feport

|Warning: Applet window

Figure4: Registration Form—User Tab

1. Enter ausernamein the Username field.

Note:  All username information is account specific. No two users may have the same
username.

2. Enter apassword in the Password field.

Note:  The password entered must be a minimum of 8 characters including one or more special
characters (e.g., “%" or “#").

3. Verify the password by re-entering it in the Verify field.

4. If applicable, select the Administrator check box.

Note: TheView PRweb PRsin Status Report check box and View All PRsin Status Report
check box are disabled if the Administrator check box is selected.

5. If applicable, select the View PRweb PRsin Status Report check box.

Selecting the View PRweb PRsin Status Report check box requests the right to use the PR
Status Report function to view PRs that have been created in PRweb and reside in PD?. For
more information on PR Status Report, refer to the “ PR Status Report” section in Chapter
10: Reports.

AcquiLine PRweb v2.3 6 July 29, 2002
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Chapter 1: Getting Started

6. If applicable, select the View All PRsin Status Report check box.

Selecting the View All PRsin Status Report check box requests the right to use the PR
Status Report function to view all PRs that reside in PD? including PRs created in PRweb.
For more information on PR Status Report, refer to the “ PR Status Report” section in
Chapter 10: Reports.

Contact Tab

1. Click the Contact tab.

The information contained on the Contact tab provides a profile for the user account. The
contact information includes Contact Name, Title, Phone number, Fax number, E-mail
address and a Requesting Office address. If contact information needs to be changed or
updated after registration, contact the PRweb System Administrator.

i Registration Form |_ O] x|
Farm

Uzer ‘Contact | Groups |

[T Check here if you are an existing Contact in PD2. Then press
the Select button below ta find your Contact profile.

SElEst.. | Eemeye |

Contact Marme: I

Title:

|
Phone: I Fam:
E-mail: I

Requesting
Cffice:

Select... |

|Warning: Applet WwWindow

Figure5: Registration Form — Contact Tab

Note:  Select the Check hereif you are an existing Contact in PD?... check box to choose an
existing contact in PD?. This activates the [Select] and [Remove] buttons. Clicking the
[Select] button allows the registrant to search for existing contact information contained
in PD?. Clicking the [Remove] button erases any contact information previously pulled
from PD?. If an existing contact is selected, the fields on the Contact tab populate with
the information pertaining to that contact.

2.  Enter anameinthe Contact Name field.

Thisisarequired field. The contact name displaysin the user list when creating route
templates, routing sheets and groups.

3. Enter the contact’stitleinthe Titlefield.

AcquiLine PRweb v2.3 7 July 29, 2002
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Chapter 1: Getting Started

4. Enter the contact’ s phone number in the Phone field.
5. Enter the contact’ s fax number in the Fax field.

6. Enter the contact’s e-mail addressin the E-mail field.
Thisisarequired field.

7. Click the [Select] button to select a Requesting Office.
The Requesting Office Contact Search window opens.

Note: The Requesting Office field on the PR defaults to the Requesting Office selected by the
contact during the registration process. The registrant can search for an existing contact
or add anew one.

Requesting Office Contact Search

Search Criteria Search By

IE ' Code £~ Organization Mame

" Contact Mame  © Phone Mumber
Search | Selewt | Cancel | O State " Zip Code
Contact | Code | Organization | City | State | Zip Code PH

LI 5

|Warning: Applet Window

Figure 6: Requesting Office Contact Search Window

8. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

9. Highlight the desired Requesting Office and click the [ Select] button.

The Contact tab displays with the selected Requesting Office in the Requesting Office
field.

AcquiLine PRweb v2.3 8 July 29, 2002
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' Registration Form Hi=] E3
Formn

Uzer Contact | Groups |

[T Check here if you are an existing Contact in PDE. Then press
the Select button below ta find your Contact profile.

SElERh.. | EEmaye |

Contact Marne: Iacquser'l

Title: Iacquser'l

Fhore: |555-4321 Fax: |555-4321

E-rnail: Iacquser'l (Bjag. cam

Fequesting Training Center -
Oiffice: ATTH: ATZ]1-DOC

Remove | Building 4340 LI

|'W'arning: Applet Window

Figure 7: Registration Form — Contact Tab
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Chapter 1: Getting Started

Groups Tab

1. Click the Groupstab.

The PRweb module utilizes groups to organi ze users with commonalties and helps to organize
the approval trail. There are two tabs within the Groupstab, the Member tab and Manager
tab. The Member tab allows the registrant to request membership of agroup and the Manager
tab allows the registrant to request to be a manager of agroup.

Member Tab

The Member tab allows aregistrant to request membership of agroup. The PRweb routing
components allows the user to route PRs to groups of users. For more information on routing,
refer to the “Routing” section in Chapter 9: Workflow.

' Registration Form Hi=] E3

Form

I_Iserl Contact  Groups |

Member | Managerl

M ame | D'escription Add...

Eemaye |

|Warning: Applet window

Figure8: Registration Form - Groups Tab - Member Tab

1. Click the[ Add] button to search for agroup.

The Group Search window opens.

Note:  Itisnot required that aregistrant be a member of agroup.

AcquiLine PRweb v2.3 10 July 29, 2002
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Group Search
Search Critena Search By
IE & Name ™ Description
Search | Selent | Cancel |
M ame | Dezcription

|'W'arning: Applet 'Window

Figure9: Group Search Window

2. Enter Search Criteria, and click the [Sear ch] button.

Note:  For moreinformation regarding searches, refer to “ Search Function” section in Chapter
2: PRweb Desktop.

3. Highlight the desired group(s) and click the [Select] button.
The Member tab displays with the selected group(s).

Note:  Multiple groups can be selected by pressing the <CtrI> key and clicking on the desired
groups.

AcquiLine PRweb v2.3 11 July 29, 2002
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i Registration Form [_ (O] x|

Farm

Llserl Cortact Groups |

Member | Managerl

M ame | Dezcription
Admin Training 1

| EEmowe |

|Warning: Applet WwWindow

Figure 10: Registration Form - Groups Tab - Member Tab

Note:  For aquick way to search alist, refer to the * Searching Within A List” section in Chapter
2: PRweb Desktop.

Manager Tab

The Manager tab allows aregistrant to request to be a manager of one or more groups.
Managers of groups can use PR Status Reports to view PRsthat currently reside in PD? and
were created by members of the groups they manage. For more information on PR Status
Report, refer to “ PR Status Report” section in Chapter 10: Reports.

AcquiLine PRweb v2.3 12
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i Registration Form [_ (O] x|

Farm

Llserl Cortact Groups |

Member Manager |

M ame | Dezcription Add...

EEmowe |

|Warning: Applet WwWindow

Figure 11: Registration Form— Groups Tab - Manager Tab

1. Click the[Add] button to search for agroup.
The Group Search window opens

Note: Itisnot required that aregistrant be a manager of a group.

Group Search
Search Criteria Search By
IE ' Name " Description
Search | Selent | Cancel |
M ame | Dezcriptian

|Warning: Applet Window

Figure12: Group Search Window

AcquiLine PRweb v2.3 13 July 29, 2002
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2. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information regarding searches, refer to “ Search Function” section in Chapter
2. PRweb Desktop.

3. Highlight the desired group(s) and click the [Select] button.
The Groups tab displays with the selected group.

Note:  Multiple groups can be selected by pressing the <CtrI> key and clicking on the desired
groups.

i Registration Form M=l

Farm

Userl Cortect  Groups |

Member Manager |

MHame | Dezcription

Adrmin Training 1 ; :
H ErmEye |

|Warning: Applet Window

Figure 13: Registration Form — Groups Tab - Manager Tab

Note:  For aquick way to search alist, refer to the * Searching Within A List” section in Chapter
2: PRweb Desktop.

4. Tosubmit the Registration Form, select Form - Submitfrom the Registration Form
menu bar.

AcquiLine PRweb v2.3 14 July 29, 2002
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=] E3

i Registration Form
Submit
Grnups |

Cancel
TT=ETTTIIE. an:quser'l

Ixxxxxxxxx

Pazzword:

Ixxxxxxxxx

Werify:

Requested Rights:

[ &drmiristratar

¥ ‘iew PRweb PRz in Status Feport
¥ Aiew &l PRz in Status Flepork

|Warning: Applet WwWindow
Figure 14: Submit Menu Option

An e-mail alert from the PRweb System Administrator is sent to the contact’ s e-mail

Note:
address upon registration approval or rejection.

AcquiLine PRweb v2.3 15 July 29, 2002

Functional User’s Guide



Chapter 2: PRweb Desktop

Chapter 2: PRweb Desktop

File Menu In This Chapter...
The File menu provides desktop functions to allow Using the functions described in this
the PRweb user to update or exit the desktop. For chapter. Vou can:
these purposes, three components are provided in the apter, y :
File menu: Refresh Folder, Refresh All, and Exit. - Understand the desktop
functions and components
Use the Search feature
Use the Auto-Calendar feature
& PRweb _: - 10| x|
W= Freferences  Purchaze Reguest  Help
Refresh Faolder
Refresh Al
Exit
I My ay
I.Java Applet \Window
Figure15: FileMenu
AcquiLine PRweb v2.3 16 July 29, 2002
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Chapter 2: PRweb Desktop

Refresh Folder

The Refresh Folder menu option allows the PRweb user to refresh individual folders to reflect
changes. For example, if auser getsan e-mail alert regarding anew PR in hig’her Inbox, but does
not see the PR in that folder, he/she can highlight the Inbox folder and select File > Refresh
Folder from the desktop menu bar. Thisrefreshes the Inbox folder with the new information and

the PR displaysin that folder.

Refresh All

The Refresh All menu option allows the PRweb user to refresh all folders on the desktop to reflect
changes. For example, if auser adds an attachment to a PR but does not see the attachment icon
on the desktop, he/she can select File > Refresh All from the desktop menu bar. This refreshes
all folders on the desktop with any new information. The PR icon now reflects the addition of the
attachment.

Exit
PRweb users can exit the desktop by selecting File > Exit from the desktop menu bar.
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Using Desktop Components

The PRweb desktop is a Graphical User Interface (GUI) that provides the user control and
interaction with the program.

=10l x|

E-( Archive

I TrvEy

IJava Applet \Wwindow

Figure 16: Desktop

Desktop Folders

The PRweb desktop isthe large white area that holds all of the PRweb user’s PRs in four folders:

Drafts, Inbox, Outbox and Archive. Each folder represents a stage in the requirements
development process.

The Drafts folder contains PRs that have been created but not yet routed. PRsthat have been
re-routed back to PRweb from PD? also display in the Drafts folder.

The Inbox folder contains PRs that have been routed to the user for review and approval by
another PRweb user.

The Outbox folder contains PRs that have been routed to another PRweb user.

The Archive folder contains PRs that have proceeded through the approval processin the
PRweb module and now reside in the PD? database.

To access adocument contained within afolder:

AcquiLine PRweb v2.3 18 July 29, 2002
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1. Click onthe plussymbol (+) to open afolder and display the folder’ s contents.

The (+) symbol denotes that a closed folder has one or more documentsin it.

2. Double-click the document to be opened.

Note:  Theminussymbol (-) that displays directly to the left of an open folder allows the user to
close that folder.

Title Bar

A title bar displays the name of the window at the top of every window in the PRweb system.
Throughout this document, the name contained within the title bar is used as the window name.

S - 1]

Figure17: Title Bar

Menu Bar

The menu bar allows the user to efficiently and quickly navigate through the various functions and
capabilities of the PRweb module. The menu bar is the strip of one or more words located across
the top of awindow, below thetitle bar. Each word in the menu bar can be selected to activate a
drop-down menu. Each drop-down menu contains words that relate to the various options
provided in the program that can be selected to link the user to that option.

File  Adminiztration  Help

Figure 18: Desktop Menu Bar

Username

The usernameis displayed in the bottom right corner of the desktop. Thisidentifiesthe user who
isloggedin.

Java Applet Window or Warning: Applet Window

Either the“Java Applet Window’ or “Warning: Applet Window” message displaysin the
lower left corner of the PRweb desktop. It serves as areminder that the PRweb module is not a
program that resides on the hard drive of the user’s computer, unlike aword processor or a
spreadsheet program. The PRweb module isaJava Applet, aspecial type of program that can be
used over the Internet.

AcquiLine PRweb v2.3 19 July 29, 2002
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Search Function

There are two search functions available in PRweb, searching the database and searching alist.
The searching the database function allows the PRweb user to pull information directly from the
PRweb or PD? database. The searching within alist function allows the PRweb user to search a
list quickly.

Searching the Database

To conduct a search:

1. Click the[Select] button for the appropriate Sear ch box.

Requesting Office Contact Search
Search Criteria Search By
IE ' Code ™ Organization Mame
" Contact Mame € Phone Mumber
" State " Zip Code
MHew...
Search | Selest | Cancel |
Contact | Code | Organization | City | State | Zip Code Ph
= 5
|Warning: Applet Window

Figure 19: Sample Search Window

2. Qualify the Search Criteriafield by selecting the desired Sear ch By radio button.

The Sear ch By radio buttons enables the PRweb user to perform searches by specific
categories. The search results display the specific category alphabetically.

3. Definethe criteriain the Search Criteriafield.

The Sear ch Criteriafield allows the PRweb user to further define and refine the search
parameters. The PRweb module employs the universal search symbol (%) to aid in the search
process. The universal search symbol pullsall information pertaining to the designated search
parameter. For example, “A%” in the Requesting Office Contact- Sear ch field displays al
vendors beginning with the letter A. The % may also be used to search for akeyword. For
example, “%Army%" in the Requesting Office Contact Search field displays all Requesting
Offices containing the word “Army.”

AcquiLine PRweb v2.3 20 July 29, 2002
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Note: The Search Criteriafield is case-sensitive.

4. Click the[Sear ch] button.

Requesting Office Contact Search
Search Criteria Search By
I,&,Lz " Code £~ Organization Mame
" Contact Mame  © Phone Mumber
Select | Cancel | * State " Zip Code
Contact Code Organization City State | Zip Code =
BREMDAN HAG 501024, DPRO PEMCO AEROFL BIRKIMGHAR I0202-2447
MO COMTACTS 501024 DPRO PEMCO AEROFL BIRMINGHAM AL a5202-2447
=-SMITH DAACT AMMISTON ARMY DEP AMMISTOM AL A6201-5003
MO COMTACTS DaaC0l AMMISTON aRMY DEF AMMISTOM AL 36201-5003
MO COMTACTS DAdHOT US4 MISSILE COMMAR REDSTOME AR AL 25898-5280
MO COMTACTS DABTO2 1.5 ARMY CHEMICAL. FORT MCCLELL AL A6205-5000
MO COMTACTS DaACAD] 54 EMGIMEER DISTR MOBILE AL 36E28-0001
MO COMTACTS DACWT1 JSAEMGIMEER DISTR MOBILE AL A6E28-0001
MO COMTACTS DACABT US4 EMGIMEER DIVISI HUMTSWILLE AL a5807-4301
MO COMTACTS DACWSEY  USAEMGIMEER DIVISI HUMTSWVILLE AL 25807430
LI 3

|Warning: Applet Window

Figure 20: Sample Search Results

5. Highlight the desired result and click the [Sel ect] button.
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Searching Within A List

To conduct a search:

1. Click onthe appropriate list.

i Registration Form [_ (O] x|

Farm

Llserl Cortact Groups |

Member | Manager |
M ame Dezcription Add...
BLSH#1 Buz Level Securty Remave |
BLSHZ2 BLSH2
BLSH2 BLSH2
BLSH4 BLSH4
Group 2 Betzy's group 2
Group 3 Betzy's Group 3
Group 4 Betzy's group 4
TR Training Group
TRAT Training Group
TRAZ 2nd Training Group
TRAR Training

|Warning: Applet WwWindow

Figure 21: Registration Form - Groups Tab - Member Tab

2. Enter search text.
The Starts with window opens.

Note:  Morethan one character may be typed in the Search Text field.

Starts with._.

Search Text: oK. |
_ Concel |

IT Cancel

|Warning: Applet Window

Figure 22: Starts With Window

3. Click [OK].
The search resultsis highlighted.
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i Registration Form

Farm

Llserl Cortact  Groups |

IS [=] E3

Member | Manager |
Mame | Dezcription Add. .
Admin Training 1
BLS#1 Buz Level Securty Remove |
BLSHZ BLSH2
BLSH2 BLSH2
BLSH4 BLSH4
Group 2 Betzy's group 2
Group 3 Betzy's Group 3
Eroup 4 Betzy's group 4
TRAT Training Group
TRAZ 2nd Training Group
TRAR Training

|Warning: Applet "Window

Figure 23: Registration Form - Groups Tab - Member Tab
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Auto-Calendar Feature

The Auto-Calendar feature allows the PRweb user to quickly select adate from a calendar
interface.

To use the Auto-Calendar feature:
1. Placethe cursor inside the field that requires a date.

2. Press <Shift> and double-click the left mouse button.

[2002 7] Tosay |

Sun Mon Tue Wed Thu  Fri Sat
1 2134|567
g | 9 101 1213 14

15 |16 | 17 | 18 | 19 | 20 | 21

22123 |24 |25 |26 |27 |28

8|9 fw]]12]

] | Cancel |

|Java Applet Window

Figure 24: Calendar Window

Note: A calendar displayswith the current date as the default.

Note:  Clicking on the auto-calendar icon also displaysthe calendar. %

3. UsetheMonth drop-down list box to select a different month if necessary.
4, Usethe Year drop-down list box to select adifferent year.
5. Click the desired day of the month in the calendar that displays.

6. Double-click the appropriate date or single-click adate and click [ OK] to select and close the
calendar.
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Chapter 3: Account Maintenance

The PRweb desktop allows the requesting agent to In This Chapter...

successfully perform procurement-related tasks. A

reguesting agent in PRweb has the capability of This chapter introduces the basic
creating, viewing, editing, routing and approving information needed to begin working
PRs from the PRweb desktop. Maintenance of the with AcquiLine PRweb. Thisincludes:
PRweb user account allows the user to access -

PRweb, become familiar with desktop functionality - Customizing the user account

and set user preferences.

Customizing the User Account

The Prefer ences menu allows the PRweb user to customize his/her user options. The Preferences
menu contains five options: Change Archive Days, Change Password, Route Templates,
Change E-mail Address, and Out of Office.
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I =] E3

FPurchasze Request  Help

Change Archive Days...

Foute Templates...
Change E-mail Address. ..
Cut of Office. ..

€
& Change Pazaword...
&

@

I ]

|Warning: Applet ‘Window

Figure 25. PreferencesMenu Option

Change Archive Days

The Change Archive Days menu option allows the PRweb user to specify the number of days that
PRs are displayed in the Archive folder. Changing the number of days overwrites the default set
by the System Administrator.

To change the number of archive days:

1. From the menu, select Preferences - Change Archive Days.
The Archive Days window opens.

Archive Days

Enter the number of dayz, from the
creation date, that PR documents are
wizible from within the Archive folder.

s

k. Cancel

|'W'arning: Applet Window

Figure 26: Archive Days Window
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2. Enter the desired number of days.

3. Click [OK] to save the Archive Days setting.

The Attention window opens.

Attention

& Your Archiving Dapz value has been updated.

|Warning: Applet Window

Figure 27: Attention Window

4. Click [OK] toreturn to the PRweb desktop.
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Change Password

The Change Passwor dfeature allows the PRweb user to change his/her login password.
To change passwords:

1. From the menu, select Preferences - Change Passwor d.

Change Paszword

Qld Paszword: ||

Mew Pazsward: I

Werify: I

] Cancel

|Warning: Applet Window

Figure 28: Change Password Window
2. Enter the current password in the Old Passwordfield.
Thisisarequired field.

3. Enter the desired password in the New Password field.
Thisisarequired field.

Note:  The password entered must be a minimum of 8 charactersincluding one or more special
characters (e.g., “%" or “#").

4. Re-enter the desired password in the Verify field.
Thisisarequired field.

5. Click [OK] to change the password.

The Attention window opens.

Attention

& Your paszward has been changed.

|Waming: Applet \Window

Figure29: Attention Window

6. Click [OK] to return to the PRweb desktop.
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Route Templates

The Route Templates feature allows the PRweb user to create his/her own specific route
templates to complement current approval processes. Only users with appropriate security rights
can create route templates. Members of security groups that only have routing access to specific
templates can choose from those templates to which they are assigned when routing a PR. The
routing sheet populates with the contents of the template. Therefore, the order in which users are

put on the route template is the order in which the PR is routed.

Creating a Route Template

The PRweb user can create new route templates. Route templates can be created to complement

current approval processes.

To create aroute templ ate;

1. From the menu, select Preferences - Route Templates.

i Templates

Mame | Diezcription
&drnin. Adminigtrators Template :
Testing Teszt Template ...

n

[Melete

| |

= Cloze

|Warning: Applet Window

Figure 30: Templates Window

Note:  For aquick way to search alist, refer to the ‘ Searching Within A List” section in Chapter

2. PRweb Desktop.

AcquiLine PRweb v2.3
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2. Click the[ New] button.

The Template — New window opens.

Template - Hew

M ame: ||

Description; |

View Boutees By - = ser
= Group

-

M on-tembers kembers

&C0 USERC
AC0 USERD
&C0 USERE

ACQ USERF I

SCOUILIME USERA
&COUSER B
ACOUSERTD
&COUSERTD
&L GAMZEMULLER
BaRBARA E BROCK

Route ta PDE User: I Select.., |
Wigw Groups... | k. | Cancel |

|Warning: Applet 'Window

Figure 31: Template—New Window

3. Enter aunique template namein the Name field.

A unique name isrequired for each template. The Name field holds up to 30 characters.

4. Enter adescription for the new template in the Description field.

The template description allows the System Administrator to further clarify the route template
he/sheiscreating. The Description field holds up to 255 characters.

5. Select membersfor the new template by highlighting desired users from the Non-Members
list box and clicking the[ » ] button.

Note:

For aquick way to search alist, refer to the * Searching Within A List” section in Chapter
2. PRweb Desktop.

Note:

The Non-Members list box displays all available usersto add to the route template. As
users are added to the route template their usernames display in order selected in the
Memberslist box and are subsequently removed from the Non-M ember s list box.
Members can be removed from the route template by highlighting the desired user from
the Members list box and clicking the[ 4 ] button.

AcquiLine PRweb v2.3
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6. Select the Group radio button from the View Routees By field.
7. Select amember from the Non-Members list.

8. Clickthe[View Group] button.
The Groups (Read Only)window opens.

* Groupsz [Read Only] _ (O] x]

Mame Dezcrption -
BLS#H1 Bus Level Security
BLSHZ BLSH2
BLSH2 BLSH3
BLSH4 BLSH4
Group 2 Betsy's group 2
Group 3 Betzy's Group 3 =
Group 4 Betzy'z group 4
Group B Betzy's Group B
Group B Betsy's group B
Group 7 Betsy's group 7 .
1 | 3

CDpen... |

Cloze

|Warning: Applet Window

Figure 32: Groups (Read Only) Window

9. Click the[Closd button to return to the Template— New window.

10. Click [OK] to save the new template and return to the Templates window.

11. Click the[Select] button next to the Route to PD? User field.

The Select PD? User window opens.

Select PDE Uszer

PO Uzers
Drarminic Joel

Sarah Jopce
Sygtem Adminigtrator

Celemt i Cancel

|Warning: Applet Window

Figure 33: Sdect PD? User Window

12. Highlight the appropriate Contract Official.
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13. Click the[Select] button.
The PD? user selected displaysin the Route to PD? User field on the routing sheet.

Note: At least one member and a PD? user must be added to the new template before saving it.

14. Click [OK] to save the new template and return to the Templ ates window.

15. Click the[Close button to return to the user’s desktop.

Editing a Route Template
The PRweb user can edit existing route templates to add or remove users from the templ ate.

To edit aroute template:

1. From the menu, select Preferences - Route Templates.

The Templates window opens.

i Templates =]
e | Drezcription i _
&drnin. &dminigtrators Template :
Testing Test Template ... |
== |
| | S Cloze
|'W'arning: Applet \Window

Figure 34: Templates Window

2. Highlight the route template to be edited.

Note:  For aquick way to search alist, refer to the * Searching Within A List” section in Chapter
2: PRweb Desktop.
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4,

Click the[ Edif] button.

Template - TEST

M ame:

[TEST

Dezcrption: Itesters

Yiew Houtees By -

% zey
i~ Group

M on-tembers

-

&C0 USER C
&C0 USERD
&C0 USERE
&C0 USER F
ACHUILINE USERA
&COUSER B
ACOUSERTD
ACUUSERTO
&L GAMZEMULLER
BaREARA E BROCK

kembers

Route to POE User: IS_I,Istem Adrrinistrator

Select. . I

Wigw Froups... |

(] | Cancel

|Warning: Applet tindow

Figure 35: Template - <Template Name> Window

Edit the template description in the Description field if necessary.

Note:

The name in the Name field is not editable.

5. Select additional members for the template by highlighting desired users from the Non-
Members list box and clicking the[ » ] button.

Note:  For aquick way to search alist, refer to the * Searching Within A List” section in Chapter
2. PRweb Desktop.
Note: TheNon-Members list box displays all available usersto add to the route template. As

users are added to the route template their usernames display inorder in the Members

list box and are subsequently removed from the Non-M ember s list box. Members may
be removed from the route template by highlighting the desired user from the Members
list box and clicking the[ 4 ] button.

6. Select the Group radio button from the View Routees By field.

7. Edit the members from the Non-Members list if necessary.

8. Click [OK] to save the new template and return to the Templates window.
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9. Click the[Select] button next to the Route to PD? User field to change the PD? user.
The Select PD? User window opens.

Select PD® User

PO Uzers
Drarninic Joel

Sarak Joyce
System Administrator

St !  Cancel

|Warning: Applet Window

Figure 36: Sdlect PD? User Window

10. Highlight the appropriate Contract Official.

11. Click the[Select] button.
The PD? user selected displaysin the Route to PD? User field on the routing sheet.

Note: At least one member and a PD? user must be included on the template before saving it.

12. Click [OK] to save the changes and return to the Templates window.

13. Click the[Closg button to return to the user’ s desktop.
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Deleting a Route Template
The PRweb user can delete existing route templ ates.

To delete aroute template:

1. From the menu, select Preferences—> Route Templates.

The Templates window opens.

i Templates [_ O] x|
Name | DESC”ptIDn ......... NEW ......... I
&drnin, Adminigtrators Template :
T esting Teszt Template ... |
[EfEte |
1 | " Cloze
|Warning: Applet Window

Figure 37: Templates Window

2. Highlight the route templ ate to be del eted.

For aquick way to search alist, refer to the * Searching Within A List” section in Chapter
2. PRweb Desktop.

Note:

3. Click the[Delete] button.
The Confirmation window opens.

Confirmation
@ You are about to delete thiz route
ternplate. Would you like b continue?
............ T ™
|Warning: Applet \Window

Figure 38: Confirmation Window

4. Click the[Yes] button.
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Change E-mail Address

The Change E-mail Addressfeature allows the PRweb user to change their e-mail address as
defined in the contact information. The e-mail address denotes where all PRweb generated alerts
are sent.

To change your e-mail address:

1. From the menu, select Preferences—> Change E-mail Address.

The Update E-mail Addresswindow opens.

Update E-mail Address

PEweb User

Current E-mail Address: |ia.;k_re_|,|nnldg@amg_cnm

Mew E-mail &ddress: ||

k. Cancel

|Warning: Applet Window

Figure 39: Update E-mail Address Window

2. Enter thenew e-mail addressin the New E-mail Address field.

3. Click [OK] to save the changes.

Out of Office

The Out of Office feature allows the PRweb user to specify a date range that the user will be
away. The user can also specify another PRweb user that the “out of office” user’sworkload will
be forwarded to while the “out of office” userisaway. Email notification is sent to the “out of
office” user informing the user that a PR or PR Mod has been forwarded to the designated
alternate. Oncethe Last Day Out of Office passes, the user’s workload will not be forwarded to
the designated user.

To specify out of office information:

1. From the menu, select Preferences - Out of Office.
Out of Office window opens.
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[T Out of Office &ctivated

First Dray Out of Office: || éwl‘
Last Day Out of Office; | éwl‘
Forwarding Workload to PRweb Llser: Select... |

k. I Cancel |

Warning: Applet Window

Figure 40: Out of Office Window

2. Select the Out of Office Activiated check box.

3. Enter the appropriate date in the First Day Out of Officefield.
Thisisarequired field.

4. Enter the appropriate date in the Last Day Out of Officefield.
Thisisarequired field.

Note: TheFirst Day Out of Office and Last Day Out of Office dates can be entered manually
or by using the Auto-Calendar feature. For more information on the Auto-Calendar, refer
to “Auto-Calendar Feature” section in Chapter 2: PRweb Desktop.

5. Clickthe[Select] button next to the Forwar ding Workload to PRweb User field.
The Select PRweb User window opens.

Select PRweb Uszer Ed
Available PRweh Users el
30 CHARACTERS LISER ID —

ACCEPTOR FOUR
ACCEPTOR OME
ACCEPTOR THREE
ACCEPTOR TWO

ADAM ARDREWS
ANDREVY
AQLIAFIMA

Alex Schefer

B Watson

Select... Cancel

|'W'arning: Applet 'Window

Figure41: Select PRweb User Window
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6. Highlight the user and click the [Select] button to select the desired user.
The selected user displaysin the Out of Office window.

Out of Office x|

v Out of Office Activated

First D'ay Out of Office: ID?*"'JE'#":'2 éwl‘

Last Day Out of Office: IU?HEEFUE éwl‘

Fonwarding Workload to PRweb User [204M ANDREWS Delete... |
0k, | Cancel I

Warning: Applet Window

Figure 42: Out of Office Window
7. Click [OK] to save the Out of Office configuration.

8. Click [Cancel] to cancel the Out of Office configuration.

To remove out of office information:

1. From the menu, select Preferences - Out of Office.

Out of Office x|

v Out of Office Activated

Firzt Day Out of Office; IEI?HEIEIHEIE éwl‘
Last Day Out of Office: [07/22/02 %”’:I
Forwarding *orkload to PRweb Uzer: aDak ANDREWS Delete... |

] | Cancel |

Warning: Applek Window

Figure 43: Out of Office Window

2. Clear the Out of Office Activatedcheck box.

The First Day Out of Office, Last Day Out of Office, and Forwarding Workload to
PRweb User fields are cleared.
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0ut of Office

) |

Figure 44: Out of Office Window

3. Click [OK] to save the Out of Office configuration.

4. Click [Cancel] to cancel the Out of Office configuration.
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Chapter 4: Purchase Request

The Purchase Request (PR) document isthe principle In This Chapter...

document supported within PRweb. The PRweb

module allows the requesting agent to create, route, Using the Purchase Request

approve, and submit the PR to the Contracting Office. functions described in this chapter,

The electronic interchange of the PR, and the ability of you can:

the rt_aguesti ng agent etg tr?ck_ the status of the PRl, . Create and Manage PRs

rovides an integrated sol ution to support paperless .

gcq\l/,lll sition. 'nteg w pport pap Manage Funding Sources

Manage Funding Strips
Creating a New Purchase Request . Manage Job Orders

To create anew Purchase Request:

1. From the menu, select Purchase Request > New.

! PRweb M=l E3

RN EEREEN Purchase Request

] =i

T ST AT,

[EEm.,

[lelete

PR Status Report...
Standard Reparts. ..

Eerumier. .

Eiaute:. .

SRpIove..,

e mmnayal Histan.

I Iacquser'l

|Warning: Applet Window

Figure 45: New Purchase Request Menu Option
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The PR Header displays at the top of the Purchase Request window and is visible from
every tab of the Purchase Request window.

i Purchase Request - Hew M=l
File  Line Item

D escription Purchaze Request Mumber
Purchase | |
ReqUESt Requizition Date DPAS Priority Rating | Priority
J14-5ep-2000 | |

Figure 46: Purchase Request Header

2. Enter adescription in the Description field.
The Purchase Reguest description allows the PRweb user to assign a descriptive reference of
up to 60 characters. Thisfield isrequired to save aPR.

3. Enter aunique number in the Purchase Request Number field.

The Purchase Request number allows the PRweb user to assign a unique al phanumeric
combination of up to 30 characters to the PR. Duplicate PR numbers are not allowed. This
field isrequired to save aPR.

4. Enter the Defense Priority Allocation System (DPAS) Priority Rating in the DPAS Priority
Rating field.

Thisfield holds up to 6 characters.

5. Enter the appropriate priority number in the Priority field.
Thisfield holdsany number between 1 and 15.

Note:  The PRweb module automatically assigns a date/time stamp called the Requisition Date,
to the PR upon creation. Thisfield isnot editable.
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Main Form Tab

The Purchase Request opensto the Main Formtab. The Main Form tab contains information
regarding the Requesting Office, |ssuing Office, Suggested Vendors, Type of Action and
Comments.

i Purchase Request - New ;lglil

File  Line Item

| Description FPurchaze Reguest Mumber

Purchase | | |
|

Request DPAS Pricrity Rating | Priority

R equizition D ate
[ 25-Jur-2002

Main Form I Line ftem I Contracts I Lodl Deta |

R equesting Office Select...l Type of Action
[MaYAL COMMUMICATIONS DET. WASHINGT | * Small Puchaze " Grants/Coops Agreement
™ Competed Contract " Sealed Bid
o T " Mon-Competed Contract ¢ F55/G54 Schedule
‘i I J-i " Manufacturer Sole Source © Commercial
I ssuing Office Delete I ™ Dielivery Order £ MIB / NISH 2 FFI
" Tagk Order

WALTER REED ARMY MEDICAL CEMTER =

DIRECTORATE OF COMTRACTING C ]
ATTH: HSHL-ZC, BUILDING T-20 SRS
|

B e Tt

4| *
Suggested Wendoar(z) Add... |

Warning: Applet Window

Figure 47: Purchase Request - New —Main Form Tab

1. Select the appropriate Type of Action radio button.

Note: The Requesting Office and I ssuing Office fields default to the Requesting Office
defined in the creator’ s user account on the Contacts tab.

2. Click the[Select] button next to the Requesting Officefield.
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The Requesting Office Address Search window opens.

Requesting Office Addrezs Search E3

Search Criteria Search By

IE %' Code " Phone Mumber

™ Organization " Zip Code
Search | (et | Cancel |  State
Code | Organization | Street City | State| £ip Eu:u:le| A

| 3

|'W'arning: Applet Window

Figure48: Requesting Office Address Search Window

3. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information regarding searches, refer to “ Search Function” section in Chapter

2. PRweb Desktop.

4. Highlight the desired Reguesting Office Address.

5. Click the[Select] button.

The Main Formtab displays with the selected Requesting Office in the Requesting Office
Addressfield.

6. Click the[Select] button next to the I ssuing Office Addressfield.
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The I ssuing Office Address Search window opens.

Izzuing Office Address Search Ed

Search Criteria Search By

IE % Code ™ Phone Mumber

" Organization " Zip Code
Search | Selest | Cancel | € State
Code | Organization | Street City | State| £ip Eu:u:le| A

LI 3

|Warning: Applet Window

Figure 49: Issuing Office Address Search Window

7. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information regarding searches, refer to “ Search Function” section in Chapter
2: PRweb Desktop.

8. Highlight the desired I ssuing Office Address.

9. Click the[Select] button.

The Main Formtab displays with the selected I ssuing Office in the | ssuing Office
Addressfield.

10. Click the[Add] button next to the Suggested Vendor (s) field.

The Suggested Vendor (s) field allows the PRweb user to identify potential
suppliers/contractors for the request. Vendor information is pulled from the PD? database.
The PRweb module user cannot create new vendor profiles; the Contracting Office must do
thisvia PD?.
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The Vendor Address Search window opens.

Vendor Addresz Search

Search Criteria Search By

IE %' Code " Phone Mumber

" Mame " Zip Code
Search I Seleet I Cancel I € State
Code | Organization | Street | City | Statel £ip I:::ude| A

LI 3

|Warning: Applet \Window

Figure50: Vendor Address Search Window

11. Enter Search Criteria, and click the[Sear ch] button.

Note:  For more information regarding searches, refer to “ Search Function” section in Chapter
2: PRweb Desktop.

12. Highlight the desired Vendor Address.

13. Click the[Select] button.
The Main Formtab displays with the selected vendor(s) in the Suggested Vendor (s) field.

Note: The[Add] button becomesthe [ Mor €] button after selecting one Suggested Vendor (S).

14. Enter comments about the requirement into the Comments field.
Thisfield holds up to 255 characters.
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Additional Suggested Vendors

1. Click the[More] button next to the Suggested Vendor (s) field.
The Vendor Summary View window opens.

i ¥endor Summary Yiew

H=]
Vendor Summary View
M4 AMERICAM MANAGEMEMT 4114 LEGAT! FAIRFAx Wao 22033 F3-227-5654
182037705 BalLL AEROSPACE 10LOMGS D BROOMFIELD CO  20020-251

LI 3
........... Addl Remove Ok, Cancel

|‘-N'aming: Applet Window

Figure51: Vendor Summary View Window
2. Click the[Add] button.
The Vendor Address Search window opens.
Yendor Addrezs Search Ed
Search Criteria Search By
IE %' Code " Phone Mumber
= Mame " Zip Code

Search | Lt | Cancel | € State

Code | Organization | Street | City | State| Zip Code | A

| 3
|Warning: Applet wWindow
Figure 52: Vendor Address Search Window
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3. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information regarding searches, refer to “ Search Function” section in Chapter
2. PRweb Desktop.

4. Highlight the desired Vendor Address.
5. Click the[Select] button.
The Main Formtab displays with the selected vendor (s) in the Suggested Vendor (s) field.

Remove Suggested Vendor

1. Click the[More] button next to the Suggested Vendor (s) field.
The Vendor Summary View window opens.

i Yendor Summary Yiew [_ (O] %]
Vendor Summary View
ah724 AMERICAM MAMNAGEMENT 4114 LEGAT! FAIRFAX WA 22033 F3-227-555
182037705 BalLL AEROSPACE 10LOMGS O BROOMFIELD CO  80020-251
=l »
.......... f—'«ddl Remaove Ok, Cancel

|'W'arning: Applet Window

Figure53: Vendor Summary View Window

2. Highlight one or more vendors and click the [Remove] button.

3. Click [OK] toreturnto the Main Formtab.
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Line lItem Tab

The Line Itemtab of the PR provides a summary of the line items on the PR. This summary
provides general information on lineitems for a PR such asNumber, Description, Quantity,
Unit of Issue, Unit Cost, and Total Cost.

In PRweb, funding may be handled at the contract level or at the lineitem level. Contract level
funding may be entered on the Line Itemtab. To establish line item level funding, the information

may be added on the Funding tab in the Line Item Detail window. To create aline item refer to
Chapter 6: Line Item

& Purchase Request - PRO101 - |I:I|i|
File Line Iterm

Description Purchaze Reguest Mumber
Purchase | [unitorms [PrROT01
RequeSt Requistion Date DPAS Priorty Rating | Priarity
| 24-Jun-2002 [3 [3
Main Form  Line Rem | Cortracts | &clef!| Data |
Total Funding: |$|:|_|:||:| Contract Level Funding  [IE}

* liglues may he munded fordisolay guiposes.

| Murnker | Description | Guantity | Unit of lzsue Unit Cost Total Cost *

Total Cost:  |F0.00

|Java Applet \Windaw

Figure 54: Purchase Request - <Purchase Request Number> — Line Item Tab
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Creating a New Funding Source

PRweb users can create funding sources at the contract level. The System Administrator grants
user rights to manage funding information. If the user does not have these rights, funding
information is read-only or not available.
1. Click the[New] button next to Contract Level Funding.

The Contract Level Funding window opens.

Note:  If associated funding information is already in the database, the [Mor €] button displays
and the funding information displaysin the table.

£ contract Level Funding |

Contract Level Funding

Funding Strip Funded Amount

.| [
e Edit... Celete Cloze |

|Java Applet WWindow

Figure 55: Contract Level Funding Window

2. Click the[ New] button to add funding information.
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The Funding Sources - New window opens with the funding header displayed at the top.

The funding header includes the Document Number and the Total Estimated Cost of all
line items.

@ Funding Sources - New x|

Funding Sources

Document Mumber |F‘RIZI1 01
Total Estimated Cost: |$D.DD

Fund Strip Chigw | Edit | Manage...

Funded Amount: |$D.DD Fund &ACRM: I

Towr | owamome | cwty | rwssammart| e |

Edlit...

Total Quantity: | Tatal Amaunt; | Dielete |

Ok | Cancel |

Java Applet Window

Figure56: Funding Sources — New Window

3. Tosearchfor an existing funding strip, click the [ M anage] button.
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The Funding Strip Search window opens.

Funding Strip Search x|
Search Criteria: IE S By
* Code
Mesne.. | Ediit.. | Copy... | Delete " Uzer ID
Search | select | Cancel | Template: IGIDbaI ;I
Cocle | U=et D
0 [ S
Jawva spplet Window

Figure57: Funding Strip Search Window

4. Select the appropriate template from the Template drop-down list box.

Note:  Selecting “Global” in the Template drop-down list box searches across all tenplates.

5. Enter Search Criteria.
6. Click the[Search] button.
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The search results display.

Funding Strip Search x|
Search Criteria; IE Sl By
& Code
Mesne.. | Ediit... | Copy... | Delete O Uzer ID
Template: I.&rm':.f ;I
Codle U=et D
GEDEI293111111111111112 k] Iy
2120000 2.&.&.&.&344BSSSCCCCCCCEE????BBDEEIEEIEH 1111111111 EEQEEESFBBBES Py
1| [ r
Java applet \Window

Figure58: Funding Strip Search Window

Note:  Only funding strips that have been created by the user or released by the PD? System
Administrator are displayed.

7. If thedesired funding strip is not found skip to step 10. If it isfound, continue with step 8.
8. Highlight the desired funding strip and click the [ Select] button.

9. Skiptostep 14.

Note:  For moreinformation on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

10. If thefunding strip is not found, click the [ New] button.
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The <Default Template> Funding Strip— New window opens.

Army Funding Strip - New x|

Fund Strip

Departrment Codel2) Fiscal Year(1]

ApproprigtionBasic Symbol(4) Lirnitation;4)

Prograrm Year(1] Operating Adency(2)
Allotnent Serial Mumber(d] Prograim Elementi11)
Eletrent of Resource(4]) MDERSSODP(E])

Document Reference Mumber(14) Accounting Processing Code(B)

Fizcal Station Murnber(6)

Select Template: Army i l QK | Cloze

Java Applet Window

Last Digit(1)

Figure59: Army Funding Strip — New Window

Note:  Thedefault funding strip template set by the System Administrator displays. If the
System Administrator has not selected a default template, you cannot continue

11. Tochangeto an alternate template, select another template from the Select Template drop-
down list box.

12. Enter the funding strip information in the appropriate fields.

Note:  Each field must either befilled out completely or left blank.

13. Click [OK].
The funding strip displays on thelist of available funding stripsin the Funding Strip
Search window.

14. Highlight the new funding strip and click the [Sel ect] button to select the new funding strip.

15. Enter the appropriate fund amount in the Funded Amount field.

The Funded Amount field allows the PRweb user to enter the desired dollar amount to
correspond with the selected funding strip. (It isnot required to enter adollar sign.)

Note: The Funded Amount defaults to the total cost of all lineitems.

16. Enter an Accounting Classification Reference Number (ACRN) in the Fund ACRN.

The Fund ACRN field allows users to enter ACRN information in the Funding Sour ce
window. Thisfield holds up to two characters.

17. Click [OK] to returnto the Contract Level Funding window.
18. Click [Closg] to return to the Pur chase Request window.
19. From the menu, select File® Save to update the funding information and save the PR.
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Editing a Funding Source

PRweb users can edit funding sources at the contract level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
isread-only.

& Purchase Request - PRO101 ;Iglil

File Line ltermn

Dezcription Purchaze Reguest Mumber
Purchase | [unitorms [PrRO101
Requeat Requisition Date DPAS Priority Rating | Priarity
| 24-Jun-2002 f3 f3
Mazin Form  Line Rem | Cortracts | &gel!| Data |
Total Funding: |$1E|||:|E|D_E|D Contract Level Funding

* liglues may he munded for disolay guiposes.

| Murnber | Description | Guantity | Unit of lzsues Unit Cost Tatal Caost *

Total Cost: [$0.00

I.Java Applet Window

Figure 60: Purchase Reguest - <Purchase Request Number> - Line |tem Tab

1. FromtheLineltemTab of the Purchase Request window, click the [Mor €] button next to
Contract Level Funding.

The Contract Level Funding window opens.
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% Contract Level Funding x|

Contract Level Funding

Funding Strigp Funded Amourt

21 21y 3446 ik 9991 1111111111 Gl 10,000.00

My .. """" Edit.. Delete Claze |

|Java Applet Window

Figure61: Contract Level Funding Window

2. Highlight the funding source to be edited and click the [ Edit] button.
The Funding Sources window opens.

£ runding Sources x|

Funding Sources

Document Mutmkber IF‘RD1 0
Total Estimated Cost: |$E|.I:IEI

Fund Strip Mewy... I Ecit... IManage...l
21 2 2488 A 3RS S0 CCCCCCRET T TEE0EISa 1A 1 111 2222227 FFFFF

Funded Amournt: |$1D,DDD.DD Fund ACREMN: |23

Job Order | Expiration Date | Quattity | Funded Amourit Acld.... |

Ediit...

Total Guantity: IEI.EI Total Amount;  |0.00 Delete |

QK | Cancel |

Java Applet Window

Figure 62: Funding Sources Window

3. Makedesired changes and click [ OK] to return to the Contract Level Funding window.
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4. Click [Closg] to return to the Purchase Request window.

5. From the menu, select File® Save to update the funding information and save the PR.

Deleting a Funding Source

PRweb users can delete funding sources at the contract level. Deleting a funding source removes
it fromthe PR. The System Administrator grants user rights to manage funding information. If
the user does not have these rights, funding information is read-only.

& Purchase Request - PRO101 ;Iglﬂ

File Line Iterm

Description Furchaze Reguest Mumber
Purchase | |uniforms [PRO101
REqUESt Reqguisition Date DPAS Priority Rating | Priority
|24-Jun-2002 E 3

Main Forrn  Line lem | Contracts | Addl Dsta

Total Funding: |$1E|,E|E|D.E|D Contract Level Funding  More... |
* Valves may he munded fordisolay purposes.
| Murnker | Dezcription | Gty | Unit of lzsues Unit Cost | Total Cost *

Total Cost:  |$0.00

|Java Applet \Window

Figure 63: Purchase Request - <Purchase Request Number> — Line Item Tab

1. Fromthe Line Itemtab of the Purchase Request window, click the [More€] button next to
Contract Level Funding.

The Contract Level Funding window opens.
2. Highlight the funding source to be deleted and click the [Delete] button.

3. Click the[Yes] button in the Confirmation window.

The Contract Level Funding window displays with the funding source deleted from the
table.

4. Click the[Closg button to return to the Pur chase Request window.

5. From the menu, select File® Save to update the funding information and save the PR.
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Creating a New Funding Strip

PRweb users can create funding strips at the contract level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information

isread-only.
i Purchase Request - PRO100 [_ (O] %]
File Line ltem
Drezcription Purchaze Request Mumber
Purchase | [supplies [PRO10D
Requeat R equizition D ate DPAS Priority Rating | Priority
|07-Jun-2002 |

Main Form ~ Line lem | Contracts | Addl Dsta

Total Funding: I Contract Level Funding  Mew. . |
* lalves may he munded fordisalay puvposes.
Mumber | Dezcription Quantity [ Unit of lssue Unit Ciozt | Total Cost =
Total Cost:

|"-.-\-"arning: Applet wWindow

Figure 64: Purchase Request - <Purchase Request Number> - Line Item Tab

1. Click the[New] button next to Contract Level Funding.
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The Contract Level Funding window opens.

Contract Level Funding E

Contract Level Funding
Funding Strip Funded Amount
D | 3
Mew... | Edit,.. [Vefete Cloge |

|Waming: Applet window

Figure 65: Contract Level Funding Window

2. Click the[New] button.

The Funding Sources— New window opens.

AcquiLine PRweb v2.3 58 July 29, 2002
Functional User’s Guide



Chapter 4: Purchase Request

Funding Sources - New

Funding Sources

Document Murnber |

Total E stimated Cost:

Fund Strip Mew... hanage...

Funded Amount: |$0.00 Fund ACRM:

Job Order | Expiration D ate | (uantity | Funded Amount Add... |

Tatal Quantity: Total Amount: |

(1] | Cancel |
Wharning: Applet Window
Figure 66: Funding Sources — New Window
3. Click the[New] button.
The <Default Template> Funding Strip - New window opens.

Army Funding Stiip - New

Fund Strip

Department Codel2] Fizzal Year(1]

Appropriation/E asic Symbol(4] Lirnitation(4)

Program vear[1] Operating Agencyl2]

Allotment Sernial Mumber(4] Program Element(17]

Element of Resource(4] MOEF/SODPE)

Daocument Feference Mumber(14] Accounting Proceszing Code(s)

Fizcal Station Mumber(E)

Select Template: Army j Ok | Cloze |

Wharhing: Applet Window

Figure 67: Army Funding Strip — New Window

4. To change an alternate template, select another template from the Select Template drop-
down list box.

AcquiLine PRweb v2.3 59 July 29, 2002
Functional User’s Guide



Chapter 4: Purchase Request

5. Enter the funding strip information in the appropriate fields.

Note:  Each field must either be filled out completely or left blank. However some fields may
be required, depending on how the System Administrator configured the funding
template.

6. Click [OK].
The funding strip displays inthe Fund Strip field of the Funding Sources - New window.

7. Click [OK] toreturn to the Contract Level Funding window.
8. Click [Closg] to return to the Pur chase Request window.

9. From the menu, select File® Save to update the funding information and save the PR.

Note: A new funding strip may also be created from the Funding Strip Search window by
clicking the [New] button.
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Copying a Funding Strip

PRweb users can copy funding strips at the contract level. Copying funding strips may save time
in the creation of new funding strips. The System Administrator grants user rights to manage
funding information. If the user does not have these rights, funding information is read-only.

& Purchase Request - PRO100 ;Iglﬂ
File Line ltem

Description Furchaze Reguest Mumber
Purchase | |s.pie: [PrRO100
REqUESt Reqguisition Date DPAS Priority Rating | Priority
07-Jun-2002 2 f1
Main Form ~ Line ftem | Cortracts | Add| Data |
Total Funding: |$1E|,E|E|D.E|D Contract Level Funding

* Valves may he munded fordisolay purposes.
| Murnker | Dezcription | Gty | Unit of lzsues Unit Cost Total Cost *

Total Cost:  |$0.00

|Java Applet \Window

Figure 68: Purchase Reguest - <Purchase Request Number> - Line Item Tab

1. Clickthe[More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

& Contract Level Funding |

Contract Level Funding

Funding Strip Funded Amount

|

e Edit... Celete Cloze |

|Java Applet wWindow

Figure69: Contract Level Funding Window
2. Click the[New] button.

The Funding Sources— New window opens.

Funding Sources - New Ed
Funding Sources

Diocument Mumber |F'F|EI1 i

Tatal E stimated Cost: |$D.EID

Fund Strip Mew... ity | Manage_._l

Funded Amount: |$EI.EIEI Fund ACEM: I

Job Order | E xpiration D1ate | [uantity | Funded Amount Add. . |

it |

Total Quantiby: I Total Amount: I Dielate |

Ok | Cancel |

|Warning: Applet WWindow

Figure 70: Funding Sources — New Window
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3. Click the[ Manage] button.
The Funding Strip Search window opens.

Funding 5trip S5earch
Search Criteria: I;gj Search By
' Code
Hem... | i | (B, | [Ielete | " User ID
Search | SEERE | Cancel | Template: IGInbaI ;I
Code | ger 1D
LI 3
|'W'arning: Applet \Window

Figure 71: Funding Strip Search Window
4. Select the appropriate template from the Template drop-down list box.

5. Enter Search Criteria, and click the [Sear ch] button.

Note:  For moreinformation regarding searches, refer to the “ Search Function” section in
Chapter 2: PRweb Desktop.
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Funding Strip Search x|
Search Criteria: IE Search By
* Code
e, | Ecit... | Copy... | Delete " Uzer |0
Zearch | Zelect | Cancel | Template: I.ﬂ«rm':.f ;I
Code Us=er |0

94477544445944455tuuh

1| Ih

Java Spplet Window

Figure 72: Funding Strip Search Window

6. Highlight the desired funding strip and click the [Copy] button.

The <Default Template> Funding Strip - Copy window opens with the copied funding
strip information in each field.

Army Funding Strip - Copy il
Fund Strip
559897555447 79444459444 55iqgh 4 545 75599r 55554 444444444397 3943999995
Department Code(2) Iaa Fizcal Year(1) Ig
AppropristionBasic Symbol(4) Iag?a Lirritation;4) |3944
Progratn Year(1) |;.' Operating Agency(2) |?g
Allotnent Serial Mutmnber(d) |4444 Prograrm Elermert(11) |8944455tggh
Eletrert of Resourceld) |4545 MODERSODPIE) |?8899r
Document Reference Mumber(14) |88884444444444 Accounting Processing Codels) |39?394
Fizcal Station Murmber(5) |899999 Lazt Digitc1) |3

Select Template: Army b I Ok | Cloze

Jawa Applet Window

Figure 73: Army Funding Strip — Copy Window

Note:  Thefunding strip is copied into the template that corresponds with the PRweb template
used to create the original funding strip. If the funding strip was created with a PRweb
template that has either been disabled or updated, the PRweb user is unable to copy the
funding strip. In addition, funding strips that were created in PD? will display as
Miscellaneous.
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7. Makethe desired changesto the funding strip.

8. Click [OK] to save the changes and return to the Funding Strip Search window.
The new funding strip displaysin the Funding Strip Search window.

9. Highlight the funding strip and click the [Select] button to select the new funding strip.
10. Click [OK] toreturnto the Contract Level Funding window.
11. Click [Closg] to return to the Pur chase Request window.

12. From the menu, select File > Save to update the funding information and save the PR.
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Editing a Funding Strip

PRweb users have two options for editing funding strips at the contract level. The System
Administrator grants user rights to manage funding information. If the user does not have these
rights, funding information is read-only.

If the System Administrator has updated or removed the template from which the selected funding
strip was created from, PRweb alerts the user that the temp late has changed.

Confirmation

® The funding template uzed to create this
funding strip has been changed or disabled.
Select Yes' to update using new funding

template. Select Mo to view selected
funding =trip az read only.

Tes Mo

|Waming: Applet Window

Figure 74: Confirmation Window

If the user selects[Yes], PRweb displays the updated version of the template or the default
template, depending on whether the template was disabled. The user is able to select another
template if desired from the Select Template dropdown list box.

Army Funding Strip - New E

Fund Strip

Department Code(2)

Fizcal "rear(1]

Appropriation/B asic Symbol[4] Lirnitation[4]

Program vear(1] Operating Agency|2]

Allotrment S erial Murnber[4) Program Element[11]

MDEPASODPE]

Element of Resource(4]

Document Reference Humber[14) Accounting Processing CodelB)

Fizcal Station Mumber[&) Lazt Digit[1]
Select Template: Ay - I Ok I Cloze

|Waming: Applet Window

Figure 75: Army Funding Strip — New Window
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If the user selects[No], the funding strip displays as read-only.

Army Funding Strip - [Read Only)

Fund Strip

|881 1288122230A1118PRE 1 2300397 M/ 333469025 PO40025G 0934555678054 2334

Department Codel2] Igg Fizzal Year(1] |1

Appropriation/Basic Symbaol4) |1 2AE Lirnitation(4] |1 2

Frogram Y'ear(1] |3 Operating Agency(2) IDA

Allatment Serial Murnber(4] |-| 118 Pragram Element[11] IF'FIE'I 2300997

Element of Resource(4) Ingg MDEF/SODP(E) |34ngg

Daocument Reference Mumber(14] Ispg4gn25|3 09345 Accounting Processing Code(B] |555?35

Fiscal Station Murnber(E) |SA2334

Select Template: Amoy 'I ] | Close

|Waming: Applet Window

Figure 76: Army Funding Strip — (Read Only) Window

Option 1. By Funding Strip Search

& Purchase Request - PRO100 =1O] x|
File Line ltem
Description Purchaze Reguest Mumber
Purchase | [s.puies [PrRO100
Requesi: Requistion Date DPAS Priorty Rating | Priarity
f07-Jun-z002 2 1

Main Forrn  Line lem | Contracts | Addl Dsta

Total Funding: |$1EI,IZIEID.EID Contract Level Funding Mure...l

* alyes may pe munded fordisnlay gupose s,

| Murnber | Dezcription | Guartity | Unit af lzsues Unit Cost | Tatal Caost * |

Total Cost: [$0.00

IJava Applet \Window

Figure 77: Purchase Request - <Purchase Request Number> - Line Item Tab
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1. Clickthe[More] button next to Contract Level Funding.
The Contract Level Funding window opens.

% Contract Level Funding x|

Contract Level Funding

Funding Strip Funded Amount
2120001 28,00 0 34 ARESSERCCCCCCEEETTEEDEA991 1111 1111111 11 222222323883 10,000.00

1| [+

Mew... Edit... Lelete Cloze |

IJava Applet wWindow

Figure 78: Contract Level Funding Window

2. Highlight the desired funding source and click the [ Edit] button.

Note:  The PRweb user can also double-click on the funding source to open the highlighted
funding source.
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The Funding Sources window opens.

unding Sources

Lelete

Figure 79: Funding Sources Window

3. Click the[Manage] button.
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The Funding Strip Search window opens.

Funding Strip Search
Search Criteria: IE Search By
* Code
MHew... | =it | [EGT. . | [elete | T User ID
Search | SE(ERE | Cancel | Template: |GI-:|I:|E|I ;I
Code | ger D
LI 3
|Warning: Applet Window

Figure 80: Army Funding Strip — Edit Window

4. Enter Search Criteria, and click the [Sear ch] button.

Note:  For moreinformation regarding searches, refer to the  Search Function” sectionin
Chapter 2: PRweb Desktop.

5. Highlight the desired funding strip and click the [ Edit] button.
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The Army Funding Strip— Edit window opens with the original funding information
displayed.

Note:  You may not edit afunding strip that is applied to either another PR or another funding
source on the same PR.

Army Funding Strip - Edit x|
Fund Strip
21 20 28,000 34 ARSSSEECCCCCCESST FEEDESIS 1111111111111 222222325F 883
Department Code(2) |21 Fiscal Year(1) |2
AppropristionBasic Symbol(4) |M|,.f\|“| 2 Litritation(4) I,a\,a_,a\,a,
Progratn Year(1) |3 Operating Auency(2) |44
Allotnent Serial Mumber(d] |EISSS Prograim Elementi11) |55ccccccsaa
Eletnent of Resource(4) |??33 MDER/SODP(E) |DE9999
Document Reference Mumber(14) |1 1111111111111 Accounting Processing Code(B) |222222
Fizcal Station hurnber(5) |323F88 Lazt Digit(1) |3
Select Template: Army vl QK | Cloze
Java Applet Window

Figure 81: Army Funding Strip — Edit Window

6. Makedesired changesto the funding strip and click [ OK] to return to the Funding Strip
Sear ch window.

7. Click the [Select] button to select the updated funding strip and return to the Funding
Sour ces window.

8. Click [OK] toreturntothe Contract Level Funding window.
9. Click the[Close button to return to the Pur chase Request window.

10. From the menu, select File® Save to update the funding information and save the PR.
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Option 2: By Funding Sources Window

& Purchase Request - PRO100 -0l x|

File Line Iterm

Description Furchaze Reguest Mumber
Purchase | [s.gple- [prRO100
Requeat Requistion Date DPAS Priority Rating | Priarity
07-Jun-2002 2 f1
Main Form ~ Line ftem | Cu:untradsl A Datal
Total Funding: |$1E|,E|E|D.E|D Contract Level Funding Mure...l

* lalves may he munded fordisolay puvposes.

| |rumoer [vescrpton | uentty | unkofissue]  umtcost | Totaicost” | |

Total Cost:  |$0.00

|Java Applet Window

Figure 82: Purchase Reguest - <Purchase Request Number> - Line Item Tab

1. Clickthe[More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

& Contract Level Funding

Contract Level Funding

Funding Strip

939311111111111111

Funded Amount

10,000.00

|

e Eciit... Delete

Cloze |

|Java Applet wWindow

Figure 83: Contract Level Funding Window

2. Highlight the desired funding source and click the [ Edit] button.
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The Funding Sources window opens.

£ runding Sources |

Funding Sources

Document Mutmkber IF‘RIZH oo
Total Estimated Cost: |$I:|.EIEI

Fund Strip ey, I Exiit... IManage...

21 2W0 280,00 34 4RSS 566 CCCCOCEEETFEEDESS99 1111111111111 22222 25323F583
Funded Amount: |$1D,DDD.DD Fund ACRRN: I

Job Order | Expiration Date | Quartity | Funded Amourit Add... |

Edlit...

Tatal Guantity: IIZI.EI Total &Amount; (000 Delete |

QK | Cancel |

Java Applet Window

Figure 84: Funding Sources Window

3. Fromthe Funding Sour ces window click the [ Edit] button next to the Fund Stripfield.
The Funding Strip— Edit window opens with the original funding information displayed.

Army Funding Strip - Edit il
Fund Strip
212001 28,8 04,8 344R55566CCCCCCAEETTEEDEIAI911111 114111111 222222323F 883
Department Code(2) |21 Fizzal Year(1) |2
AppropristionBasic Symbol(2) |Mw1 o Litritation;4) IAAAA
Program Year(1) |3 COperating Agency(2) |44
Allotrment Serial Mumber(4) IEISSS Prograim Element(11) |55cccccc533
Eletnent of Resource(4) |??3a MDEP/SODP(E) |DEgggg
Document Reference Mumber(14) |1 1111111111111 Accounting Processing Codel(E) IQQQQQQ
Fizcal Station Mumber() |323F33 Last Digit(1) |3

Select Template: Srmy bt I O | Cloze

Java Applet \Window

Figure 85 Army Funding Strip — Edit Window
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4. Make desired changesto the funding strip and click [ OK] to return to the Funding Sour ces
window.

5. Click [OK] toreturn to the Contract Level Funding window.
6. Click the[Close button to return to the Pur chase Request window.

7. From the menu, select File> Save to update the funding information and save the PR.

Deleting a Funding Strip

PRweb users can delete funding strips at the contract level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
isread-only.

£ purchase Request - PRO101 =10l x|
File Line ltem

Description Purchaze Reguest Mumber
Purchase | |uniforms [PrRO101
Requesi: Requistion Date DPAS Priorty Rating | Priarity
[ 24-Jun-z002 3 3
Main Form ~ Line tem | Cortracts | Al Dats |
Total Funding: |$1EI,IZIEID.EID Contract Level Funding Mure...l

* alyes may pe munded fordisnlay gupose s,

| Murnber | Dezcription | Guartity | Unit af lzsues Unit Cost | Tatal Caost * |

Total Cost: [$0.00

IJava Applet \Window

Figure 86: Purchase Request - <Purchase Request Number> Window

1. Clickthe[More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

& Contract Level Funding

Contract Level Funding

Funding Strip

99931111 111111111:

Funded Amount

10,000.00

e ... i Edit.. i Delete

Cloze |

|Java Applet wWindow

Figure 87: Contract Level Funding Window

2. Highlight the desired funding source and click the [ Edit] button.
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The Funding Sources window opens.

& Funding Sources ﬂ

Funding Sources

Document Mutmkber IF‘RIZH 01
Total Estimated Cost: |$I:|.EIEI

Fund Strip ey, I Exiit... IManage...
|21 WA 248,800 34 4RSS SCCCCCCCEST 7T TEE0EII9 1M 111141111 222222 FFFFFF 3

Funded Amount: |$1D,DDD.DD Fund ACRRN: I
A, |

Edlit...

Tatal Guantity: IIZI.EI Total &Amount; (000 Delete |

QK | Cancel |

|.Jax-'a Applet Window

Figure 88: Funding Sources Window

3. Click the[Manage] button.
The Funding Strip Search window opens.

4. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information regarding searches, refer to the “ Search Function” sectionin
Chapter 2: PRweb Desktop.
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Funding Strip Search x|
Search Criteria; IE Sl By
¥ Code
Mesne .. | Eclit... | Copy... | Delete " Uzer ID
Zearch | Zelect | Cancel | Template: I.ﬂ\rrn':.f ;I
Code | Uzer D

2120 28880 34ABSSS66CCCCCCREE T T SEDEI99 1 11111111111 11 2222225323F 883 v ay
2120000 208 00 34 ARSSSCCOCC OCEETTTTEEDEAS 11 111111141 222222 3F 58883 Py

21 WA 28,0, 4 T4 4B 77776E0EAI99111111111111122 IZZIZ3  tway

1| [r

Java applet \Window

Figure 89: Funding Strip Search Window

5. Highlight the desired funding strip and click the [Delete] button.

Note:  You may not delete afunding strip that is applied to either another PR or another funding
source on the same PR.

6. Click the[Yes] button in the Confirmation window.

The Funding Strip Search window displays with the funding strip deleted fromthe table.
7. Click the[Cancel] button to return to the Funding Sour ces— New window.

8. Click [OK] toreturntothe Contract Level Funding window.

9. Click the[Close button to return to the Pur chase Request window.

10. From the menu, select File® Save to update the funding information and save the PR.
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Creating a Job Order

PRweb users can create job orders at the contract level. The System Administrator grants a user
rights to manage funding information. I the user does not have these rights, funding and job order
information is read-only.

& Purchase Request - PRO101 =10] x|

File Line Iterm

Description Furchaze Reguest Mumber
Purchase | |uniforms [PRO101
REqUESt Reqguisition Date DPAS Priority Rating | Priority
|24-Jun-2002 E E
Main Form ~ Line ftem | Cu:untradsl A Datal
Total Funding: |$D_E|E| Contract Level Funding  Rlew...

* Valves may he munded fordisolay purposes.

| [rwmber [vosorpton | uentty | unkotiesue]  umtcost | Totacost” | |

Total Cost:  |$0.00

|Java Applet \Window

Figure90: Purchase Request - <Purchase Request Number> Line Item Tab

1. Click the[New] button next to Contract Level Funding.
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The Contract Level Funding window opens.

& Contract Level Funding |

Contract Level Funding

Funding Strip Funded Amount

| [+

e Edit... Celete Cloze |

|Java Applet wWindow

Figure91: Contract Level Funding Window

2. Click the[New] button.
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The Funding Sources— New window opens.

it

22 Funding Sources - New

Lelete

Figure 92: Funding Sources—New Window

3. Click the[ Add] button next to the Job Order table.
The Attach Job Order — New window opens.

3, Attach Job Order - New

[

Figure 93: Attach Job Order — New Window

4. Click the[Select] button.
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The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
Search | =elect Cancel
Job Order Mumber Fundz Expiration Date

Java applet \Window

Figure 94: Job Order Number Search Window

5. Click the[ New] button.
The Create New Job Order window opens.

& Create New Job Order x|

Job Order Mumbet: I

Fundz Expiration Date: I

Ok | Cancel

Java Applet Window

Figure 95: Create New Job Order Window

6. Enter anumber inthe Job Order Number field and an exp iration date in the Funds
Expiration Date field.

Note:  Thefunds expiration date can be entered manually or by using the Auto-Calendar feature.
For more information on the Auto-Calendar, refer to “ Auto-Calendar Feature” sectionin
Chapter 2: PRweb Desktop.

7. Click [OK] toreturntothe Job Order Number Search window.
8. Double-click the new job order to return to the Attach Job Order window.

9. Click [OK] toreturn to the Funding Sour ces— New window.
Thejob order displaysin the Funding Sources— New window.
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10. Click [OK] to returnto the Contract Level Funding window.
11. From the menu, select File® Save to update the job order information and save the PR.

Attaching a Job Order

PRweb users can attach job orders at the contract level. The System Administrator grants a user
rights to manage funding information. If the user does not have these rights, funding and job order
information is read-only.

& Purchase Request - PRO101 : - |I:I|i|
File Line Iterm

Description Purchaze Reguest Mumber
Purchase | [unitorms [PrROT01
RequeSt Requistion Date DPAS Priorty Rating | Priarity
| 24-Jun-2002 [3 [3
Main Form  Line Rem | Cortracts | &clef!| Data |
Total Funding: |$|:|_|:||:| Contract Level Funding New...l

* liglues may he munded fordisolay guiposes.
| Murnker | Description | Guantity | Unit of lzsue Unit Cost | Total Cost * |

Total Cost:  |F0.00

|Java Applet \Windaw

Figure 96: Purchase Request - <Purchase Request Number> Line Item Tab

1. Click the[New] button next to Contract Level Funding.

The Contract Level Funding window opens.

2. Click the[New] button.
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The Funding Sources— New window opens.

& Funding Sources - New . |

Funding Sources

Document Mutmkber IF‘RIZH 01
Total Estimated Cost: |$I:|.EIEI

Fund Strip ey, I Ediit... IManage...

Funded Amount: ISBIZI.IZIIZI Fund ACRRN: I

Job Order | Expiration Date | Quartity | Funded Amourit Add... |

Edlit...

Total @uantity: | Tatal Amaount: | Dilste |

Ok | Cancel |
Java Applet Window
Figure 97: Funding Sources — New Window
3. Click the[ Add] button next to the Job Order table.
The Attach Job Order — New window opens.
Attach Job Order - Hew

Job Order: I
Funded Amount:  0.00000

Funded Quartity: IN;".-’-'-.

k. Canicel

|Warning: Applet Window

Figure 98: Attach Job Order — New Window

4, Click the[Select] button.
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The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
Search | =elect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 99: Job Order Number Search Window

5. Enter Search Criteria, and click the [Sear ch] button.

The search results display.

Job Order Number Search x|
Seatch Criteria
IE [W¥ Current Job Orders Only
e | Search Select cancel |
Job Order Mumber Fundz Expiration Date j
PSR 28-Jun-2003
Pl J R 18-Jun-2004
hAODO01 25456759 10-Feh-2019

hfif1 111000093553 30-Sep-2002

MO0123 12-May-2009

MhAPOO01 12-Mary-2201

MMAPOO0T 11 -Mary-2201

kjlzkil 27_Jun-2002 =

1| [+
Java dpplet window

Figure 100: Job Order Number Search Window

6. Highlight the desired job order number and click the [Select] button.
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The Attach Job Order - New window opens.

& Attach Job Order - New

Jab Order: |wrnm:|33993

Funded Amaourt: ||:|.|:u:|nn|:|

Funded Quartity: |NIA

Ok Cancel

I-.lava Applet 'Window

Figure 101: Attach Job Order — New Window

7. Click [OK] toreturn to the Funding Sour ces- New window.
8. Click [OK] toreturntothe Contract Level Funding window.

9. From the menu, select File® Save to update the job order information and save the PR.
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Editing a Job Order

PRweb users can edit job orders at the contract level. The System Administrator grants a user
rights to manage funding information. I the user does not have these rights, funding and job order

information is read-only.

=13l x|

& Purchase Request - PRO101
File Line ltem

Furchaze Reguest Mumber

Description
[PRO101

Purchase [Unitorms

REqUESt Reqguisition Date
|24-Jun-2002

DPAS Priority Rating | Priority
E E

Main Forrn  Line lem | Cu:untradsl Al Data

Total Funding: |$1E|,E|E|D.E|D Contract Level Funding Mure...l

* Valves may he munded fordisolay purposes.

Tatal Cost *

F10,000.00

Unit Cost
40.00

Unit of lzsue

Dezcription
Urnitarm Shirt

Murmber
oo

Total Cost:  [$10,000.00

|Java Applet \Window

Figure102: Purchase Reguest - <Purchase Reguest Number> Line Item Tab

1. Clickthe[More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

& Contract Level Funding |

Contract Level Funding

Funding Strip Funded Amount
21 2h0 2880054 4RSS 566 CCCCCCESETVSEDESS99 111 11 1 1111 11 2222223253F 583 10,000.00

| [+

e Edit... Celete Cloze |

|Java Applet wWindow

Figure103: Contract Level Funding Window

2. Highlight an existing funding source and click the [ Edit] button.
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The Funding Sources window opens.

& Funding Sources ﬂ

Funding Sources

Document Mutmkber IF‘RIZH 01
Total Estimated Cost: |$1 0,000.00

Fund Strip ey, I Exiit... IManage...
|21 W0 248,000 34 4RSS SERCCCCCCEEATFEE0EII9 1111111111111 222222323F 553

Funded Amount: IIZI.EIIZI Fund ACRRN: I

hTAD0SE995 01-Zep-2003

Edlit...

Tatal Guantity: IIZI.EI Total &Amount; (000 Delete |

QK | Cancel |

Java Applet Window

Figure 104: Funding Sources Window

3. Highlight the desired job order and click the [ Edit] button next to the Job Order table.
The Attach Job Order - <Job Order Name>window opens.

& Attach Job Order - MWO08§993

Jok Order: |mein0sasss

Funded Amourt:  |0.00

Funded Quartity: |Nm

Ok Cancel

I.Java Applet Windaw

Figure 105: Attach Job Order - <Job Order Name> Window

4. Click the[Select] button.
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The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
e | Search =elect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 106: Job Order Number Search Window

5. Enter Search Criteria, and click the [Sear ch] button.

6. Highlight ajob order number and click the [ Select] button.

The Attach Job Order - <Job Order Name>window opens with the new job order
number displayed in the Job Order field.

& Attach Job Order - MW0D038993

Job Order: |coneaara

Funded Amourt:  |0.00

Funded Quartity: |Nm

Ok Cancel

Java Applet Window

Figure 107: Attach Job Order - <Job Order Name> Window

7. Click [OK] toreturn to the Funding Sour ces window.
8. Click [OK] toreturntothe Contract Level Funding window.

9. From the menu, select File® Save to update the job order information and save the PR.
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Deleting a Job Order

PRweb users can delete job orders at the contract level. The System Administrator grants a user
rights to manage funding information. I the user does not have these rights, funding and job order

information is read-only.

=13l x|

& Purchase Request - PRO101
File Line ltem

Furchaze Reguest Mumber

Description
[PrRO101

Purchase | Unitorms

REqUESt Reqguisition Date
|24-Jun-2002

DPAS Priority Rating | Priority
E E

Main Forrn  Line lem | Cu:untradsl Al Data

Contract Level Funding  More. .. |

* Valves may he munded fordisolay purposes.
Unit Caost Tatal Cost *

40.00 0 000,00

Total Funding: |$1 0,000.00

Unit of lzsue

Dezcription
Urnitarm Shirt

Murmber

o0

F10,000.00

Total Cost:  [$10,000.00

|Java Applet \Window
Figure 108: Purchase Reguest - <Purchase Reguest Number> Line Item Tab

1. Clickthe[More] button next to Contract Level Funding.
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The Contract Level Funding window opens.

& Contract Level Funding

Contract Level Funding

Funding Strip

939311111111111111

Funded Amount

10,000.00

|

e Eciit... Delete

Cloze |

|Java Applet wWindow

Figure109: Contract Level Funding Window

2. Highlight an existing funding source and click the [ Edit] button.
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The Funding Sources window opens.

£ runding Sources |

Funding Sources

Document Mutmkber IF‘RIZH 01
Total Estimated Cost: |$1 0,000.00

Fund Strip ey, I Exiit... IManage...

21 2000 2488 8 A S ARSSSRRCCCCOCEEETTEEDEI9 1111111111111 22222 25323F 553
Funded Amount: IIZI.EIIZI Fund ACRRN: I

Job Order Expiration Date Quartity Funded Amourit Add...

Mol JOR 28-Jun-2003

Edit...

Tatal Guantity: IIZI.EI Total &Amount; (000 Delete |

QK | Cancel |

Java Applet Window

Figure 110: Funding Sources Window

3. Highlight the job order and click the [ Delete] button next to the Job Order table.

4. Click the[Yes] button in the Confirmation window.
The Funding Sources window displays with the job order deleted fromthe table.

5. Click [OK] toreturntothe Contract Level Funding window.

6. From the menu, select File® Save to update the job order information and save the PR.
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Contracts Tab

The Contracts tab of the PR allows the PRweb user to designate Suggested Contract
Information, aContract Number, and a Suggested Prefer ence Program.

& Purchase Request - New -0l x|

File Line Iterm

Description Purchaze Reguest Mumber
Purchase | |
REqUESt Requisition Date DPAS Priority Rating | Priority
| 28-Jun-z002 |

Mait Formm | Line tem Contracts | Al Data

Suggested Contract Infarmatiar

0 Delivery Order ™ mModification

Cortract Mumber Select...l

Suggested Preference Program
|Nu Preference § Mot Listed j

IJava Applet \Window

Figure 111: Purchase Request — New — Contract Tab

1. Select the appropriate Suggested Contract Information radio button.
The Suggested Contract I nfor mation radio buttons enable the PRweb user to suggest either
aDelivery Order or Modification for the requirement.

2. Click the[Select] button next to the Contract Number field.

The Contract Number search field allows the PRweb user to select an existing contract in
PD? and associate it with the PR. The Contract Number search field pulls all contracts
available in the PD? database that meet the PRweb user’ s search criteria.
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The Attachment Search window opens.

Attachment Search |
Search Criteria Document Type
IE |Cu:unstruu:1iu:un Cortract Award ;I
Search By
Search I Select | Cancel | % Document Mumkber " Document Title
Document Mumber | Document Title

Jawa Applet WwWindow

Figure 112: Attachment Search Window

3. Select the appropriate contract type from the Document Type drop-down list box.

4. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

o

Highlight the desired Document Number for the contract.

6. Click the[Select] button.
The Contracts tab displays with the selected contract in the Contract Number field.

7. Select the desired preference program from the Suggested Pr efer ence Program drop-down
list box.
The Suggested Pr efer ence Program drop-down list box allows the PRweb user to designate
the desired Preference Program for the requirement.

8. Click the desired Preference Program.
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Add’l Data Tab

The Add’| Data tab allows the PRweb user to add any Additional Point of Contact (POC)

Information and Security Clearance Requirements. The user can also view any Contracting
Officer Notes (KO Notes).

& Purchase Request - New

_(ol x|
File Line Item

Description
Purchase

Request

Furchaze Reguest Mumber

DPAS Priority Rating | Priority

Reqguisition Date
| 28-Jun-2002

hain Form | Line tem | Cortracts  Add’l Data |

Addtional Point of Contact (POC) Information _ Select.. |

Security Clearance Required

;I * Unclassified " Secret

Ky " Confidential  Top Secret
Kl :
KO Motes

]
=
|Java Applet \Window

Figure 113: Purchase Request —New — Add’'| Data Tab

1. Click the[Select] button next to the Additional Point of Contact (POC) Information field.

The Additional Point of Contact (POC) Infor mation field allows the PRweb user to include
one additional POC on the PR. The POC information is pulled from the PD? database.
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The Contact Search window opens.

Contact Search

Search Criteria Search By

IE ' Code £~ Organization Mame

" Contact Mame  © Phone Mumber
Search | Selewt | Cancel | " State " Zip Code
Contact | Code | Organization | City | State | Zip Code PH

LI 5

|Warning: Applet Window

Figure 114: Contact Search Window

2. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

3. Highlight the desired contact.

4. Click the[Select] button.
The Add’l. Datatab displays the selected contact in the Additional Point of Contact
(POC) Information field. The[Select] button is now a [ Remove] button.

5. Select the appropriate Security Clearance Required radio button.

The Security Clearance Requir ed radio buttons enable the PRweb user to add additional
security information for the requirement.

Note: TheKO Notes field is provided for the Contracting Officer (KO) to input any additional
requirement information in PD?. If the PR is returned to the PRweb user, the KO notes
aredisplayed in thefield. InPRweb, thisfield isread-only.

Saving a Purchase Request

The Save menu option allows the PRweb user to save all changes made to the PR. Upon
completing a PR, the PRweb user must save the PR information. If the PR is updated with new
information, the PR must also be saved. To saveaPR, select File > Save from the menu.

Note:  Updating and saving are two separate functions. A PR that has been updated with
information needs to be saved in order to save the PR in its updated status.
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Closing a Purchase Request
The Close menu option allows the PRweb user to close the PR.
To closethe PR:
1. From the menu, select File > Exit.
2. Click the[Yes] button in the Save Confirmation window if the PR information needs to be

saved. Click the [NQ] button in the Save Confirmation window if the PR information does
not need to be saved.

Note:  If aPR has been updated with new information, it is necessary to save the PR before
closing it.

Editing a Purchase Request

PRweb users can open PRs for viewing from the Drafts, Inbox, Outbox and Archives folders.
Open PRs contained in the Drafts, Inbox or Outbox folders may also be edited.

Toopen aPR:

1. From the desktop, click the plus symbol (+) next to the desired folder (e.g., Drafts, Inbox,
Outbox, or Archive).

2. Highlight the PR.
3. From the menu, select Purchase Request - Open, or double-click the highlighted PR.

4. Edit or view the PR as necessary.

Note:  For more information refer to Creating a New Purchase Request in this chapter.

Copying a Purchase Request

PRweb users can copy an existing PR that resides in any of the desktop folders. The ability to copy
PRsisavaluabletool that can reduce the creation time for a PR by eliminating repetitive data
entry. Using the Copy feature resultsin creating a copy of the entire PR including lineitems, and
funding. Funding that is not available to the specific user is not copied and the user is notified of
thisinaWarning window.

Note:  PRweb users can also copy PR Mods. However, the copied PR Mod displaysin a
Purchase Request — New window.
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' PRweb Mi=] E3

File Preferences Help

e . MHew...

e Open...

t2 Inbio .|:|

(7 Outhos Wigw Surnmary.. .

Delete

FR Status Repart...
Standard Reparts. ..

Renurber. ..

Route...

A =

Wiew Approwal Histony. .

I acquzer]
|Warning: Applet Window

Figure 115: Purchase Request Copy Menu Option

1. From the PRweb user’s desktop, highlight the desired PR to be copied.

2. Fromthe menu, select Purchase Request > Copy.
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The Purchase Request - New window opens.

& Purchase Request - New -0l x|

File Line Iterm

Furchaze Reguest Mumber

DPAS Priority Rating | Priarity

Description
Purchase | [copy oftestizs|

Request

Requistion Date
| 28-Jun-2002

Main Form | Lite Heml Cu:untradsl e | Datal

Reguesting Office Selec:t...l Type of Action

winl TER REED ARMY MEDICAL CEMTER | | % Small Purcha=e " Grants/Coops Agreement
DIRECTORATE OF CONTRALCTING ™ Competed Contract " Zesled Bid

ATTH: HSHL-ZC, BUILDING T-20 _l;l " Mon-Competed Contract ¢ FSSIGSA Schecule

ﬂ L ™ Manufacturer Sole Source © Commercial

lesuing Office Delete | |© Delivery Order " NIB £ MISH / FPI
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Figure 116: Purchase Reguest — New —Main Form Tab
3. Enter anew description for the PR in the Descripti on field, if necessary.
The Description field automatically populates with the description “ Copy of <Description>.”
4. Enter aunique number in the Purchase Request Number field.

5. The user can make any necessary changes to the PR and associated line items, attachments,
and funding before saving the PR.

6. From the menu, select File > Save to save the PR Copy.
The copied PR display in the Drafts Folder.

Note:  Any information contained on the original PR that is PD?-specific datais not copied onto
the new PR.
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Copying a PR Mod

PRweb users can copy an existing PR Mod. Thisthat residesin any of the desktop folders. The
ability to copy PRsisavaluable tool that can reduce the creation time for a PR by eliminating
repetitive dataentry. Using the Copy feature results in creating a copy of the entire PR including
lineitems, and funding. Funding that is not available to the specific user is not copied and the user
isnotified of thisin aWarning window.
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Figure 117: Purchase Request Copy Menu Option

1. From the PRweb user’s desktop, highlight the desired PR Mod to be copied.

2. From the menu, select Purchase Request > Copy.

AcquiLine PRweb v2.3 101 July 29, 2002
Functional User’s Guide



Chapter 4: Purchase Request

The Purchase Request - New window opens.

& Purchase Request - New -0l x|

File Line Iterm

Furchaze Reguest Mumber

DPAS Priority Rating | Priarity

Description
Purchase | [copy oftestizs|

Request

Requistion Date
| 28-Jun-2002

Main Form | Lite Heml Cu:untradsl e | Datal

Reguesting Office Selec:t...l Type of Action

winl TER REED ARMY MEDICAL CEMTER | | % Small Purcha=e " Grants/Coops Agreement
DIRECTORATE OF CONTRALCTING ™ Competed Contract " Zesled Bid
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ﬂ L ™ Manufacturer Sole Source © Commercial
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Figure 118: Purchase Reguest — New —Main Form Tab
3. Enter anew description for the PR in the Description field, if necessary.
The Description field automatically populates with the description “ Copy of <Description>.”
4. Enter aunique number in the Purchase Request Number field.

6. The user can make any necessary changes to the PR and associated line items, attachments,
and funding before saving the PR.

7. From the menu, select File > Save to save the PR Copy.
The copied PR display in the Drafts Folder.

Note:  Any information contained on the original PR that is PD?-specific datais not copied onto
the new PR.
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Deleting a Purchase Request
The Delete feature allows the PRweb user to delete existing PR and PR Mods that reside in the
user’s Drafts or Outbox folders. The user cannot delete adocument that isin the Inbox or Archive
folders. Deleting aPR or PR Mod removes the document from the user’ s desktop and the PRweb
database. The PR Number isthen available for future use.
TodeleteaPR or PR Mod:
1. From the PRweb user’s desktop, highlight the desired PR or PR Mod to be del eted.

2. From the menu, select Purchase Request > Delete.

A Confirmation window appears to confirm the command to del ete the document.

3. Click the[Yes] button.

Renumbering a Purchase Request

PRweb users can renumber a PR after it has been saved. A PR that residesin the Drafts, Inbox, or
Outbox can be renumbered.

1. Fromthe PRweb user’s desktop, highlight the desired PR.

2. From the menu, select Purchase Request > Renumber .

The PR Renumber window opens.

PR Renumber

Current PR Mumber: |123Train
Mew PR Mumber: I

k. Cancel

|Warning: Applet WwWindow

Figure 119: PR Renumber Window

3.  Enter the new PR number in the New PR Number field.

4. Click [OK] to save the new number.
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View Summary
PRweb users can view and print a synopsis of the PR information.
1. Fromthe user’sdesktop, highlight a PR.

2. From the menu, select Purchase Request > View Summary.
The Purchase Request Summary View window opens.

Purchase Request Summary View
Description: Training =
Humber: Train123
Requisition D ate: 2R-Apr-2001
DPAS Priority Rating:

Priority:
Type of Action: Small Purchaze
Comments: (.

Requesting Office:
DIRECTORATE OF PEMINSULA COMTRACTING, ATTH: ATZF-DPCIBUILDING 27461 HARRISON LOOP,
FORT EUSTIS, W 23604-5293

Issuing Office:
USPFO FOR PUERTO RICO, P.O. BOX 3786, SAM JUAN,, PR 00904-3786

Suggested Yendors:

FAIRCHILD SP & DEF CORF

Suggested Contract Information:  Delivery Order

Contract Humber: DAk F36-01-C-0007 -
o

| - -

Print HTML Repart | " Ciase |

|'W'aming: Applet Window

Figure 120: Purchase Request Summary View Window
3. Clickthe[Print HTML Report] button.
A new Web browser window opens.

4. From the menu, select File > Print.

The PR printsto the machine’ s default printer.

5.  From the Web browser window menu, select File > Close

The Web browser window closes.

6. Click the[Closg] button in the Purchase Request Summary View window.
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Chapter 5: PR Modifications

PRweb allows the PRweb user to create a PR
Modification by highlighting the archived PR. The PR
Modification (PR Mod) contains the contract and line
item level information from the archived base PR. The

In This Chapter...

Using the PR Modifications

PR Mod feature is similar to the PR feature. PRweb functi on.s described in this chapter,
allows the requesting agent to create, route, approve, and you can:
submit the PR Mod to the Contracting Office. - Create a PR Modification

In order for aPR Mod to be created from a PR, following Manage a PR Modification

criteria must be met: - Renumber a PR Modification

The PR has been approved in PD?

A PR Mod has not been created in PD? off the PR
An unapproved/unreleased PR Mod does not exist in PD?
A PR Mod for the selected PR is not in progress in PRweb

Note: If anew PR Mod isbeing created from an existing PR Mod that was created in PRweb,
the existing PR Mod must be approved and released in PD?.

The PR Mod that is created in PRweb will contain all the conform information that existsin PD?
for the base document. Attachments that have been generated with the base document will be
attached to the resulting PR Mod. However, the DD254 that was added to the base document is
not carried over to the PR Mod that is created in PRweb.

Creating a PR Modification

To create anew Purchase Request Modification:
1. Highlight the desired PR in the Archive folder.
2. From the menu, select Purchase Request > New - PR Maodification.
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Figure121: New PR Modification Menu Option

3. Enter the PR Modification extension number in the Select M odification Number window.

& Select Modification Number x|

Prewvious PR Mumber IF'R Test2

Mewe PR Mumber: IF'R Test?- ||:u:|n1

033 | Cancel

Java Applet Window

Figure 122: Select Modification Number Window

Note: ThePrevious PR Number field isread-only. The PR Modification number consists of
the Previous PR Number and afour digit PR Modification extension number. The
extension number defaults to the next available number, however the PRweb user is able

to edit the extension number.

4. Click the[ OK] button to create anew PR M odification.
The PR Modification displays.
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i PR Mod - PR Test2-0001 =10l x|

File  Line Item

Dezcription Purchaze Request Mumber
Purchase | [rr tod PR Test2-0001
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|29-May-2002 |3 3

Main Form ‘ Line tem | Cortracts | Add) Data |

Requesting Office Seleu:t...l Type of Action

Masial SURFACE wWaRFARE CEMTER ¥ Small Purchasze {~ Grants/Coops Agreement
CRANE DIVISION ™ Competed Contract " Sealed Bid

300 Hw 367

" Mon-Competed Contract ¢ F55/G54 Schedule
™ Manutacturer Sole Source  Commercial
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CRAME. IN 47522
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Figure 123: PR Mod - <PR Madification Number> Window

The PR Mod Header displays at the top of the PR Mod window and is visible from every tab of the
PR Mod window.

PR Mod - PR Test2-0001 =10l x|

File  Line Item

Dezcription Purchaze Request MNumber
Purchase [Fr mod PR Test2-0001
Requeslt Requizition D ate DPAS Priority R ating | Pricrity
|29t ay-2002 E E

Figure 124: New PR Modification Header

5. Enter adescription in the Description field.

Note:  The PR Modification defaults the description to display “PR Mod”. However, the
PRweb user is able to edit the description.

The description allows the PRweb user to assign a descriptive reference of up to 60
characters. Thisfieldisrequired to save aPR.

6. ThePurchase Request Number field is read-only and displays the PR Modification Number
previously selected.
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7. Enter the Defense Priority Allocation System (DPAS) Priority Rating in the DPAS Priority
Rating field.

Thisfield holds up to 30 characters.

8. Enter the appropriate priority number in the Priority field.
Thisfield holds any number between 1 and 15.

Managing a PR Modification
The PRweb user is able to edit, view, copy, approve, and route PR Mods. ManagingaPR Mod is

similar to managing PRs. For more information on managing a PR, refer to Chapter 4: Purchase
Request. For more information on routing a PR Mod, refer to Chapter 9: Workflow.

Renumbering a PR Modification

PRweb users can renumber a PR Mod after it has been saved. A PR Mod that residesin the
Drafts, Inbox, or Outbox folders can be renumbered. PR Modsthat are in the Archive folder
cannot be renumbered.

1. Fromthe PRweb user’s desktop, highlight the desired PR.

2. From the menu, select Purchase Request > Renumber .

The PR Renumber window opens.

& PR Renumber x|

Current PR Mumbet: IF‘R Test2-0001

Mesne PR Mumbet: IF‘R Test?- |

04 | Cancel

|Java Applet Window

Figure125: PR Renumber Window

3.  Enter the new PR Modification extension number in the New PR Number field.

4, Click [OK] to save the new number.
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Chapter 6: Line Item

Creating a Line Item In This Chapter...

1. From the menu, select Lineltem > New > e Sielienibetalfictions

CLIN. described in this chapter, you can:
TheLine Item Detail — New window opens - Createaline ltem
with the Detail tab displayed. - Manage Funding Sources

TheLine Item Detail header displays at the top METETD RS2

of the Line Itemform and is visible from every - Manage Job Orders
tab of the Line Item Detail window. . Create aSUbCLIN

i Line Ttem Detail - New o =] |

File Funding

Line ltem Detail | Mumber Description
Jpoo |

Detail | Descrigtion | Furnicinig | Shifpiri | Lacal Info

NSM: | Select._|
Delivery Date: % l:] I ;]I =)

Start Date End Date
Period of Performance: ;Ew!ﬂ %
CLIN Type: * Priced " |nfo Only

Estended Description:

[uantity E ztimated Linit Price E ztimated Line [tem Cosgt
Iter Calculation: | X = ]
Perind: " Option * Baze Opt. #: ]_‘ Uit af |zsue
MILSTRIP: | [ =1

{wWarning: Applet Window

Figure 126: Line Item Detail — New - Detail Tab
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2. Enter adescription in the Description field.

The Description field for the line item holds up to 65 characters.

Detail Tab
The Detail tab allows the PRweb user to provide information pertaining to the NSN, Delivery
Date, or Period of Performance, aswell asCLIN Type, Extended Description, Quantity,
Estimated Unit Price, Period, Option Number (if applicable), MIL STRIP, and Unit of Issue.
=
File  Funding
Line ltem Detail MNumber Description
oo [
Detall | Description | Funding I Shipping I Lacal Infio
MSM: I Select. . |
Delivery O ate: I :w: (] | =1 =)
Start D ate End Date
Penod of Performance: I %W:l I éwli
CLIM Type: + Priced ¢ |nin Orily
Extended D escrption: .
[uantity E ztimated Linit Frice E ztimated Line Item Cost
[tenn Calzulation: I X ! = i
Feriad: " Dption & Baze Opt. #: I Uiibafbcie
MILSTRIF: | | =l
|'-.-'-.-'arning: Applet Window
Figure 127: Line Item Detail - New — Detail Tab
1. Toassociate an NSN with the line item, click the [Sel ect] button next to the NSN field.
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The NSN Search window opens.

shsearch |
Search Criteria
Search By:
' MSH
" Description

B

Search Results:

HSH Dezcnphion Unit af lzzue | War Gty + | War Qb - | BM/S5S5 |

Search Select Cancel

Warning: Applet Window

Figure 128: NSN Search Window

2. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

3. Highlight the desired NSN.

4. Click the[Select] button.

The selected NSN automatically popul ate the following fields with information from PD2:
NSN, Description, Extended Description, Unit of I ssue, Var in Qty +, Var in Qty —, and
Brand Name/Sole Source.

Note:  If noinformation existsin PD? for Variation in Quantity(+),Variation Quantity (-)%, or
Brand Name/Sole Source, then the search shall display these fields as blank.

5. There must be aDelivery Date or Period of Performance entered in order to save theline
item.
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Note: If thePricedradio button is selected, a Delivery Date or Period of Performance is
required. If the Info Onlyradio buttonis selected, the Delivery Date or Period of
Performanceis not required.

a. If thelineitem requires a specific delivery date, enter it in the Delivery Date field
manually or use the Auto-Calendar feature.

b. If thelineitem requiresan ADC or AFATA delivery date, select the appropriate units of
time from the drop-down list box to the right of the Delivery Date field and enter the
numeric valuein the field on the left.

c. If thelineitem requires a Period of Performance, enter it in the Start Date and End Date
fields manually in the Period of Performance field, or use the Auto-Calendar feature.

Note:  Only one date type can be entered, a Delivery Date or aPeriod of Performancedate.

6. If aPD2user adds multiple delivery information to a PR and return routes that PR to PRweb,
PRweb will display a[Multiple Deliveries] button instead of the Delivery Date or the Period
of Performancefields. To seeasummary of the multiple delivery information, click on the
[Multiple Deliveries] button. PRweb displays the multiple delivery informationin a
summary format that is read-only.

! Line Ttem Detail - 0001 =101 x|

File  Funding

Line ltem Detail | Mumber Descripticn
{oo [Chock Wheel, Painted

Detail l Descriptin:nn] Funding] Shipping] Lacsl Infa

MSH: |1 730-00-MIB-001E Select... I

Multiple Deliveres |

CLIM Type: £ Priced " Info Orly

Estended Description:. | The chocks are made of finished, planed kiln-dried wood blocks.
There are bwo types of four optiong:

[Iuantity E ztimated Linit Price E ztimated Line Item Cost
Item Calculation: [200.00 x [200.00 = [$40,000.00
Perniod: " Option + Baze Opt. #: ]_‘ kit of |ezue
MILSTRIP: | |Each -]

{warning: Applet Window

Figure 129: Line Item Detail — 0001 — Detail Tab
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Multiple Delivery Detail - D001 x|
Delivery Date | Quantity | Ship To Address e
17-Juk2002 12055 USPFO FORVIRGINIA DAHA44

501 EAST FRAMNKLIN STREET
RICHMOMD,, WA 23219-2317

12 hrs ADC 859.45 1 COMSICC F44600
T4 MEALY AVENLIE
SUITE 104
LAMGLEY AFB, VA 23665-2088

[WWarning: Applet Window

Figure130: Multiple Delivery Detail - 0001

7. Enter amore detailed description of the line item, if necessary, in the Extended Description
field.

Thisfield holds up to 255 characters.
8. Enter aquantity inthe Quantity field.

9. Enter an amount in the Estimated Unit Pricefield.

The PRweb module automatically calculates the line item cost out to five decimal places. The
user must include the quantity in order to save the line item.

Note: A dollar signisnot required when entering the estimated cost of each unit.

10. Select the Option or Base Period radio button.

11. Enter the appropriate number of daysin the Opt # field, if it isan option period line item.

Thisfield holds up to four characters. The specified number of days represents the period’s
duration in days.

12. Enter the MILSTRIP information inthe MILSTRIP field if necessary.
Thisfield holds up to 30 characters.

13. Select the appropriate unit of issue from the Unit of | ssue drop-down list box.
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Description Tab

The Description tab in the Line Item Detail window allows the PRweb user to further specify
details pertaining to theline item. The user can include the M anufacturer, Manufacturer Part
Number, Vendor Number, Product/Category Number, Drawing Number, Specification
Number, Serial Number , Piece Number, Model Number, Color , Size, SMIC, Positive
Variation in Quantity, Negative Variation in Quantity, Project Number, FSC code, SIC
code, Brand Name/Sole Sour ce and NAICS code on this tab.

! Line Item Detail - 0001 =10] x|

File  Funding

Line ltem Detail Mumber Description

|00 [

Detsil  Description | Funding | Shipping | Local Infa |

b anufacturer:

Select... |

b anufacturer
Part Mumber:

Colar:

Wendar Mumber:

|
Cize: I
Prod. /Cat. Mumber: |

|
i
l
!
Drawing Number: | VarOy+ [ wvadw-[
I
I
l
|

SMIC:

Spec. Mumber: Froject: i

FsC: | =l
SIC: | -~
Brand Name/Sole Source| <]
MNAICS: | |

Serial Mumber;

Fiece Mumber:

b odel Mumber:

Warning: Spplet Window

Figure 131: Lineltem Detail — New — Description Tab

1. To associate a manufacturer with the line item, click the [Sel ect] button next to the
Manufacturer field.
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The Vendor Address Search window opens.

Vendor Addresz Search

Search Criteria Search By

IE %' Code " Phone Mumber

" Mame " Zip Code
Search I Seleet I Cancel I € State
Code | Organization | Street | City | Statel £ip I:::ude| A

LI 3

|Warning: Applet \Window

Figure 132: Vendor Address Search Window

2. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

3. Highlight the desired manufacturer.

4. Click the[Select] button.
The selected manufacturer displaysin the Manufacturer field in the Description Tab.

5. Enter the manufacturer number of the requirement in the Manufacturer Part Number field.
Thisfield holds up to 40 characters.

6. Enter the appropriate vendor number of the requirement in the Vendor Number field.
Thisfield holds up to 40 characters.

7. Enter the product/category number of the requirement in the Prod./Cat. Number field.
Thisfield holds up to 25 characters.

8. Enter the drawing number in the Drawing Number field.

Thisfield holds up to 25 characters.

9. Enter the specification number of the requirement in the Spec. Number field.
Thisfield holds up to 15 characters.

10. Enter the serial number of the requirement in the Serial Number field.

AcquiLine PRweb v2.3 115 July 29, 2002
Functional User’s Guide



Chapter 6: Line Item

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

21

22,

Thisfield holds up to 15 characters.

Enter the piece number of the requirement in the Piece Number field.

Thisfield holds up to ten characters.

Enter the model number of the requirement in the Model Number field.

Thisfield holds up to ten characters.

Enter the color of the requirement in the Color field.

Thisfield holds up to 15 characters.

Enter the size of the requirement in the Size field.
Thisfield holds up to 30 characters.

Enter the Special Material Identification Code (SMIC) of the requirement in the SM1C field.

Thisfield holds up to two characters.

Enter the Positive Variation in Quantity of the requirement in the Var Qty + field.
Thisfield holds anumber greater than zero and equal or less than 10 with up to 2 decimals.

Enter the Negative Variation in Quantity of the requirement in the Var Qty - field.
Thisfield holds anumber greater than zero and equal or less than 10 with up to 2 decimals.

Enter the project number/description of the requirement in the Project field.

Thisfield holds up to ten characters.

Select the Federal Supply Classification (FSC) code from the FSC drop-down list box.
Select the Standard Industrial Classification (SIC) code from the SI C drop-down list box.
Select the Brand Name/Sol e Source from the Brand Name/Sole Sour ce drop-down list box.

Select the North American Industry Classification Standards (NAICS) code from the NAICS
drop-down list box.
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Funding Tab

The PRweb module provides the ability to add funding at the lineitem level or assign contract
level funding. For more information on contract level funding, refer to Chapter 4: Purchase
Request. The user can add lineitem level funding from within the Line Item Detail window. The
Funding tab displaysline item funding information. The cumulative amount of funding
automatically displays on the Line Itemtab of the PR. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information

isread-only.
& Line Item Detail - New = 0] x|
Li k etail rumber Description
Edlc... {0001 | Tool Box and Kt
— | [elete...
Dietail I Description Funding | Shippitg | Local Info
Funding Strigp Funded An
4 I L]
Java fpplet window
Figure 133: Lineltem Detail - New — Funding Tab
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Creating a New Funding Source

PRweb users can create funding sources at the contract level. The System Administrator grants
user rights to manage funding information. If the user does not have these rights, funding
information is read-only.
1. From the menu, select Funding® New.

The Funding Sources— New window opens with the funding header displayed at the top.

The funding header includes the Number, Description, and the Total Estimated Cost of the
lineitem. The datacontained in these fieldsisretrieved from the Detail tab.

% Funding Sources - New x|

Funding Sources

Mumber; |E||:||:|1 Description: |T|:||:|| Bio and it
Tatal Estimated Cost: |$EI,5EIEI.EIEI
Fund Strip Chign ] i | wanage...

Funded Amount: I!BEI,SDD.DD Fund ACRMN: I

Job Order | Expiration Date | Quantity | Funded &mourit Add... |

Edlit...

Tatal Guantity: I Total Amourt: I Dilete |

QK | Cancel |
Java Applet Window
Figure 134: Funding Sources —New Window
2. Tosearch for an existing funding strip, click the [ M anage] button.
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The Funding Strip Search window opens.

Funding Strip Search
Search Criteria: Iz Search By
% Code
Mew... | Edit... | [EEp.. | [Delete | O UserID
Search | SElect | Cancel | Template: IGInhaI ;I
Code | zer D

[T

|Warning: Applet Window

Figure 135: Funding Strip Search Window

3. Select the appropriate template from the Template drop-down list box.

Note:

Selecting “Global” in the Template drop-down list box searches across all templates.

4. Enter Search Criteria, and click the [Sear ch] button.
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The search results display.

Funding Strip Search x|

Search Criteria: IE Search By
* Code
e, | Eciit... | Copy... | Delete " Uzer IO
Search | Select | Cancel | Template: I.":".rﬂ'l':." ;I

Code Uzer D

SEDES999 1111111111111 2 -3 ITIEY

0 Ih

Jawva spplet Window

Figure 136: Funding Strip Search Window

Note:  Only funding strips that have been created by the user or released by the PD? System
Administrator are displayed.

5. If thedesired funding strip is not found, skip to step 8. If itisfound, continue with step 6.
6. Highlight the desired funding strip and click the [Select] button.

7. Skiptostep 13.

Note:  For more information on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

8. If thefunding strip is not found, click the [ New] button.
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The <Default Template> Funding Strip— New window opens.

Army Funding Strip - New x|

Fund Strip

Departrment Codel2)

Fiscal Year(1)

ApproprigtionBasic Symbol(4) Litnitation;4)

Program Year(1) Operating Agency(2)
Allotrment Serial Mumberi4) Program Element(11)
Element of Resourceld] MDEPRSSODPIE]

Document Reference Mumber(14) Accounting Processing Codel(B)

Figcal Station Murnber(6) Lazt Digitr1)
Select Template: Army vl Ok | Close

Java Applet Window

Figure137: Army Funding Strip - New Window

Note:  The default funding strip template set by the System Administrator displays. If the
System Administrator has not selected a default template, you cannot continue.

9. Tochangeto an aternate template, select another template from the Select Template drop-
down list box.

10. Enter the funding strip information in the appropriate fields.

Note:  Each field must either be filled out completely or left blank.

11. Click [OK].
The funding strip displays on the list of available funding stripsin the Funding Strip
Search window.

12. Highlight the new funding strip and click the [ Sel ect] button to select the new funding strip.

13. Enter the appropriate fund amount in the Funded Amount field.

The Funded Amount field allows the PRweb user to enter the desired dollar amount to
correspond with the selected funding strip. (It is not required to enter adollar sign.)

Note: The Funded Amount defaultsto thetotal cost of the line item.

14. Enter an ACRN inthe Fund ACRN.

The Fund ACRN field allows users to enter ACRN information in the Funding Sour ce
window. Thisfield holds up to two characters.

15. Click [OK] to save.

Note:  The PR must be saved to save the new funding source.
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Editing a Funding Source

PRweb users can edit funding sources at the contract level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information

isread-only.
# Line Item Detail - 0001 - 0] x|
File  Funding
. . (01141 (] ifati
Line ltem Detail | "4meer gscripfion
{0001 | Taol Box and Kit
Detail | Desciption  Funding | Shipping | Local Info |
Funding Strigp Funded A
2120000 288 A0 SAARESSRECCCCCCESET FEEDES2A9 1111111 111111 22222231 9,
1 I
Java applet \Window

Figure 138: LineItem Detail - <Line Item Number> - Funding Tab

1. Fromthe Funding tab of the Line Item Detail window, highlight the funding source to be
edited.

2. From the menu, select Funding > Edit.

Note:  The PRweb user can also double-click on the funding source to open the highlighted
funding source.
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The Funding Sources window opens.

£ runding Sources |

Funding Sources

Mumbet; |E||:||:|1 Description: |T|:||:|| Bioye and kit
Total Estimated Cost: |$EI,5IIIEI.IIIEI
Fund Strip Pty I Exiit... I Manage. ..

21 2W0 280,00 34 4RSS 566 CCCCOCEEETFEEDESS99 1111111111111 22222 25323F583
Funded Amount: ISBEI,SDD.DD Fund ACRRN: I

Job Order | Expiration Date | Quartity | Funded Amourit Add... |

Edlit...

Tatal Guantity: IIZI.EI Total &Amount; (000 Delete |

QK | Cancel |

Java Applet Window

Figure 139: Funding Sources Window

3. Makedesired changes and click [OK] to returnto the Line Item Detail window.

4. From the menu, select File® Update to update the line item with the funding information.

Note:  The PR must be saved to save the new funding source.

Deleting a Funding Source

PRweb users can delete funding sources at the contract level. The System Administrator grants
user rights to manage funding information. If the user does not have these rights, funding
information is read-only.
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& Line Ttem Detail - 0001 S
File  Funding =10
H . N h D Ben
Line Item Detail ™ escription
{0001 | Toal Box and Kit

Detail | Desciption  Funding | Shipping | Local Info

Funding Strigp

2120y F44E: SeDEZ99911111111111111

Java applet \Window

Figure 140: Line Item Detail - <Line Item Number> - Funding Tab

1. From the Funding tab of the Line Item Detail window, highlight the funding source to be
deleted.

2. From the menu, select Funding ® Delete.

3. Click the[Yes] button in the Confirmation window.

The Funding tab displays with the funding source deleted from the table.

4. From the menu, select File® Update to update the line item with the funding information.

Note:  The PR must be saved to save the funding source.

Creating a New Funding Strip

PRweb users can create funding strips at the lineitem level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
isread-only.
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5140-01-424-3317

Flaztic hinged hid tool box with a remowable tray which can also be
uzed az a step stoal. The box haz a recessed carming handle. [k
the kit are various hand toolz zuch as pliers, wrenches, screwdrivers,!
tape measure, knife, safety gogales, hammer, fla [

Figure141: Lineltem Detail — New Window

1. From the menu, select Funding® New.
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The Funding Sources— New window opens.

& Funding Sources - New |

Funding Sources

Mumbet: |E||:||:|1 Description: |T|:||:|| Biox and Kit
Total Estimeted Cost: |$EI,5IIIEI.IIIEI
Fund Strip || Edt... I Manage. ..
Funded Amount: ISBEI,SDD.DD Fund ACRRN: I
Job Order | Expiration Date | Quartity | Funded Amourit Add... |

Edlit...

Total @uantity: | Tatal Amaount: | Dilste |

Ok | Cancel |
Java Applet Window
Figure 142: Funding Sources — New Window
2. Click the[ New] button.
The <Default Template> Funding Strip— New window opens.
Army Funding Skrip - New x|

Fund Strip

Departrnent Codel2) Fiscal Wear(1)

AppropristionBazic Symbaol(4) Lirnitationg 4

Prograrm Year(1) Operating Agencyl2)
Allotinert Serial Mumber(4) Prograin Elemernti11)
Eletnent of Resaurce(4) WDERSSODPE])

Document Reference Number(141 Accounting Processing Codel(E)

Lazt Digit(1)

Fiscal Station Mumber(E)

Select Template: Army hi l QK | Cloze

Java Applet Window

Figure 143: Army Funding Strip — New Window

3. Tochange an alternate template, select another template from the Select Template drop-
down list box.
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4. Enter the funding strip information in the appropriate fields.

Note: Each field must either be filled out completely or left blank. However some fields may
be required, depending on how the System Administrator configured the funding
template.

5. Click [OK].
The funding strip displaysin the Fund Strip field of the Funding Sources - New window.

6. Click [OK] toreturn to the Line Item Detail window.

7. From the menu, select File® Update to update the lineitem with the funding information.

Note: A new funding strip may also be created from the Funding Strip Search window by
clicking the [New] button.

Note:  The PR must be saved to save the new funding strip.

Copying a Funding Strip

PRweb users can copy funding strips at the lineitem level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information
isread-only.
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3 Line Item Detail - New

Funding

Figure 144: Lineltem Detail - New — Funding Tab

1. From the menu, select Funding® New.
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The Funding Sources — New window opens.

Funding Sources - New
Funding Sources

Murnber: IEIEIEI'I Dezcription: |

Total Estimated Cost: I

Fund Strip L |Manage...|

Funded Amavnt: |$D.EIEI Cost Cade: IDDDDDDDDDDDD Fund ACRHN: I

JbOde [ EpronDse | Guawy | Fundedbmont|  ads |
Edlit,.. |

Tatal Gluantity: I T otal Amaunt: I Delete |

Ok | Cancel |
|Warning: Applet Window
Figure 145: Funding Sources — New Window
2. Click the[Manage] button.
The Funding Strip Search window opens.
Funding Strip Search E
Search Critenia: Ig Search By
¥ Code
MHew... | it I [EEpE. | [refete I " User ID
Search | Zelect I Cancel | T emplate: |GI|:|I:|aI ;I
Code | zer D
= *
|Warning: Applet Window
Figure 146: Funding Strip Search Window
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3. Select the appropriate template from the Template drop-down list box.

4. Enter Search Criteria, and click the [Sear ch] button.

Note:  For moreinformation regarding searches, refer to the “ Search Function” section in

Chapter 2: PRweb Desktop.

Funding Strip Search x|
Search Criteria: IE Search By
i+ Code
Mewy | Ecit .. | Copy... | Delete: i User ID
Search | Select | Cancel | Template: IArmy ;I
Code User ID

447794444594445

‘| [+

Jawa Spplet Wwindow

Figure 147: Funding Strip Search Window

5. Highlight the desired funding strip and click the [Copy] button.

The <Default Template> Funding Strip - Copy window opens with the copied funding
strip information in each field.

Army Funding Strip - Copy il
Fund Strip
G59597 555447 79444459444 55t0gh4 9457 5599r 55554 4444444445397 3345999995
Departinert Code(2) |33 Fizcal Year(1) |9
AppropristionBasic Syinbaol(4) |ag?a Lirnitstion( 4] |3944
Program Year(1) |',.' Operating Agency(2) |?9
Allotmert Serial Mumber(4) |4444 Programm Eletertc 1) |8944455tggh
Element of Resourcel4) |4545 MDERSODPIE) |?8899r
Documert Reference Mumber(14) |33334444444444 Accounting Processing Code(s) |3g?3g4
Fizcal Station Mumber(8) |aggggg Last Digit(1) |3
Select Template: m Ok | Cloze

Java Applet Window

Figure 148: Army Funding Strip — Copy Window
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Note:  Thefunding strip is copied into the template that corresponds with the PRweb template
used to create the original funding strip. If the funding strip was created with a PRweb
template that has either been disabled or updated, the PRweb user is unable to copy the
funding strip. In addition, funding strips that were routed from PD? will display as
Miscellaneous.

Make the desired changes to the funding strip.
7. Click [OK] to save the changes and return to the Funding Strip Sear ch window.
The new funding strip displays in the Funding Strip Search window.

8. Highlight the funding strip and click the [ Select] button to select the new funding strip.
9. Click [OK] toreturn to the Funding tab of the Line Item Detail window.

10. From the menu, select File® Update to update the line item with the new funding
information.

Note: The PR must be saved to save the edited funding strip.

Editing a Funding Strip

PRweb users have two options for editing funding strips at the lineitem level. The System
Administrator grants user rights to manage funding information. If the user does not have these
rights, funding information is read-only.

If the System Administrator has updated or removed the template fromwhich the selected funding
strip was created from, PRweb alerts the user that the template has changed.

Confirmation

@ The funding template uzed to create this
funding ztrip has been changed or dizabled.
Select Yes' to update using new funding

template. Select Mo to view selected
funding ztrip az read only,

Tes Mo

|'W'aming: Applet Window

Figure 149: Confirmation Window
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If the user selects[Yes], the PRweb user is able to create a new funding strip using the updated
version of the template or specify another template.

Army Funding Strip - New [ =]
Fund Strip

Department Code(2]

Fizcal rear(1]

Appropriation/B asic Symbol[4] Lirnitation[4]

Program vear(1] Operating Agency|2]

Allotrment S erial Mumnber[4] Program Element[11]

MDEP/SODPE]

Element of Fesource(4)]

Document Reference Humber[14) Accounting Processing CodelB)

Fizcal Station Mumber[&) Last Digit[1]
Select Template: Army - I Ok I Cloze

|Waming: Applet Window

Figure 150: Army Funding Strip — New Window

If the user selects [No], the funding strip displays as read-only.

Army Funding Strip - [Read Only]

Fund Strip

|881 12881 22230A1118PRE 1 2300397 M 333469035 PO40025G 0934555678054 2334

Department Code(2] Igg Fizzal Year(1] |1

Appropriation/Bagic Sembol[4) |-| 2AE Lirnitation(4) |1 e

Frogram ear(1] |3 Operating Agency(2) IDA

Allatment Serial Murnber(4] |-| 118 Pragram Element[11] IF'FIE'I 2300997

Element of Resource(4) Ingg MDEP/SODP(E) |34ngg

Daocument Reference Mumber(14] Ispgqgngm 09345 Accounting Processing Code(B] |555?35

Fiscal Station Mumber(E) |SA2334

Select Template: Ay 'I (K | Clase

|Waming: Applet Window

Figure 151: Army Funding Strip — (Read Only) Window

AcquiLine PRweb v2.3 132 July 29, 2002
Functional User’s Guide




Chapter 6: Line Item

Option 1. By Funding Strip Search

& Line Ttem Detail - 0001 E i
File  Fumding —I—I
H . N h D Ben
Line Item Detail ™ escription
{001 | Tool Boox and it

Detaill Description  Funding | Shippingl Local Infu:ul

Java dpplet window

Figure152: Lineltem Detail - <Line Item Number> - Funding Tab

1. Highlight the funding source to be edited.

2. From the menu, select Funding® Edit.
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The Funding Sources window opens.

it

22 Funding Sources

Lelete

Figure 153: Funding Sources Window

3. Click the[Manage] button.
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The Funding Strip Search window opens.

Funding Strip Search
Search Criteria: IE Search By
* Code
Mew... | Edit... | [Eapy., | [elete |  UserID
Search | SE(ERE | Cancel | Template: |GI-:|I:|E|I ;I
Code | ger D
| v

|Warning: Applet Window

Figure154: Army Funding Strip — Edit Window

4. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information regarding searches, refer to the ‘ Search Function” sectionin
Chapter 2: PRweb Desktop.

5. Highlight the desired funding strip and click the [ Edit] button.
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The Army Funding Strip— Edit window opens with the original funding information
displayed.

Note:  You may not edit afunding strip that is applied to either another PR or another funding
source on the same PR.

Army Funding Strip - Edit x|

Fund Strip

212001 288 88 3AARSESERCCCCCORRET TEEDEII99 11111111 111111 22222 2323F883

Department Code(2) |21 Fiscal Year(1) |2
AppropristionBasic Symbol(4) |M|,.f\|“| 2 Litritation(4) I,a\,a_,a\,a,
Progratn Year(1) |3 Operating Auency(2) |44
Allotnent Serial Mumber(d] |EISSS Prograim Elementi11) |55cccccc533
Eletnent of Resource(4) I??BB MOERZODPE) |DE9999
Document Reference Mumber(14) |1 1111111111111 Accounting Processing Code(B) |222222
Fizcal Station Murber(5) |323F88 Lzt Digit(1) |3
Select Template: Army "l Ok | Cloze

Java Applet Window

Figure 155: Army Funding Strip — Edit Window

6. Makedesired changesto the funding strip and click [ OK] to return to the Funding Strip
Sear ch window.

7. Click the [Select] button to select the updated funding strip and return to the Funding
Sour ces window.

8. Click [OK] toreturn to the Funding tab of the Line Item Detail window.

9. From the menu, select File® Update to update the line item with the new funding
information.

Note: The PR (or PR Mod) must be saved to save the edited funding strip.
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Option 2: By Funding Sources Window

& Line Ttem Detail - 0001 i
File  Fumding —I—I
H . N h D Ben
Line Item Detail ™ escription
{001 | Tool Boox and it

Detaill Description  Funding | Shippingl Local Infu:ul

111111111111

Java dpplet window

Figure156: Lineltem Detail - <Line Item Number> - Funding Tab

1. Highlight the desired funding source.

2. From the menu, select Funding® Edit.
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The Funding Sources window opens.

£ runding Sources |

Funding Sources

Mumbet; |E||:||:|1 Description: |T|:||:|| Bioye and kit
Total Estimated Cost: |$EI,5IIIEI.IIIEI
Fund Strip ey, I Exiit... I Manage. ..

21 2W0 28,000 34 4RSS SCCCCOCCEET T TTSE0ESSS9] 11111111111 22222 23F 55853
Funded Amount: ISBEI,SDD.DD Fund ACRRN: I

Job Order | Expiration Date | Quartity | Funded Amourit Add... |

Edlit...

Tatal Guantity: IIZI.EI Total &Amount; (000 Delete |

QK | Cancel |

Java Applet Window

Figure 157: Funding Sources Window

3. Fromthe Funding Sour ces window click the [ Edit] button next to the Fund Stripfield.
The Funding Strip— Edit window opens with the original funding information displayed.

Army Funding Strip - Edit il
Fund Strip
212001 28,8 48 344R555CCCCCCCEETTTTEE0EII991 111114111111 12222223F 58553
Department Code(2) |21 Fizzal Year(1) |2
AppropristionBasic Symbol(2) |Mw1 o Litritation;4) IAAAA
Program Year(1) |3 COperating Agency(2) |44
Allotrment Serial Mumber(4) IEISSS Prograim Element(11) |ccccccc53??
Eletnent of Resource(4) |??3a MDEP/SODP(E) |DEgggg
Document Reference Mumber(14) |1 1111111114 Accounting Processing Codel(E) IQQQQQQ
Fizcal Station Mumber() |3F3333 Last Digit(1) |3

Select Template: Srmy bt I O | Cloze

Java Applet \Window

Figure 158: Army Funding Strip — Edit Window
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4. Make desired changesto the funding strip and click [ OK] to return to the Funding Sour ces
window.

5. Click [OK] to return to the Funding tab of the Line Item Detail window.

6. From the menu, select File® Update to update the line item with the new funding
information.

Note:  The PR must be saved to save the edited funding strip.

Deleting a Funding Strip

PRweb users can delete funding strips at the line item level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding information

isread-only.
i Line Item Detail - 0001 M=
File  Funding
Line ltem Detail Mumber D ezcription

([ | Training

Detaill Description  Funding | Shippingl

1611075103511338214719571 233433131 29354751 893333451 9367195851345 10

|Warning: Applet Windaw

Figure159: Lineltem Detail —<Line Item Number> - Funding Tab
1. Highlight the desired funding source.

2. From the menu, select Funding® Edit.
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The Funding Sources window opens.

Funding Sources

Funding Sources

Murnber: |I:|I:|I:|1 Description: ITraining
Toatal Eztimated Caosk: |$1 0,000, 00
Fund Strip Mew. ..

|1 211075103811335831471 95712334 39131 23384 751 333333451 9367133851 3481

Funded Armont: |$1 0,000.00 Cost Code: |EIEIEIEIDEIEIEIEIEIEIEI Fund ACRHN: I

b0 |Ewponbae | Quaniy | Frdedbmont | csd |
Elit.. |

Tatal Gluantity: IEI.D Total Amaount; | 0.00 Delete |

QK | Cancel |
|Warning: Applet Window
Figure 160: Funding Sources Window
3. Click the[Manage] button.
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The Funding Strip Search window opens.

Funding Strip Search
Search Criteria: |34 Search By
* Code
MHew... | =it | [EGT. . | [elete | T User ID
Search | SE(ERE | Cancel | Template: |GI-:|I:|E|I ;I
Code | ger D
LI 3
|Warning: Applet Window

Figure161: Funding Strip Search Window

4. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information regarding searches, refer to the “ Search Function” section in
Chapter 2: PRweb Desktop.

5. Highlight the desired funding strip and click the [Delete] button.

Note:  You may not delete afunding strip that is applied to another PR, alineitem on the same
PR or the same line item on a different funding source.

6. Click the[Yes] button in the Confirmation window.

The Funding Strip Search window displays with the funding strip deleted fromthe table.
7. Click the[Cancel] button to return to the Funding Sour ces— New window.

8. Click [OK] toreturn to the Funding tab of the Line Item Detail window.

9.  From the menu, select File® Update to update the funding information.

Note:  The PR must be saved to save the funding information.
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Creating a Job Order

PRweb users can create job orders at the contract level. The System Administrator grants user
rights to manage funding information. I the user does not have these rights, funding and job order
information is read-only.

& Line Item Detail - New : (o x|
File  Funding =10
H . N h D Ben
Line Item Detail ™ escription
{0001 | Toaloxes|

Detaill Desciption  Funding | Shippingl Local Infu:ul

Java applet \Window

Figure162: Lineltem Detail - New — Funding Tab

1. From the menu, select Funding® New.
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The Funding Sources— New window opens.

& Funding Sources - New |

Funding Sources

Mumbet; |E||:||:|1 Description: ITDDIbDXES
Total Estimated Cost: |$EI,5IIIEI.IIIEI
Fund Strip ey, I Ediit... I Manage. ..

Funded Amount: ISBEI,SDD.DD Fund ACRRN: I

Towomr  [owmmome | cwiy | rwesmmart| e |

Edlit...

Total @uantity: | Tatal Amaount: | Dilste |

QK | Cancel |

Java Applet Window

Figure 163: Funding Sources — New Window

2. Click the[ Add] button next to the Job Order table.
The Attach Job Order — New window opens.

@ Attach Job Order - New

Job Crdet: I

Funded Amourt: |12,

Funded Quartity: INI.E-.

Ok Cancel

Java Applet Window

Figure 164: Attach Job Order — New Window

3. Click the[Select] button.
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The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE [V Current Job Orders Only
ey | Search select Cancel
Job Order Mutmber Fundz Expiration Date

Java Spplet Window

Figure 165: Job Order Number Search Window

4. Click the[New] button.
The Create New Job Order window opens.

& Create New Job Order x|

Job Croder Mumber: ||

Fundz Expiration Date: I

Ok | Cancel

Java Applet Window

Figure 166: Create New Job Order Window

5. Enter anumber inthe Job Order Number field and an expiration date in the Funds
Expiration Date field.

Note:  Thefunds expiration date can be entered manually or by using the Auto-Calendar feature.

6. Click [OK] to returnto the Job Order Number Search window.

7. Double-click the new job order to returnto the Attach Job Order — New window.

8. Click [OK] toreturn to the Funding Sour ces— New window.
Thejob order displaysin the Funding Sources— New window.
9. Click [OK] toreturn to the Funding tab of the Line Item Detail window.
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10. From the menu, select File® Update to update the funding information.

Note:  The PR must be saved to save the funding information.

Attaching a Job Order

PRweb users can attach job orders at the line item level. The System Administrator grants user
rights to manage funding information. I the user does not have these rights, funding and job order
information is read-only.

£ Line Item Detail - New 3 - 0] x|
File  Funding
Line ltem Detail Mumber Deszcription
{0001 | Tookoxes|
Detaill Desctiption  Funding | Shippingl Local Infn:nl
Funding Strig Furnded Ly
1 [+
Java applet \Window

Figure 167: Line Item Detail - New — Funding Tab

1. From the menu, select Funding® New.
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The Funding Sources— New window opens.

£ runding Sources - New |
Funding Sources
Mumbet; |E||:||:|1 Description: ITDDIbeES
Total Estimated Cost: |$EI,5EIEI.EIEI
Fund Strip Pty I Ediit... I Manage. ..
Funded Amount: ISBEI,SDD.DD Fund ACRRN: I
Job Order | Expirstion Date | Ciartity | Funded Amount Acdd... |
Edit....
Tatal Guantity: IIZI.EI Total Amount: (000 Dielete |
Ok | Cancel |
Java Applet Window
Figure 168: Funding Sources — New Window
2. Click the[ Add] button next to the Job Order table.
The Attach Job Order - New window opens.
Attach Job Order - Hew [ x|

Job Order: I :

Funded &mount: IN.I’.i'-.

Funded Quartity: INa’.ﬂ'-.

ak. Cancel
|Warning: Applet Window
Figure 169: Attach Job Order — New Window
3. Click the[Select] button.
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The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
e | Search =elect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 170: Job Order Number Search Window

4. Enter Search Criteria.

5. Check the Current Job Orders Only checkbox to display job orders that have not expired.
6. Click the[Sear ch] button.

The search results display.

Job Order Number Search x|
Seatch Criteria
IE [W¥ Current Job Orders Only
e | Search Select cancel |
Job Order Mumber Fundz Expiration Date j
Z0000393491 15-Feb-2003
CO0G53979 1d-Mary-2003
DUPOO0Y 12-Mary-2201
DUPOO0Y 10-Mary-2021
ERKOO1 31 -Dec-2002 [
ERKODM 3 -Dec-2022
ERKOO2 3 -Dec-2002
HHH111 10-Mary-2004 =
1| [+
Java dpplet window
Figure 171: Job Order Number Search Window
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7. Highlight the desired job order number and click the [Select] button.
The Attach Job Order — New window opens.

& Attach Job Order - New

Jok Crder: ICEIEIEISEMEI‘I

Funded Amourt: |11/

Funded Quartity: |Nm

Ok Cancel

Java Applet Window

Figure 172: Attach Job Order — New Window

8. Click [OK] toreturn to the Funding Sour ces— New window.
9. Click [OK] toreturn to the Funding tab of the Line Item Detail window.

10. From the menu, select File® Update to update the funding information.

Note:  The PR must be saved to save the funding information.
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Editing a Job Order

PRweb users can edit job orders at the lineitem level. The System Administrator grants user
rights to manage funding information. I the user does not have these rights, funding and job order
information is read-only.

# Line Item Detail - 0001 =]
File  Funding
. . Mumky (] poti
Line ltem Detail | "4meer gscripfion
{0001 | Taolbaxes
Detail | Desciption  Funding | Shipping | Local Info |
I T e e e e e et e T R R R L R NN R L 9,
1 I
Java applet \Window

Figure173: Lineltem Detail —<Lineltem Number>—Funding Tab

1. Double-click an existing funding source.
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The Funding Sources window opens.

& Funding Sources - New |

Funding Sources

Mumbet; |E||:||:|1 Description: ITDDIbDXES
Total Estimated Cost: |$EI,5IIIEI.IIIEI
Fund Strip ey, I Exiit... I Manage. ..

I?5E?5555555555555555555555555.’ i i Al =1 w1 a1 11 a1 <l t ] o < ]

Funded Amount: IEI,SIZIIZI.IZIIZI Fund ACRRN: I

100.0 9 500
Edit...

Tatal Guantity: |1IZIIII.IZI Total Amount: IEI,SEIIZI.EIIZI Delete |

QK | Cancel |

Java Applet Window

Figure 174: Funding Sources Window

2. Highlight the desired job order and click the [ Edit] button next to the Job Order table.
The Attach Job Order — <Job Order Name> window opens.

& Attach Job Order - CO0039491

Jok Crder: ICEIEIEISEMEI‘I

Funded Amourt:  [3,500.00

Funded Quartity: |1 o0.0a

Ok Cancel

I.Java Applet Windaw

Figure 175: Attach Job Order - <Job Order Name> Window

3. Click the[Select] button.
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The Job Order Number Search window opens.

Job Order Number Search x|
Search Criteria
IE W Current Job Orders Only
e | Search =elect Cancel
Job Order Mumber Fundz Expiration Date
Java applet \Window

Figure 176: Job Order Number Search Window

4. Enter Search Criteria, and click the [Sear ch] button.

5. Highlight ajob order number and click the [Select] button.

The Attach Job Order - <Job Order Name>window opens with the new job order
number displayed in the Job Order field.

& Attach Job Order - COD039491

Job Order: |kPat01

Funded Amourt:  [3,500.00

Funded Quartity: |1 o0.0a

Ok Cancel

Java Applet Window

Figure 177: Attach Job Order - <Job Order Name> Window

6. Click [OK] toreturnto the Funding Sour ces window.
7. Click [OK] toreturn to the Funding tab of the Line Item Detail window.

8. From the menu, select File® Update to update the funding information.

Note:  The PR must be saved to save the funding information.
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Deleting a Job Order

PRweb users can delete job orders at the lineitem level. The System Administrator grants user
rights to manage funding information. If the user does not have these rights, funding and job order
information is read-only.

# Line Item Detail - 0001 ' =]
File  Funding
. . Mumky (] poti
Line ltem Detail | "4meer gscripfion
{0001 | Taolbaxes
Detail | Desciption  Funding | Shipping | Local Info |
I T e e e e e et e T R R R L R NN R L 9,
1 I
Java applet \Window

Figure178: Lineltem Detail - <Line Item Number > Funding Tab

1. Double-click an existing funding source.
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The Funding Sources window opens.

& Funding Sources ﬂ

Funding Sources

Mumbet; |E||:||:|1 Description: ITDDIbDXES
Total Estimated Cost: |$EI,5IIIEI.IIIEI
Fund Strip ey, I Exiit... I Manage. ..

I?5E?5555555555555555555555555.’ i i Al =1 w1 a1 11 a1 <l t ] o < ]

Funded Amount: IEI,SIZIIZI.IZIIZI Fund ACRRN: I
A, |

KP&101 10-hay-2003 1000 9,5300.00 =

Tatal Guantity: |1IZIIII.IZI Total Amount: IEI,SEIIZI.EIIZI Delete |

QK | Cancel |

Java Applet Window

Figure 179: Funding Sources Window

2. Highlight ajob order and click the [Delete] button next to the Job Order table.

3. Click the[Yes] button in the Confirmation window.
The Funding Sources window displays with the job order deleted fromthe table.

4. Click [OK] toreturnto the Funding tab of the Line Item Detail window.

Note:  The PR must be saved to save the funding information.
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Updating the Purchase Request with a Line Item

PRweb users can update the PR with alineitem once it has been created or modified. An updated
PR reflects any changes made to the line item since the last update. To update the PR with aline
item, select the File > Update from the Line Item Detail menu. Updating the PR with aline
item returns the user to the PR window.

Note:  Updating and saving are two separate functions. A PR that has been updated with aline
item needs to be saved in order to save the PR in its updated status.

Creating a New Subcontract Line Item

The process for creating a Subcontract Line Item (SubCLIN) is similar to the creation of a
Contract Line Item (CLIN), however, there are afew differences. For example, if you have a
Priced CLIN, the CLIN Type defaults to I nfo Onlyin accordance with the Defense Federal
Acquisition Regulations (DFARS).

1. Openanexisting PR.
2. Highlight aCLIN from the Line Itemtab of the Pur chase Request window.

3. From the menu, select Line Iltem—> New = SubCLIN.
The Line Item Detail — New window opens with the Detail tab displayed.

Theline item detail header displays at the top of the Line Item form and is visible from every
tab of the Line Item Detail — New window.
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Figure 180: LineItem Detail — New — Detail Tab

Note:  Sincecreating a SUbCLIN issimilar to creating a CLIN, refer to “ Creating a New Line
Item” in this chapter, to learn how to createa CLIN.

4. From the menu, select File > Update.

AcquiLine PRweb v2.3 155 July 29, 2002
Functional User’s Guide



Chapter 6: Line Item

The SUbCLIN displays as part of CLIN “ 0001" .

i Purchase Request - 123Train =]
File  Lire [tem

Description Purchasze Request Mumber
Purchase ITraining |123Train
Requeat Requisition D ate DPAS Prionty Bating | Pricrty
| 06-5ep-2000 | |
Main Form ~ Line item | Cortracts | Add Data |
Total Funding |$20,DE|IJ,IJD Contract Level Funding [z I
* alues way be munded fordisolay pumposes.
Bl o001 Training 2.0 10,000.00 $20,000.00

Q00107 Training SubCLIN

Total Cost: [$20,000.00

|Waming: Applet Window

Figure 181: Purchase Request — <Purchase Request Number> — Line Item Tab
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Shipping Tab

The Shipping tab allows the PRweb user to identify the Shipping Addr ess, Free On Board
(F.O.B)), Additional Markings, Charge Shipping To, Hazardous Material (HAZMAT)
Requirements and Shipping Mode.

Figure 182: Line Item Detail — New — Shipping Tab

1. Toenter ashipping address, click the [Select] button next to the Addressfield.

The Address field allows the PRweb user to searchfor a specific address from the PD?
database.
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The Ship to Contact Search window opens.

Ship To Contact Search E3

Search Criteria Search By

IE * Code ™ Organization Mame

™ Contact Mame ¢ Phone Number
Search | SElEEt | Cancel | C Stale " Zip Code
Contact | Code | Organization | City | State | Zip Code PH

[0 | 3

|Warning: Applet Window

Figure 183: Ship To Contact Search Window

2. Enter Search Criteria, and click the [Sear ch] button.

Note:  For more information on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

3. Highlight the desired shipping address.

4, Click the[Select] button.
The Shipping tab displays the selected shipping addressin the Addressfield.

5. If aPD2 user adds multiple delivery information to a PR and return routes that PR to PRweb,
PRweb will not display the Shipping Addressfield. To seea summary of the multiple
delivery information, click on the [ M ultiple Deliveries] button located on the Detail tab of
the PR. PRweb displays the multiple delivery information including the ship to address
information in asummary format that is read-only.
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= Line Item Detail - 0001 x| |

0o Chock Wheel, Painted

Figure 184: Line Item Detail — 0001 — Shipping Tab

6. To enter Free On Board instructions, select the desired item from the F.O.B. drop-down list
box.

7. Enter any additional markings and specifications for shipping in the Additional Markings
field.

Thisfield holds up to 60 characters.

8.  Enter shipping chargeinformation in the Char ge Shipping Tofield.
Thisfield holds up to 40 characters.

9. Enter Hazardous Materials (HAZMAT) information in the HAZMAT field.

Thisfield holds up to four characters.

10. To enter the mode of shipping, click the [Sel ect] button next to the Shipping Modefield.

The Shipping Mode field allows the PRweb user to search for the shipping mode that is
required for the material being shipped.
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The Shipping Mode Search window opens.

Shipping Mode Search
Search Critena Search By
IE & Code " Description
Search | Selent | Cancel |
Code | Dezcription

|'W'arning: Applet 'Window

Figure 185: Shipping Mode Search Window

11. Enter Search Criteria, and click the[Sear ch] button.

Note:  For more information on searches, refer to “ Search Function” section in Chapter 2:
PRweb Desktop.

12. Highlight the desired shipping mode.

13. Click the[Select] button.
The Shipping tab displays with the selected shipping mode in the Shipping Mode field.
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Local Info Tab

The Local Info tab allows the PRweb user to view, refresh, and edit line item local fields of aPR.
The PD? System Administrator determines the lineitem local info fields that are displayed on the
Local Info tab. Refreshing the Local Info tab allows the user to update the line item local fields
with the latest changes made by the PD? System Administrator. Clicking the [Refresh] button for
alineitem updates all local info configurations for all lineitems on the PR. When the Local Info
isrefreshed, any existing datain the fields remain, only the labels of the fields change. If the new
configuration has del eted fields from the old configuration, they are not displayed. If there have
been no updates made in PD2, the fields remain the same.

i Line Item Detail - 0001 =10f x|

File  Funding

Line [tem Detail | Mumber Description
0002 | Trairiing

Detsil | Description | Funding | Shipping  Lecal Info ‘

Type

Shipping Label Mo

Trade

E-mall Addrezz

Foreign addresz

]
|
1
Local Code ]
]
]
!

NAFTA

Refresh I

{Warning: Applet Window

Figure 186: Lineltem Detail — New —Local Info Tab

1. Click onthe[Refresh] button to refresh the lineitem local fieldsto the most current
configuration set by the PD2 System Administrator.

2. Enter lineitem local information in the appropiate fields.
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Copying a Line Item

1. From the Purchase Request window, click on the Line Item to be copied.

2. Fromthe menu, select Lineltem - Copy.
The Line Item tab is updated with the copied Line I tem.

i Purchase Request - New ;IEIEI
e

Mew r =criphion | Purchaze Request Mumber
| |DOCoot

FEdi... cumentation T est

l:luisitiu:un [rate | DFAS Prionty Rating | FPrionty
ul2002 I |

Delete

Main Form  Line lem I Cn:untractsl A Data

Total Funding: !$1 0000, 0 Contract Level Funding tore.. |
* liglyes may He munded fordisolay gumposes.

U ? ol

Total Cost: [$10,000.00

Warning: Applet Window

Figure 187: Purchase Request - <Purchase Request Number> —Line Item Tab

Note:  Line Items cannot be copied on PR Modifications. For more information on PR
Modifications, refer to Chapter 5: PR Modifications
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Chapter 7: Attachments

PRweb users may attach external filesto the PR. In This Chapter...

The creation of an attachment facilitates the

completion of a Requirements Package. For Using the Attachments function
example, a PRweb user can attach a Statement of described in this chapter, you can:

Work document to a PR or PR Modification and
send both objects to the Contracting Office. The
PRweb user may add, view and remove any Object - View an attachment
Linking and Embedding (OLE) compatible objects.

Add an attachment

Remove an attachment

Adding an Attachment

PRweb users may attach any OL E compatible object to the PR.

To attach an OLE compatible object:
1. From the PRweb user’s desktop, open aPR.

2. From the menu, select File > Attachments.

The File Attachments window opens.

File Attachments Ei

Attached Docurments Add. I
WEWL. |
Eremaye |
Cloze
Drezcription:

|Warning: Applet wWindow

Figure 188: File Attachments Window
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3. Click the[Add] button.
The New Attachment window opens.

Mew Attachment

Filenarne: I

D ezcription:

‘Celect File...| Cancel

|Warning: Applet \Window

Figure 189: New Attachment Window

4, Enter the name of thefileto be attached in the Filename field.

Note:  Thefilename does not need to be the actual name of the object being attached. The
filename displays for reference purposes. Users should include the extension of the
object they are attaching at the end of the filename. For example, if a Statement of Work
created in Microsoft Word is attached, the filename should be in the form “ SOW.doc” .
In this case, thefile'sextensionis*“.doc.”

5. Enter adescription in the Description field.

6. Click the[Select File] button to continue.
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The Upload File window opens as a new Web browser window.

3 Upload File - Microzoft Internet E xplorer

File Edit “iew Favorites Toole Help |
J =X AN 3 B =2
Back FamEnd Stop  Refresh  Home Search Fawvortes  Histary (GET Frint
JAddress I@ F3RI21A 2150600ede__ 141 8fcf300f0d8d0d2__ Ob02fe3F3F2M e2dbredlc2aadefidie04 70726643 204415201 B1 5383[0302ﬂ @Go
J Lirks @ﬂcqulLlne @ Customnize Links @ Free Hotrnail @ Windows
=
Select file to attach:
| Browse... | Attach |
Mote: PRweb allows you to upload any file on your desktop. However, we strongly recommend that you attach
documents that can be interpreted by the desktop software used by your Contracting Office and other PRweb users.
Microsoft Office® documents are preferred.
I
|&] Dore ’_’_|e Inkermet 4
Figure 190: Upload File Window
7. Fromthe PRweb Attach Filewindow, click the [Browsg button.
The Choose file window opens.
Choosze file EHE |
Lokin: | 2 My Computer = | @‘l | |
= 3% Floppy (4]
()
(D)
& on 'wahoo' [E:]
 on 'wahoo' [F:]
ams(G:]
| | i
File name: I Open I
Files of type: I.-'l‘-.II Files [*.7) j Cancel |
Figure 191: Choose File Window
8. Fromthe Choose File window, locate the desired object to attach to the PR.
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9. Highlight the object.

10. Click the[Open] button in the Choose File window.
The Upload File window opens.

11. Click the[Attach] button to attach the object to the PR.

12. Click [OK].
The Upload Compl ete window opens with the “ Successful Attachment” message.

< Upload Result - Microsoft Internet Explorer

Figure 192: Upload Complete Window

13. Closethe window to return to the File Attachments window.
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The new attachment is displayed in the Attached Documents table with its description
displayed in the Description field.

File Attachments E

Aftached Diocuments add..

Wi,

Remove

i

Cloze

Dezcrption

Staternent af Wwark,

|Warning: Applet Window

Figure 193: File Attachments Window

14. Click the[Closg button to return to the PR.

15. From the menu, select File > Save to save the attachment.

Viewing an Attachment
PRweb users may view objects that have been attached to the PR.
To view an attachment:
1. From the PRweb user’s desktop, open a PR.

2. From the menu, select File > Attachments.
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The File Attachments window opens.

File Attachments Ed

Attached Documents Add.

Wi,

R emowve

i

Cloze

Dezcrption

Statemnent of Wark,

|Warning: Applet Windaw

Figure 194: File Attachments Window

3. Highlight an attachment and click the [ View] button.
The Viewing I nstructions window opens.

Viewing Instructions

Micrazaft Office, plain test and HTML documents and
JPEG and Bitrnap images will be autaratically
dizplayed in a new browser window,

[ arder to view all other attachments, pau muost:

1. Save the downlnaded file ta a temparary directary
2. Rename the file ta its anginal name
3. Open the file with the appropriate application

Click, OF. ta continue.

k., Cancel

W always view attachment instructions.

|Warning: Applet Window

Figure195: Viewing I nstructions Window

4. Readthe Viewing Instructions and click [OK].
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Note:  If changes were made to the attachment, the user must remove the original object and re-
attach the updated object.

Removing an Attachment
PRweb users may remove attachments from a PR.
To remove an attachment:
1. From the PRweb user’s desktop, open an existing PR with an attachment.

2. From the menu, select File > Attachments.
The File Attachments window opens.

File Attachments E3

Attached Documents Add.

Wigw, ..

Remove

i

Cloze

Description;

Statement of *Work,

|'W'arning: Applet Window

Figure 196: File Attachments Window

3. Fromthe File Attachments window, highlight the desired attachment and click the [ Remove]
button.

4. Click the[Closg button to return to the PR.

5. From the menu, select File® Save to save the attachment.

Note:  An attachment on a PR Modification that was pulled forward from the conform copy can
not be removed in PRweb. Only attachments that were added to the PR Modification can
be removed. The attachments pulled forward from the conform copy can be removed in
PD2,
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Chapter

The DD254 menu option allows the PRweb user

8: DD254

In This Chapter...

Using the function described in this

to add a contract Security Classification chapter, you can:

Specification (DD254) to the PR.

Toadd aDD254 to aPR:

Add a security classification
specification (DD254) to the PR

1. Fromthe PRweb user’s desktop, open an existing PR.

2. Fromthe menu, select File® DD254.

The DD254 window opens. Thiswindow contains six tabs:

Items 1-5
Items 6-9
Items 10-11
Items 12-13
Items 14-15
Items 16-17

: DD254 - 123Train M= B3

File

tems 1 -5 | ﬂemsﬁ-gl ftems 10 - 11 | fems12-13 | Item314-15| Items18-1?|

DEPARTMEMNT OF DEFENSE la. FACILITY CLEARANCE REQUIRED
CONTRACT SECURITY CLASSIFICATION SPECIFICATION
[The requirements of the Dol Industrial Security Manual b. LEVEL OF SAFEGUARDING REQUIRED
apply to all security aspects of thiz effart.] I
2. THIS SPECIFICATION 15 FOR: [complete az applicable] | 3. THIS SPECIFICATION 15: [complete as applicable)
" a PRIME CONTRACT MUMBER ' a ORIGIMAL [Complete date in all cases)
D ate: I28-SED-2DDU
™ b SUBCONTRACT NUMEBER ¢ b REYISION [Supercedes all previous specifications]

| Rev. #:I Date: I

& ¢ SOLICITATION OF OTHER MUMBER  Due Date ¢ FINAL [Complete tem 5 in all cazes)

I‘I 23Train I Date: I

4,15 THIS & FOLLOW OM COMTRACT? © Yes Mo If ves, complete the follawing:

Clazsified material received or generated under I [Preceding Contract Mumber] iz transferred to
this follow-on contract.

5 1S THIS & FINAL DD FORKM 2547 ez  No o If yes, complete the follawing:
In responsze to the contractor's request dated I retention of the identified classification material is
authorized for the peniod of; | through |

|W'aming: Applet 'Window

Figure 197: DD254 - <Purchase Request Number> Window
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3. Enter the appropriate information on each tab to complete the DD254.

4. From the menu, select File® Updateto update the PR with the DD254.
Updating the PR with a DD254 form closes the DD254 window.

Note:  Updating and saving are two separate functions. A PR that has been updated with a
DD254 needsto be saved in order to save the PR in its updated status.
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Chapter 9: Workflow

Routin -

g In This Chapter...
The PRweb module supports the electronic routing : :
and approval of PRs and PR Mods withinPRweb and [ Using the Workflow functions
between PRweb users and PD? users. Members of described in this chapter, you can:
secu.rfllty grogpsthat clmly have rOlftI n% acce?s to . RouteaPR or PR Mod by
specific routing temp _ates may only choose from creating a custom routing sheet
those templates to which they have access when
routing. PRweb users without restricted security - ApproveaPR or PR Mod
access can create new routing sheets, edit existing - View approval history
routing sheets and create route templ ates to facilitate
the electronic review and approval process.
The user must select aPD? user in order to route a PR. However, a PR Mod is automatically
routed to the PD? user that owns the conform copy of the base PR
Creating a Custom Routing Sheet
Only users with custom routing privileges may create custom routing sheets. Users have custom
routing privilegesif they are not a security group member or are a member of a security group that
has custom routing privileges. Userswith custom routing privileges may create routing sheets by
using any combination of usernames, group names or template users.
Creating a Custom Routing Sheet — All Users
To create a custom routing sheet using the All Users option:
1. From the PRweb user’s desktop, highlight a PR or PR Mod.
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2. From the menu, select Purchase Request > Route.
The Routing Sheet - <Purchase Request Number> window opens.

& Routing Sheet - PRO101 x|
Routing Sheet
View Routees By : Al Users!
" Group Templates
= Template I ;I
Route To
30 CHARACTERS LIZER D 0 - Michelle YWary
ACCEPTOR FOUR E
ACCEPTOR OME
ACCEPTOR THREE
ACCEPTOR Twid E
ADARM ANDREBEAS
ALEX DL SCHEFER
ALEX SCHEFER
select Al I
Foute to PD* Uset: I Select.. |
Wiewy Groups. .. | 034 | Cancel |
IJava Applet tAindow

Figure 198: Routing Sheet - <Purchase Request Number> Window

Note:  TheAll Users radio button is automatically selected by default.

3. Fromthe Routing Sheet window, select the View Routees By radio button.

Note:  The User list box displays all available usersto add to the routing sheet. Asusersare
added to the routing sheet their username displaysin the order they were selected in the
Route To list box. Users must be placed in routing order on the routing sheet. The user
in the zero position is the creator of the PR and cannot be deleted from the routing sheet.

4. Select routees for the new routing sheet by highlighting desired users from the User list box
and clicking the[ » ] button.

Note:  Routees may be removed from the routing sheet by highlighting the desired user from the
Route Tolist box and clicking the[ 4 ] button.
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5. Click the [Select] button next to the Route to PD? User field.
The Select PD? User window opens.

Select PD® User

PO Uzerd
Drarninic Joel

Sarak Joyece
System Administrator

Helect

|Warning: Applet Windaw

Figure 199: Select PD2 User Window

Note:  When the user clicks the [Select] button next to the Routeto PD? User field on aroute
sheet for a PR Mod, a message displays that indicates that the PR Mod will be routed to
the PD? user that owns the conform copy of the PR.

6. Highlight the appropriate PD? user.

7. Click the[Select] button.
The PD? user selected displaysin the Route to PD? User field on the routing sheet.

8. Click [OK] toinitiate the routing sheet.

Note:  Once anew routing sheet has been created and saved, routing initiates automatically.
The creator of a PR does not need to approve the PR to begin the routing process.

Create a Route Sheet — Groups

Selecting the Groups radio button displays all organizational groups created by the PRweb
System Administrator.

To create aroute sheet using the Groups criteria:
1. From the PRweb user’s desktop, highlight a PR.

2. From the menu, select Purchase Request ® Route.
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The Routing Sheet - <Purchase Request Number> window opens.

3. Select the Group radio button.

& routing Sheet - PRO102 x|

Routing Sheet

View Routees By: | &l Users

i Group; Templates
" Template LI

GraLp ’_‘ Foute Ta

0 - Michelle Way
Alex grp [‘
CUSTOMER
DF&S —
Dena v E
Dena's
EG
ERIK

-

Select Al I

Route to PD? L=er: I Select. .. |
Wiewy Groups. .. | Ok | Cancel |

IJava Applet \Window

Figure 200: Routing Sheet - <Purchase Request Number> Window

4. Click the[View Groups] button to view members of agroup.
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The Groups (Read Only)window displays.

i Groups (Read Only) " =10] x|

Description Opeh... |
Alex arp Alew'z Group
CHICKEMWS Just chickens
CUSTOMER Custarmer for PRweb Creation
DFAS DFas PayMENT OFFICE GROUP
Dena Dena's Fun Group 2
Dena's Fun Group
EG Ellen's Routees
ERIE. Erik's group =
ERIKZ Erik's second group
E nwinZ Erwin's Second Group
FOR WIEW To view the PRz of pour subs. -
| I P Cloze

|'-.-'-.-'arning: Applet Window

Figure201: Groups (Read Only) Window

5. Highlight the desired group and click the [ Open] button to view group members.

Group - Alex grp (Read Only) x|

M arne: I.-’-'-.Ie:-: arp

Dezcription: |ﬁ.lex's Group

Members | Managersl Rightsl

MHon-tembers - kembers

30 CHARACTERS USER 1D ACCEPTOR T
ACCEPTOR FOUR E ACCEPTOR THREE
ACCEPTOR OME ADAM ANDREWS
ACOIUSER21 ANDREW
AQUAFIMA ALE DL SCHEFER
B Watson E &LE¥ SCHEFER
B “Watson JENNIFER ROSS
B wWatzon
BADILLO

Cloze |

Warning: Applek Window

Figure 202: Group - <Name> (Read Only) Window

6. Click the[Closg] button to return to the Groups (Read Only) window.

7. Click the[Closg] button to return to the Routing Sheet <Purchase Request Number >
window.
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8. Select group(s) for the new routing sheet by highlighting a desired group from the Group list
box and clicking the[ » ] button.

Note:  All groupsthat the PRweb System Administrator created displaysin the Group list box.
As groups are added to the routing sheet their group name displaysin the order they were
selected in the Route To list box. Groups must be placed in routing order on the routing
sheet. The user in the zero position isthe creator of the PR and cannot be deleted from
the routing sheet.

Note:  Groups may be removed from the routing sheet by highlighting the desired group from
the Route To list box and clicking the[ € ] button.

9. Click the[Select] button next to the Route to PD? User field.
The Select PD? User window opens.

Select PDE Uszer

PO Uzerd
Drarninic Joel

Sarah Joyce
System Adminigtrator

Celect i Cancel

|'W'arning: Applet "Window

Figure 203: Select PD? User Window

Note:  When the user clicks the [Select] button next to the Routeto PD? User field on aroute
sheet for aPR Mod, a message displays that indicates that the PR Mod will be routed to
the PD? user that owns the conform copy of the PR.

10. Highlight the appropriate Contracting Officer.

11. Click the[Select] button.
The PD? user selected displaysin the Route to PD? User field on the routing sheet.

12. Click [OK] to initiate the routing sheet.

Create Routing Sheet — Template

PRweb employs the use of templates to facilitate the routing process. Userswith appropriate
security access can create individual route templates. Selecting the Template radio button
activates the Templates drop-down list box and allows the user to display global and individual
templates. The user can then select the desired temp late.
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To create aroute sheet using the Templates criteria:
1. From the PRweb user’s desktop, highlight a PR.

2. From the menu, select Purchase Request > Route.
The Routing Sheet - <Purchase Request Number> window opens.

3. Select the Template radio button.

# Routing Sheet - PRO103 x|

Routing Sheet

View Routees By: { A&l Users

Templates

I[Nu:une] ;I

Template Route Ta
0 - Michelle Wiy

=
-~

Select Al I

Route to P02 User: I Zelect... |
Wiewy GrOups. .. | Ok I Cancel |

I.Ja'-.fa Applet \Window

Figure 204: Routing Sheet - <Purchase Request Number> Window

4. Select the desired route template from the Templates drop-down list box.

5. Select routees for the new routing sheet by highlighting the desired members from the
Template list box and clicking the[ » ] button. Click the [Select All] button below the

Template list box to select all members of the template.

Note:  Routees may be removed from the routing sheet by highlighting the desired routee from
the Route Tolist box and clicking the[ € ] button.

6. Click the[Select] button next to the Route to PD? User field.
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The Select PD? User window opens.

Select PDE Uszer

PO Uger?
Cominic Joel

Sarah Jopce
System Administrator

Selet {  LCancel

|Warning: Applet "Window

Figure 205: Select PD2 User Window

Note:  When the user clicks the [Select] button next to the Routeto PD? User field on aroute
sheet for a PR Mod, a message displays that indicates that the PR Mod will be routed to
the PD? user that owns the conform copy of the PR.

7. Highlight the appropriate Contracting Officer.

8. Click the[Select] button.
The PD? user selected displays in the Route to PD? User field on the routing sheet.

9. Click [OK] to initiate the routing sheet.

Editing a Routing Sheet

PRweb users with appropriate security access may edit (add and remove users from) an existing
routing sheet.

To edit arouting sheet:

1. From the PRweb user’s desktop, open aPR.
PRweb users can edit routing sheets for PRs that reside in their Inbox and Outbox.

2. From the menu, select File > Route.
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The Routing Sheet window opens.

Routing Sheet - 123 Train Ed
Routing Sheet

View Routees By Al Users

" Group Templates

" Template ;I

Jzer - Foute Ta

12345678901 2345673901 2345 0-PEGEY THOMPSOM
AMY MEHMERT

Ay MEHNERT

AUSERTF
BALEY KLINIMS

BARBARA ALERT

BaRBARA BROCK E
BARBARA ERROR 2
BaRBARA USER A

Seleshdl |

Foute to POE User: I Calact |
Wigw Froups... | Cancel |

|Warning: Applet Window
Figure 206: Routing Sheet - <Purchase Reguest Number> Window

3. Select additional routees for the routing sheet by highlighting desired users or groups from the
User, Group, or Template list box, respectively, and clicking the[ » ] button.

4. Remove routees from the routing sheet by highlighting desired users or groups from the
Route Tolist box and clicking the[ ¢ ] button.

Note:  Edits must reflect the appropriate route sequence. For example, to add aroutee before an
existing routee, remove the existing routee, add the new routee and then re-add the
original routee. The creator of the PR may not be removed from the routing sheet.

5. Changethe PD? user designated to receive the PR in the Route to PD? User field if
necessary.

6. Click [OK] to save changesto the routing sheet.
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Creating a Non-Custom Routing Sheet

Users with non-custom routing privileges may create routing sheets based only on defined
templates. Usersdo not have custom routing privilegesif they are members of security groups
that cannot custom route. These security groups can have one or more routing templates
associated with them. The PRweb System Administrator maintains security groups.

Creating Template Route Sheet by Selection

Users with non-custom routing privileges may be assigned to a security group with more than one
routing template associated with it. In this case the user may choose the routing template to route
aPR.

To create arouting sheet:

1. From the PRweb user’s desktop, highlight a PR.

2. From the menu, select Purchase Request > Route.
The Routing Sheet - <Purchase Request Number> window opens.

Routing Sheet - ABC123

Templates: {[Mone] |

Routees:

FPDE Uzer:

k. Cancel

|Warning: Applet window

Figure 207: Routing Sheet - <Purchase Request Number> Window

3. Select the desired route template from the Templates drop-down list box.

The members of the template display in the Routees list. The PD? user associated with
the template displaysin the PD? User field.

4. Click [OK] to save the routing sheet.
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Creating Template Route Sheet by Non-Selection

Users without custom routing privileges may be assigned to a security group with only one routing
template associated with it. In this case the PR isautomatically routed when the user chooses to
route the PR.

To create arouting sheet:

1. From the PRweb user’s desktop, highlight a PR.

2. From the menu, select Purchase Request > Route.

The PRisrouted automatically. The Information window opens.

Information

& Purchaze Reguest ABC123 haz been routed
succezsfully,

|Warning: Applet Window

Figure 208: Information Window

3. Click [OK] to return to the PRweb desktop.

Approvals

The PRweb module facilitates the el ectronic approval of PRsand PR Mods. When aPR or PR
Mod isreceived in auser’'s Inbox, that user can review and approve the document, reject the
document, or designate contingent approval of the document.

Approving a Purchase Request or PR Mod

PRweb users may electronically approve a PR or PR Mod. An approved PR or PR Mod is
removed from the user’ s desktop and continues on through the routing process to the next user
designated on the routing sheet.

To approve aPR or PR Mod:

1. Fromthe user’s desktop, highlight the desired PR or PR Mod contained in the I nbox.

2. From the menu, select File > Approve.
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The Approval - <Purchase Reguest Number>window opens.

Approval - 123Train
Approval
Status:

Comments:

k. Cancel

|Warning: Applet WwWindow

Figure 209: Approval - <Purchase Request Number> Window

3. Select “approved” from the Status drop-down list box.

4. Enter commentsin the Comments field, as necessary.

Note: The Comments, Approval Date, and Status display in the Approval History. For more
information regarding Approval History, refer to this chapter on “View Approval
History”.

5. Click [OK] to approve the PR.

The PR displaysin the Inbox of the next user designated on the routing sheet. If there
are no more PRweb users on the routing sheet, the PR displays in the I nbox of the PD?

user designated on the routing sheet.

Note:  Ane-mail dert issent to all userson the routing sheet when a PR is marked “ Rejected”
or “Contingent”. The e-mail contains the comments entered in the Approval window.

Rejecting a Purchase Request

PRweb users may reject a PR or PR Mod during the approval process. The rejected document
continues on through the routing process to the next user designated on the routing sheet. A copy
of the rejected document remains in the Rejecting Authority’ sInbox as a reminder that the user
has arejected document that requires change, either by the user, the creator of the document or
another user on the routing sheet. The PR or PR Mod is not sent to PD? until it is fully approved.

Toreect aPR or PR Mod:
1. Fromthe user’s desktop, highlight the desired PR or PR Mod contained in the I nbox.

2. From the menu, select File > Approve.
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The Approval - <Purchase Reguest Number>window opens.

Approval - 123Train
Approval
Status:

Comrments:

0k, Cancel

|Warning: Applet tindow

Figure 210: Approval - <Purchase Request Number> Window

3. Sdlect“regected” from the Status drop-down list box.

4. Enter commentsin the Comments field, as hecessary.

Note: The Comments, Approval Date, and Status display in the Approval History. For more
information refer to this chapter on “View Approval History”.

5. Click [OK] toreject the PR or PR Mod.

The creator of the PR or PR Mod receives an e-mail alert. The document remainsin the
Inbox of the rejecting authority. If there are no more PRweb users on the routing sheet, the
document remains in PRweb until the rejecting authority approves the PR. At that time, the
document displaysin the Inbox of the PD? user designated on the routing sheet.

Note: Ane-mail aert issent to all users on the routing sheet when the document is marked
“Approved”, “Rejected” or “ Contingent”.

Designating Contingent Approval of a Purchase Request

PRweb users may give contingent approval of aPR or PR Mod. Contingent approval of the
document does not stop the approval process. The doucment continues on through the routing
process to the next user designated on the routing sheet. A copy of the document remainsin the
approving authority’ sInbox as areminder that the user has a PR or PR Mod that needs to be
changed, either by the user, the creator of the document or another user on the routing sheet. The
document is not sent to PD? until it is fully approved.

To give contingent approval of aPR or PR Mod:
1. From the user’s desktop, highlight the desired PR or PR Mod contained in the Inbox.

2. Fromthe menu, select File > Approve.
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The Approval - <Purchase Reguest Number>window opens.

Approval - 123Train

Approval

Statuz:

Comrments:

ak. Canicel
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Figure211: Approval - <Purchase Request Number> Window

3. Select “contingent” from the Status drop-down list box.

4. Enter comments as necessary in the Comments field.

Note: The Comments, Approval Date and Status display in the Approval History. For more
information regarding Approval History, refer to this chapter on “View Approval
History”.

5. Click [OK] to authorize contingent approval of aPR or PR Maod.

The creator of the PR or PR Mod receives an e-mail dert. The document remainsin the
Inbox of the user who gave contingent approval of the document. If there are no more PRweb
users on the routing sheet, the docunment remains in PRweb until the contingent approver
approves the document. At that time, the document displaysin the Inbox of the PD? user
designated on the routing sheet.

Note: Ane-mail aert issent to all users on the routing sheet when a document is marked
“Approved”, “Rejected” or “Contingent”.

View Approval History
PRweb users may view the Approval History of aPR or aPR Mod that currently resides on their
desktop. The Approval History displays the approval status and date for all users assigned to the
routing sheet and any comments that may have beenincluded. Thelist displaysin chronological
order with the most recent approver asthe last entry. If the document is returned routed from PD?
the status shows as return routed.
To view Approval History:
1. From the user’s desktop, highlight a PR or PR Mod.

2. From the menu, select Purchase Request = ViewApproval History.
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The Approval History - <Purchase Request Number>window opens.

Approval History - View Approval History x|

Approver | [ ate | Status | Comments
Ddstd A IO 1 16-tap-2001  approved
ADUSERTOH 16-Map-2000  approved
ADUSERT1H 16-kap-2001  approved

znwebdyd [PDE] 16-tap-20001  return routed

Cloze |

|Warning: Appletindow

Figure 212: Approval History - <Purchase Request Number> Window

Note:  Using the Approval History isan effective way of determining the location of agiven PR
or PR Mod.

3. Click the[Closd button to close the Approval History window.
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Chapter 10: Reports

PR Status Report In This Chapter...
PRweb users can generate PR status reports to Using the Reports function described
identify the procurement stage for agiven in this chapter, you can:

requirement. The PRweb module directly ]
interfaces with PD? and pulls up-to-date VAR (R S E LSRG
information for the requesting agent. The user can - Generate pre-formatted Standard
view the PR Madification, milestone plan, Reports

solicitation, and award for a given requirement.

To generate a PR Status Report:

1. From the menu, select Purchase Request > PR Status Report.
The PR Status Report window opens.

Note:  The PRweb, All, and Group(s) radio buttons on the PR Status Reportwindow are
based on rights assigned to a user at the group or user level by the System Administrator
and may not display for every user.

AcquiLine PRweb v2.3 187 July 29, 2002
Functional User’s Guide



Chapter 10: Reports

........ Dluery Result Search Criteria Search By Dizplay
| & MyPR: © PRweb
Beqin Date End D ate & PR Ho.  Groupls) © Al
I I ' Desc. |TF|.-’-'n. ;l
Search | Clear | Close
FR Mumber: I
Creation D ate: I—
Description: I

ST T EEE T, |

|W'aming: Applet Window

Figure213: PR Status Report Window

2. Select the appropriate Sear ch By radio button.

PR No.:

The PR No. radio button allows the PRweb user to search by a specific purchase
request number. Users can enter the first character of the purchase request
number in the Search Criteriafield, followed by the “%” sign, and all PRs
beginning with that character that also meet the other criteria designated in the
PR Status Report window display.

The Desc. radio button allows the PRweb user to search by a specific PR
description. Users can enter the first character of the PR description in the
Search Criteriafield, followed by the “ %" sign, and all PRs beginning with
that character that also meet the other criteria designated display.

3. Select the appropriate Display radio button.

My PRs:

PRweb:

All:

The My PRs radio button allows the user to display only PRs that were created
by the user and residein PD?. PRsthat are return routed from PD? do not
display.

The PRweb radio button allows the user to display PRs that were created by any

PRweb user and residein PD?. The PRweb radio button isvisible only if the
user hasrights.

The All radio button allows the user to display all PRsthat residein PD?
including PRs created in PRweb. The All radio button isvisible only if the user
hasrights.
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Group(s):  The Group(s) radio button allows the user to display the PRsthat reside in PD?
and were created by members of the group(s) she/he manages. The Group(s)
radio button enables a drop-down list box listing all the groups the user
manages. If the non-administrative user manages more than one group, the
drop-down list box includes the “ All My Groups” option. The drop-down list
box isdisabled if the user isthe manager of only one group. The Group(s)
radio button and drop-down list box are not visible to a non-administrative user
that is not the manager of any groups.

4. Enter the Search Criteria followed by the universal search symbol (%).

Note:  For more information regarding the use of the Sear ch Criteriafield, refer to “ Search
Function” section in Chapter 2: PRweb Desktop.

5. Enter abeginning date in the Begin Date field.

Entering a Begin Date further qualifies the search to find only those PRs that were created on
or after the entered date. Users can enter the date manually or utilize the Auto-Calendar
feature.

6. Enter an end datein the End Date field.

Entering an End Date further qualifies the search to find only those PRs that were created on
or before the entered date. Users can enter the date manually or utilize the Auto-Calendar
feature.

Note:  Both the Begin Date and End Date fields are required.

7. Select the [Search] button to view the results of the search.
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Query results display in the query box on the | eft side of the window.

PR. Status Report b

]

E-- Query Resul Search Criteria Search By Display
E‘a TO0 * MpPRz " PRweh
EG Ayard Beqin D ate End D ate & PR No. Al
- [ VECEB1-02C-0001 [25Jur-2002 é“':l [15-Jul-2002 gw:, " Desc
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VECEB102T000 | Seach | Clar | Close |
Ela Milestone Plan :
~e T PR Nurber:  [T001

Creation D ate: ;0532532002

Description; ;nne

P2 Document Qwher

Requestor
ERIK BADILLO ]Erik Badilla
enik_g_badillozams, com e b
ismall Purchaze
Total Est. Cost Total Funded Amt. Priority
[#10.000 [$10.000 [
Line ltems
| s | Desc. | Delivery Date | Gty Tat. Est. Cost F|
0oo1 15-Jul-2002 100.0 $10,000.00

4
Summary Report... | -

{warning: Applet Window

Figure 214: PR Status Report Window

8. Double-click a PR beneath the Query Resultsicon.

Note:

Each result contains a parent PR folder with three associated folders. Award, Solicitation,
and Milestone Plan.

9. Open asub-directory folder and highlight the associated object number to display status
information.

Note:

Selected object information displaysin the lower right corner of the PR Status Report
window. Only sub-directory folders with a plus sign (+) next to them can be opened.

10. Click the[Summary Report] button to view the Summary Report window.
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The Summary Report window opens.

Summary Report N |

PR Mumber Appry. Cancl | Saolicitation Releazed Award Released Funded Amaunt[$]

Approved r WECEE1-02-T-0010 ECERT-02-C-0001 $10.000.00

Cloze |

Warning: Applek Window

Figure 215: Summary Report Window

Note: The Summary Reportwindow provides a snap-shot of the procurement actions for all
PRs displayed in the PR status query results.

Note:  For aquick way to search alist, refer to the * Searching Within A List” section in Chapter
2: PRweb Desktop.

11. Click the[Closg button to return to the PR Status Report window.

12. Click the[Clear ] button to clear the criteria and create another query.

13. Click the[Closg button.

Standard Reports

PRweb users can generate pre-formatted reports, pulling information directly from the PRweb and
PD? databases. PRweb users can request custom reports from American Management Systems
(AMS). Currently, there are three standard reports. PRweb L ocator Report, View Canceled PR
Status Report and View Open PR Status.
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PRweb L ocator Report
1. From the menu, select Purchase Request > Standard Reports.

The Standard Reports window opens.

standard Reports x|

Select Report

M ame | Dezcription
PRweh Locator B eport Location of PR= in route for five or more elapsed days.
Wiews Canceled PR Statuz Report Report on canceled PR
Wigw Open PR Statuz Report Repart on location of non-approved PRz
Bl | ¥
Sort By

| F2

Enter the new value far;

] E nter |

Parameter Walue

7|

k. Cloze

[Warming: Applet Window

Figure 216: Standard Reports Window

2. Double-click the PRweb Locator Report from the Select Report panel.

Note: ThePRweb Locator Reportprovidesalist of all PRsthat have been in PRweb for a
minimum of five days. The report displays associated information for each of these PRs
(i.e., PR number, description, creator, and creation date) including the total of daysin
route and in PRweb, the name of the user and/or group who had the PR the longest and
number of daysin the longest station. The report also displays the current station and

number of daysin that station.

3. Choose the desired Sort By option from the drop-down list box.

The Sort By drop-down list box allows the PRweb user to sort the information in the report
by the text in any data column that is available in the Sort By drop-down list box.
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standard Reports x|

Select Report

M ame Dezcription

PRweh Locatar Beport |ocation of PRs in route for five or more elapse:

Wiews Canceled PR Statuz Report Report on canceled PR

Wigw Open PR Statuz Report Repart on location of non-approved PRz -
Bl | ¥
Sort By
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k. Cloze
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Figure 217: Standard Reports Window

4. Click [OK] to generate the Report.
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The PRweb Locator Report window opens.

PRweb Locator Report
FR Numl:u| Descripticu| Creator | Ereatiu:un[l| Station -:uf| # of Da_l,ls| Current St| # of Da_l,ls| Tatal Da
23 234ter Copy of te: uger? 2001-04-31 wgerd 9 uzerd 9 9
BE7Rtest  Copy of be: user? 2007-04-31 uzerd 9 uzerd 9 9
DABT43-C DABT43-C dwvammino 2001-04-11 usery 14 LsEny 14 14
SPAII0E WAIT 4-27 ADuzerl# 2001-04-17 ADuser2f 22 ADuserdft 22 22
SPA330-9 2WAAIT 4- ADuzerl#t 2000-04-1% ADuser2ft 21 ADuzersft 21 21
report] report] UZEIZ 2007-04-18 uzers 15 LIS 15 19
report? report? uzerz 2001-04-1! ugerm 15 LZEIM 15 15
reporkd reporkd LIz 2007-04-2 uzerg 15 Lzerg 15 15
reporth reporth Lzeny 2001-04-2 ugerg 15 uzerg 15 15
reports reports Lz 2007-04-2 uszerg 15 Lzerg 15 15
test03 test03 LzerB 2001-04-17 Userd 26 Llzerd, 26 26
testB¥E  testing e-m ugzerd 2001-04-31 ugerb 9 uzerb 9 9
teztPR 737 Copy of be: user? 2007-05-00 userd 2 uzerh 2 2
testroute  test routing userg 2007-04-21 [tesgtgrd] 13 [testgrd] 13 13
ﬂ 5
B I ¢ Previous [Netarz > Print HTkL Fepart
|Warning: Applet 'Window

PR Number

Description

Creator
Creation Date

Station of Longest Stay

# of Daysin Longest Station

Current Station

# of Daysin Current Station

Total Daysin Route

Figure 218: PRweb Locator Report

The nunber designated in the Purchase Request
Number field of the PR.

The full description contained in the Description
field.

The creator of the PR.
The creation date of the PR.

The name of the user who had the PR in his/her Inbox
thelongest.

The number of days that the PR was in the longest
station user’ s Inbox.

The name of the user who currently hasthe PR in
his/her Inbox.

The number of days that the PR has been in the user’s
or group’ sInbox.

The total number of days, from the route date to the
report generation date, that the PR has been in PRweb.

Note:

The user can adjust the width of each column by clicking on the line separating each

column and holding down the left mouse button and dragging the cursor to the right or

left.
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Print HTML Report:

Details:

Previous:

<<

When a user clicksthe [Print HTML Repor{] button the Custom
Reports— Internet Explorer window opens allowing the user to
print the PRweb Locator Report.

The[Details] button allows the user to view details associated with a
PR. The [Details] button isenabled only if there are additional
details associated with the report currently displayed on the screen.
A user selects arow from report in the window and clicks the
[Details] button to view the details.

The[Previous] button allows the user to return to the previous
Standard Reportwindow. The [Previous] button isenabled only if
thereisany preceding information. A user selectsthe [Previous]
button to display the information previously viewed.

Press the [<<] button to return to the Standard Reports window.

5. Click the[Close] button to return to the Standar d Reports window.
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View Canceled PR Status Report
The View Canceled PR Status report providesalist of all PRs created in PRweb that have been
canceled in PD?.

1. From the menu, select Purchase Request > Standard Reports.
The Standard Reports window opens.

standard Reports x|

Select Report

M ame | Dezcription
PRweb Locator Report Location of PR in route for five or more elapzed days.

YWiew Canceled PR Status Report Repoart on canceled PRz
Wigw Open PR Statuz Report Repart on location of non-approved PRz

[T
Sort By
l =l

Enter the new value far;

l E nter |

Parameter Walue

k. Cloze

Warning: Applet Window

Figure 219: Standard Reports Window

2. Double-click the View Canceled PR Status from the Select Report panel.

The View Canceled PR Status Report providesalist of all PRs created in PRweb that

Note:
have been canceled in PD?.

3. Choose the desired Sort By option from the drop-down list box.

The Sort By drop-down list box allows the PRweb user to sort the information in the report
by the text in any data column that is available in the Sort By drop-down list box.
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Standard Reports Ed

Select Report
M ame | Dezcription
FRweb Locator Beport Location of PR3 in route for maore than five days.
iew Canceled PR Statuz Report Report on canceled PRs
Wigw Open PR Statuz Report Repart on location of non-approved PRz
Kl 3
Sart By
IF'H Murnber =

Enter the new value far;

Parameter Walle
BEGIN DATE 01,01 /2000
EMD_DATE 09/23,/2000
ORIGIMATOR E
LI 3

k. Cloze

|Warning: Applet Window

Figure 220: Standard Reports Window

4. Double-click the desired Parameter from the panel.

Note: The Parameter table allows the user to further define the search results. For example, if
auser wanted to view PRs created on a specific day, the user can select the
BEGIN_DATE and END_DATE parameter from the table and that date can be entered in
the Enter the new value for box. If the user changes the Parameter, the user must click

the [ Enter] button for changes to take effect.

5. Click [OK] to generate the report.
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The View Canceled PR Status Report window opens.

Yiew Canceled PR 5Status Report
FR Mumber | Dezcrption | Creation Datﬁi Criginator | Canceled Da1 Canceled E_|,|| k.0 Motes
canceled] canceled] 2001-05-14 ¢ bbtest 2001-05-14 10 bbr22d42
cahceled10  canceled10  20001-05-14 10 bhtest 2001-05-14 10 bbr22d42
cahceled? cahceled? 2001-05-14 0% bbtest 2001-05-14 10 bbr22da2
canceled3 canceled3 2001-05-14 0% bbtest 2001-05-14 10 bbr22d42
cahceledd cahceledd 2001-05-14 0% bbtest 2001-05-14 10 bbr22daz2
cahceledh cahceledh 2001-05-14 0% bbtest 2001-05-14 10 bbr22d42
canceleds canceleds 2001-05-14 ¢ bbtest 2007-05-14 10 bbr22d42
cahceleds cahceleds 2001-05-14 10 bbtest 2001-05-14 10 bbr22daz2
canceleds canceleds 2001-05-14 10 bbtest 2001-05-14 10 bbr22d42
cahceledd cahceledd 2007-05-14 10 bbtest 2001-05-14 10 bbr22d42
LI 3
£ I < Frevious [Nerare Print HTkL Fepart
|Warning: Applet 'Window

Figure 221: View Canceled PR Status Window

Note:  The user can adjust the width of each column by clicking on the line separating each
column and holding down the left mouse button and dragging the cursor to the right or
left.

Note:  Theuser can click the[<<], [Previous], [Details], or [Print HTML Report] button to
aid in the report generation process.

6. Click the[Close] button to return to the Standar d Reports window.

View Open PR Status Report

The View Open PR Status Reportprovides alist of al PRs currently in PRweb and their current
location.

1. From the menu, select Purchase Request > Standard Reports.
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The Standard Reports window opens.

standard Reports x|

Select Report

M ame | Dezcription
PRweb Locator Report Location of PR in route for five or more elapzed days.
YWiew Canceled PR Status Report Repoart on canceled PRz
Wigw Open PR Statuz Report Repart on location of non-approved PRz
= | ¥
Sort By

| E2

Enter the new value far;

l E nter |

Parameter Walue

k. Cloze

Warning: Applet Window

Figure 222: Standard Reports Window

2. Double-click the View Open PR Status Report from the Select Report panel.

3. Choose the desired Sort By option from the drop-down list box.

The Sort By drop-down list box allows the PRweb user to sort the information in the report
by the text in any data column that is available in the Sort By drop-down list box.
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Standard Reports Ed
Select Report
M ame | Dezcription

PRweh Locator B eport
YWiew Canceled PR Status Beport
Wigw Open PR Statuz Beport

Location of PRz in route for mare than five days.
Repart on canceled PR3z

Fepart on location of non-approved PRz

[T

Sart By

I Creation D ate

Enter the new value far;

Parameter Walle =
BEGIM DATE 01,01 /2000
EMD_DATE 09/23,/2000
ORIGIMATOR E
LI 3

|Warning: Applet Window

Figure 223: Standard Reports Window

4. Double-click the desired Parameter from the panel.

Note:

The Parameter table allows the user to further define the search results. For example, if

auser wanted to view PRs created on a specific day, the user can select the
BEGIN_DATE and END_DATE parameter from the table and that date can be entered in

the Enter the new value for box. If the user changes the Parameter, the user must click
the [ Enter] button for changes to take effect.

5. Click [OK] to generate the report.
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The View Open PR Status Report window opens.

Creation Drate | Originator | PR Murnber | Dezcription | Location | Status 1=
2000-03-01 16:Z shannon® irstall kest install test sharnnon™ draft =
2000-09-01 1&6:Z zhannon® initialbuild initialbuild zhannon® draft
2000-08-01 17:z denabw1# b b denabv1# draft
2000-03-05 12:% denabw1$ b 8/5400 b 9/5.400 denaby 1 draft
2000-09-05 125 pamuser create DPAsz Priority Rz pamuzert] draft
2000-03-06 10:% denabw1$ 9/6/2000 byv 9642000 denabuwlt draft
2000-09-06 12C bbtest bbsuggested ve bbsuggested ve PamGrpl pending appr
2000-03-06 121 bbtest bbviewzum bbvigwmwzum bbhannah rejectad
2000-09-06 121 bbtest bbviewsumz bbviewsums bbgab pending appr
2000-03-06 13 bbtest bbdontyiew bbdantyview bhtest draft
2000-09-06 12:= bbtest bbview bbwiew bbtest draft
2000-03-06 134 acquzerd 123Train Training acquzert draft
2000-09-06 12E bbtest mijtestfarbb bbtestattachmer bbtest draft
2000-03-06 14:2 bbtest bbaddinpd bbaddinpd bbtest draft
2000-09-06 15:1 bbtest bbaddsuggvend bbaddsuggvend bbbaley pending appr
2000-03-06 152 dvammino] & D254 D254 dvammino: rejectad
2000-09-06 15z dvamminol & DD254 DD254 dvammino 3t pending appr
2000-03-06 15:2 michaelk, 00052000-0302: Code Revision & michaelk, draft
2000-09-06 15:E tp 032309-2m Contract Level F tp draft
=l 3
4 | % Erewious [etars Frint HTkL Report
|Warning: Applet Window

Figure 224: View Open PR Status Window

Note:  The user can adjust the width of each columnby clicking on the line separating each
column and holding down the left mouse button and dragging the cursor to the right or
eft.

Note:  Theuser can click the[<<], [Previous], [Details], or [Print HTML Report] button to
aid in the report generation process. Click the [ Closg] button to return to the Standard
Reports window.
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Chapter 11: Transfer Document

The Transfer Document functionality allows a PRweb In This Chapter...

user with managerial rights to transfer PRs and PR

Mods from one managed user to another managed Using the Transfer Document feature
user. The manager is able to transfer PRs and PR described in this chapter, you can:
Mods that reside in a managed user’ s Drafts, Inbox,

and Outbox folders. However, PRs or PR Mods are - Transfer ownership of PRsor
not available for document transfer if the document PR Mods from one manager
residesin the Inbox folder and has been routed to a user to another managed user
group.

Transfer a Document

To transfer adocument:

I:l [[glaTuk
-] Outhox
I:l Archive

I mavayhlanager

|Java Applet WwWindow

Figure 225: PRweb Transfer Menu — Manager Desktop

1. Fromthe menu, select Transfer 2 Transfer Documents.
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The Select Managed User s window opens.

Note: The Managed Users list box displays all the users that the current user manages.

i Select Managed Users O] x|
Managed Uszers
Transfer From
Llger Marme Full Mame El
amyxhoo Michelle Way |
gdonohue GEME DOMOHLUEB :
=N Pl AY 2
N PlAY 3
nicole B Watzon Tansier T
nicalep MNIGOLE (-]
mwayhanager hAY MAMNAGE El |
denavarmminol® DEMNAVAMMIMNGC3

Mext. .. Cancel

Warning: Applet Window

Figure 226: Select Managed Users Window

2. Select Transfer From user by highlighting the user from the Managed Users list box and
clicking the[ » ] button.

The selected user’ s Full Name displaysin the Transfer Fromfield as read-only.

Note:  The selected user may be removed from the Transfer Fromfield by clicking the[ € ]
button.

3. Select Transfer To user by highlighting the user from the Managed Users list box and
clicking the[ » ] button.

The selected user’ s Full Name displaysin the Transfer To field asread-only.

Note:  The selected user may be removed from the Transfer To field by clickingthe[ 4 ]
button.
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i Select Managed Users O] x|
Managed Uszers
— Tranzfer From
Lser Mame Full Mamme [_..-
onyxboo Michelle Way IMW'.-;-.'\r*g
gdonohue GEME DOMOHLUEB
=N Pl AY 2
hicole BwWatson

— Transfer T
rwayhanager  MWAYMANAGE fanster 1o

denavammingl® DENAvVamMMINGTY | (=]

|N||:|:|LE

Mext. .. Cancel |

Figure 227: Select Managed Users Window

4. Click the[Next] button to search for documents.

The Document Search window opens.
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i Document Search =10l =]
Search Criteria Search By
% % Document Mumber

5 . INSH
ealc |
™ Description

Select Documents to Transfer from msway3

Document Type | Diocument Huamber Description MEM
Select
Selected Documents to Tranzfer to nicaole
Document Type Docurment Mumber Description MNEMN
Remove |
0k Cancel |

Warning: Applet Window

Figure 228: Document Search Window

5. Enter valuesin the Search Criteriafield.
6. Select appropriate Sear ch By radio button.
7. Click the[Sear ch] button.

The search results display in the Select Documents to Transfer from <Transfer From
User Name> list box.

Note:  Only PRsand PR Mods contained in the Transfer From user’s Drafts, Inbox, and
Outbox folders display. Documents contained in the Archive folder are not available for
transfer. In addition, PRs and PR Mods are not available for document transfer if the
document resides in the Inbox folder and has been routed to agroup of users.
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i Document Search oy ] 1|

Search Criteria Search By

4

Select Documents to Transfer from msway3

% Document Mumber

5 . INSH
ealc |
™ Description

Document Type | Document Mumber Drescription [E=] =
FR CANDGS Test 061 1002
FR Mod GANDES-0001 FR tod {Info CLIMPric
PR GADDYO Test 061 2002
PR Mod GADDY2-001 PR hod 0611202 4210-00-243-3349
PR QADDYS Test 061 2002 - Test S Ww01-02-123-4567
FR CADDBO B O6M 3/02 1008-01-134-3621
. Select
Selected Documents to Tranzfer to nicaole
Document Type Docurment Mumber Description MNEMN
Remove |
0k Cancel |

Warning: Applet Window

Figure 229: Document Search Window

8. Select the documents to be transferred by highlighting the desired documents from the Select
Documentsto Transfer from <Transfer From User Name> list box and clicking the
[Select] button.

The selected documents displaysin the Selected Documentsto Transfer to <Transfer To
User Name> list box.

Note:

Multiple documents can be selected or removed by using the <Shift> or <Ctrl> keys.
Also, the manager is able to double-click a document to move it back and forth between
the Select Documentsto Transfer from <Transfer From User Name> list box and the
Selected Documentsto Transfer to <Transfer To User Name>list box.

Note:

A document may be removed from the Selected Documentsto Transfer to <Transfer
To User Name> list box by highlighting the desired document and clicking the
[Remove] button. The removed document will display in the Select Documentsto
Transfer from <Transfer From User Name> list box

Note:

Documents that display in the Selected Documentsto Transfer to <Transfer To User
Name>list box remain, unless removed. Thus, the manager is able to perform multiple
searchesin order to select documents.
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i Document Search oy ] 1|

Search Criteria Search By

% " Document Mumber

5 . INSH
ealc |
™ Description

Select Documents to Transfer from msway3

Document Type | Document Mumber Drescription | [E=] |
FR MRS PR 052002-04 1005-00-655-1031 I
FR PR AADTOZ Copy of PR with 2clins 8115-00-134-36455
FR GADDZA0 Inbox Inkox
PR PROOTE Test 061 2002 - Test S Mw01-02-123-4567
PR QAQ001 Test 05531502 1005-00-921-5004
FR CAQNDDS Test 0531102 1005-00-312-T177
. Select
Selected Documents to Tranzfer to nicaole
Document Type Docurment Mumber Description MNEMN
PR GANDT0 Test0BM 2502
FR mMod GADDT2-0001 PR hMod 061 2/02 A210-00-243-3349
PR GAN0TS Test0BM 2102 - Test So MW01-02-123-4567
Remove |
0k Cancel |

Warning: Applet Window

Figure 230: Document Search Window

9. Click the[OK] button in the Document Sear ch window.
10. Click [Yes] to the Confirmation.

Note:  E-mail notifications are sent to the Transfer From user and Transfer To user informing
them of the documents that were transferred.
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Chapter 12: Help

The Help menu provides the PRweb user with In This Chapter...
various modes of user support including access to
PRweb online help, SPS/AcquiLine Help Desk, and Using the Help functions described

About PRweb. in this chapter, you can:

Access PRweb online help
Contact the help desk
Learn more about PRweb

=100 x|

File Preferencez Purchaze Reguest Q=

PRwweh Help...

Contact Help Deszk. .
D M rhive About PRweb, .
I T Ery
I.Java Applet \Window

Figure231: PRweb HelpMenu
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PRweb Help

The PRweb Help menu option allows the AcquiLine PRweb user to access the on-line PRweb
Help Guide.

To access the PRweb Help Guide:

1. From the menu, select Help > PRweb Help.
The AcquiLine PRweb v2.3 Help window opens.

0 e - Mrasilt Bsbemet Exploser provided by AMS 2l =|
[ E
[#od = @03 Oeh et Jner o - o —
ki [ et b oot s ebvstes_ra i e e = ¢
|Links @10HL tomdie Ameh @ (UL CEWEE  @IVECOOEWER  @TVECDSAMER  qiTanba Frod  @1A00uine - PR 2] Trad ngRieivinks Ve Mansgs @] Aorpdins - Fivead 22
|
L] #F
BequiLine PRwab v2.2 Help
PR RanE R Ay LIRE PR T Halp
There s mary dflzrant ways o navigale among e bopicesdo fire e mlomation st need. Clickan He How Ged,, page o ind anssers o common Pt ouesions, orsder
i LT T s 0w D0 B e, To sesane N Tor GReciec Wpics, Arsaile: e Tl ol Comin s, ieeie, an 0 Seanc] Mo e 3 by Eicking on T[] taiion atiows. To hda (g nedgainnal
prara and #% congonanis, ciok e i budon. Tra Browss] baiong ator e (18 s i oo WL DR Ry el g B o L e EOPECE oA prean subsetanea. in
addilion, you ane able to wse your imemetbiowsers Back] and Forwand] butons as wu would farpapes onhe intemet Wihin each fapic, cerainwards andarphrases ame
Fighighted. Cickon b wardes snd phras=s loind ol imporiant infarmat ian sho ot Hem
How Do |, .. 7 Hep Topics
Functional User: Purchase Reguest Creation and Management
System Administrater: Site and Personnel Mansgement
Abms Acouiline PRwel
o Erered nhgman
[l B ¥ loelintraret
Figure 232: AcquiLine PRweb 2.3 Help— Microsoft | nternet Explorer Window
2. Double-click on the desired topic.
Contact Help Desk
The Contact Help Desk menu option allows the PRweb user to access the PRweb Product
Support web page and submit/receive el ectronic questions/answers for functional and technical
issues.
To contact the SPS/AcquiLine Help Desk:
1. From the menu, select Help > Contact Help Desk.
AcquiLine PRweb v2.3 209 July 29, 2002

Functional User’s Guide



Chapter 12: Help

The PRweb Product Support web page opens a new Web browser window.

A Frociect Support | SP5-&cguiline Help Desk - Mioesolt Internet Explorer provid edlby AMS . =] .

e G b P D e =

[#r - = - @3 A | Qe Sdrevms vy (- D - J

| ks [t e e v ¢ convecpeets 2 ra HIEYS T =] @80 |ink ®
=) ]

Srowisdga Hara

AcguiLine

Saarch the KB
Erer monigsid =

h

—Slte bl SPS/AcquiLine Help Desk
okl
Broghn Fegmies: a
% Il you are eaperiencing problems or have questions about any af the Acquiine mu‘d_l.i::_ you can
saarch the axtensie SPS Knowdadge Base tr imfomstion reganding yourissue Click hera to search -
the SPS Knowlecke Base 1T your queshion mequins an AMS Help Desk representathve, pleass hoe * &dvanced Jearch
Module lnfe your sile's Authorized Calen’s) comact the SPS Help Desk
[
=
Tooks
B Caurdacd L
el R brastios
Mavigate | Product Support Himic Magitsr |
_Produci Suppart e e
- Aagita Ko
Eamhicin By Lin fo ¥ AenuiLing & SRS Kncusge Bacs A
izmns iy _ Mowrtans |
Ghap SPS Arol ine Trakin Calandar
Iniemation on PRweD on-cie, pemonalzed and irstuor kd rsEning
Dovinl szls
E P, Wi
s viminre Faaes p, |
\ ) -
#l 7 [ ket ¥

Figure 233: Product Support Web Page

2. Click on SPS K nowledge Base
The AMS SPS Knowl edge Base window opens.

Here you can find answers to the most frequently asked questions about PD?, SPS-I or
PRweb. Other topicsinclude Headlines, Work Stations and Help Desk Records.
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About PRweb

The About PRweb menu option allows the PRweb user to view the application name and version.
To open the About PRweb window, select Help—> About PRweb from the desktop menu bar.
To return to the desktop, click the [ Closg] button.

x
&q!#ﬂgf

Acuiline - PRwek
Release Yersion 2.3

American Management Systems, Inc.

Java Applet Window

Figure 234: About PRweb Window
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A

Access Rights

The privileges given to users by the System Administrator that determine whether they can view,
change, move, or delete an object owned by themselves or another user. Generally, also refersto
the privileges associated with menu choices and document creation. Access Rights are defined in
System Administration.

ACRN

Accounting Classification Reference Number. A two-position alpha or alphanumeric control code
used to relate the accounting classification citation to detailed line item information.

Active Window

The window in which you are currently working (not necessarily the window that opens on the
screen). The Title Bar of an active window is highlighted in a different color, usually blue, than
any other open window on the Desktop. Any new documents created are automatically placed in
the Active Window.

ADC

After Date of Contract. Used in lieu of specified delivery dates when the delivery of anitem
cannot be established until acontract isin place. Calculated based on the effective date of a
released award or the delayed effective date (whichever islater). Delivery may be specified asa
certain period of time after award of the contract. Used as one of the delivery date optionsin Line
Item Detail.

AFATA

After First Article Test Acceptance. Used to define delivery dateswhen aFirst Article Test is
required. Used as one of the delivery date optionsin Line Item Detail.

AMS

American Management Systems, Inc. Located in Fairfax, VA, the prime contractor of AcquiLine
PRweb and PD?.

Approval

A PRweb process that permits authorized usersto electronically approve procurement documents.
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Attachment

A third party file (e.g., Word or Excel or any third party software that is OLE 2.0 compliant) used
in the procurement process. Asan attachment in AcquiLine, thisfile can be associated with a
document and is represented by an icon on the desktop.

Auto Calendar

A feature that allows the PRweb user to enter adate on afield from a calendar interface.

B

Buttons

Buttonsin awindow that initiate an immediate specific action; e.g., [Sear ch], [Select], [Add] or
[Delete].

C

CLIN

Contract Line ltem.

Contingent Approval

An approval action specifying that the user approves a document under certain conditions. If a
document is contingently approved, comments should be provided detailing why it has not been
“fully approved” in the field provided on the Approval Sheet.

Contacts

Names of key personnel in the Vendor and Organization profiles. Contact names display in the
appropriate fieldsin documents and may be used as search criteriain the Addr ess Sear ch
window.

D

DD254

A Contract Security Classification Specification form. Thisform provides general security
requirements for a particular requirement package.

Desktop

The user's workspace in PRweb. Thisworkspace contains job-related tools (e.g., applications,
utilities, and reference materials), items being worked on, and files of completed actions (e.g.,
documents, spreadsheets, forms, and reports).

DFARS
Defense Federal Acquisition Regulation Supplement.
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Drop-Down List Boxes

Boxesthat “drop-down” to display alist of options. These are indicated with a downward
pointing arrow.

F

FAR
Federal Acquisition Regulation.

Fidds

Rectangular boxes in which textual information is typed.

Folders

Containers used to organize multiple related files or documents.

G

Group

A common collection of users. Groups can be defined by office, position, or title. Group
information is maintained in System Administration.

GUI

Graphical User Interface. The software 'front-end' to most applications that allows the use of
windowing, menu, and mouse techniques.

H

Hypertext

A form of on-line help in which users “jump” or move easily between related topics by clicking on
acertain type of text. ThisisafeatureinPRweb On-line Help.

lcons

Small picturesthat represent files, applications, or documents.
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J

Job Order Number

A cost accounting number that links funding to a specific task or job; e.g., construction or ship
repair. In PRweb, job order numbers may be entered by any user. Accessto job order numbersis
limited to specified users unless accessis provided to all usersin PD? System Administration. Job
order numbers are entered in procurement documents from the Funding Sour ces window.

L

Local Info

Local Information fields that are used to enter data that does not display elsewhere in PRweb or
PD2, Fields are designated locally to capture information needed for reporting and tracking
purposes.

Logon

Accessing the PRweb applet with a username and password.

M

Menu

A list of commands that typically appearsin abar across the top of awindow directly below the
Title Bar.

Milestone Plan

A utility used in PD? to create a schedule for completion of a contracting action and to record
progress against the schedule.

MILSTRIP

Military Standard Requisitioning and Issue Procedure. Number may be entered in Line ltem
Detail.

Multiple Deliveries

Refers to delivery information when a user has added more than one delivery in PD2to alineitem.

N

NAICS

North American Industry Classification Standards. Code for the North American Industry
Classification System to classify individual businesses.
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NSN

National Stock Number. A thirteen-position alphanumeric code that specifically identifies an
item.

O

OLE
Object Linking and Embedding. Provides the interface between PRweb and third party software.

Outbox

Object in which items are placed when they have been routed to other PRweb users. Displaysasa
container on the PRweb desktop.

P

PD?

Procurement Desktop - Defense. Pronounced "PD Squared." The commercial software product
that the government acquired competitively to satisfy the requirementslaid out by the Standard
Procurement System program office. A combination of operating environment, applications, and
utilities that run in Microsoft Windows.

PR

Purchase Request. The generic, non-service specific document in PRweb that is used to record the
requesting activity's requirement.

PR Mod
Purchase Request Modification. A document that is used to modify areleased Purchase Request.

Preferences

A group of optionsthat define the settings on a user's desktop.

R

Radio Buttons

Buttons that represent a group of mutually exclusive choicesin awindow. They are round and fill
with adark circle when selected.

Refresh All

Allowsthe PRweb user to refresh all folders on the desktop to reflect changes.

Refresh Folder
Allowsthe PRweb user to refresh individual folders on the desktop to reflect changes.
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Reject

An action indicating a PR has been rejected. 1f adocument has been rejected, comments should
be givenin thefield provided on the approval sheet.

Route Template

Allows the PRweb user to create his/her own specific route templates to complement current
approval processes. Only userswith appropriate security rights can create route templates.

Routing

Sending PRs and attachments to PRweb and PD? users. Accessed from either the Purchase
Request File menu or desktop Purchase Request menu.

Routing Sheet

A form that specifies the users to whom a document is to be routed and the order in which that
routing isto occur.

S

Select

The process of clicking on or highlighting an object.

SPS

Standard Procurement System.

SubCLINs

Sub Contract Line ltems.

System Administration

A series of tasks that the System Administrator uses to manage and support PRweb features, such
as security, access rights, user information, and templates. For more information on System
Administration, refer to the AcquiLine PRweb System Administrator’s Guide.

System Administrator

Title given to the person(s) responsible for creating and maintaining the data to support PRweb.
For more information on System Administration, refer to the AcquiLine PRweb System
Administrator’s Guide.

T

Tabs

Rectangular buttons above forms that enable the user to easily move between the parts of aform.

TitleBar
The space at the very top of awindow that indicates the application or object being worked in.
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Glossary of Terms

U

Universal Search Criterion

The percent sign (%) is used as the "wildcard" character in searches for vendors, organizations,
objects, and keywords. It can be used aloneto search for all itemsin the database in agiven
category or it may be used in conjunction with letters or words to narrow the search.

User

Theindividual person using PRweb. The user account is maintained in System Administration.
Each user has a username, password and contact profile.

W
Windows
Screensthat display files and documents, and “hold” applications and utilities while they are being
used.
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